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NedGraphics B.V. wil de gebruikersdocumentatie steeds verbeteren. Daarom zouden wij het op prijs stellen als u dit document 
kritisch bekijkt  en uw eventuele op- of aanmerkingen aan ons doet toekomen. Stuur uw commentaar via een melding op het 
helpdesk portaal van NedGraphics. 



 

NedBrowser Configuratiehandleiding iii Versie 1.0 

INHOUDSOPGAVE 

INLEIDING ................................................................................................................................. VIII 

 OVERZICHT BEHEER NEDBROWSER ........................................................................................ 1 

 DATAMODEL......................................................................................................................... 3 

 BASISLAGEN ....................................................................................................................... 11 

 Thematische presentatie ......................................................................... 17 

 Algemeen ................................................................................................ 23 

 Systeeminstellingen in groep Redlining controleren .............................. 23 

 Redline wizard scherm 1: Laag ................................................................ 24 

 Redline wizard scherm 2: Attributen ...................................................... 26 

 Redline wizard scherm 3: Tekenfuncties ................................................. 32 

 Redline wizard scherm 4: Autorisatie ..................................................... 34 

 Overzichtsscherm .................................................................................... 35 

 Stap 1: WFS laag ...................................................................................... 36 



 

    
Versie 1.0 iv NedBrowser Configuratiehandleiding 

 Stap 2: Attributen .................................................................................... 36 

 Stap 3: Tekenfuncties .............................................................................. 36 

 Stap 4: Autorisatie ................................................................................... 37 

 KAARTMENU ...................................................................................................................... 49 

 PRINTEN ............................................................................................................................. 55 

 PRODUCTEN ....................................................................................................................... 69 



 

NedBrowser Configuratiehandleiding v Versie 1.0 

 ZOEKINGANGEN EN RESULTAATSCHERMEN MAKEN ............................................................ 79 

 AUTORISATIE ...................................................................................................................... 93 

 REFERENTIES..................................................................................................................... 103 

 SYSTEEM .......................................................................................................................... 107 



 

    
Versie 1.0 vi NedBrowser Configuratiehandleiding 

 STATISTIEK ........................................................................................................................ 111 

 BIJLAGE A: SELECT-RECHTEN SCRIPT .................................................................................. 113 

 BIJLAGE B: ORACLE OBJECTEN T.B.V. THEMATISCH PRESENTEREN ...................................... 114 

 BIJLAGE C: INFO/METADATA KNOP TONEN IN LEGENDA EN ZOEKRESULTAAT ..................... 116 

 BIJLAGE D: RAPPORT VOOR ZOEKRESULTATEN .................................................................. 127 

 BIJLAGE E: LIJNPATRONEN................................................................................................. 130 

 BIJLAGE F: OBJECTEN IN KAART TOEVOEGEN MET KLANTAFH. ATTRIBUTEN ....................... 140 

 BIJLAGE G: NEDBROWSER OPSTARTEN MET PARAMETERS ................................................. 142 



 

NedBrowser Configuratiehandleiding vii Versie 1.0 

 BIJLAGE H: BROWSERONDERSTEUNING ............................................................................. 148 

 BIJLAGE I: BEGRIPPENLIJST ................................................................................................ 153 

 



Inleiding 

Versie 1.0 viii NedBrowser Configuratiehandleiding 

 INLEIDING 

NedBrowser is een generieke intranet/internet applicatie van NedGraphics voor het 
ontsluiten van geografische en administratieve gegevens via een standaard browser. De 
ontsluiting wordt in belangrijke mate gestuurd door een catalogus met gegevens over de 
gekoppelde databases, de te ontsluiten gegevens daarin en de autorisatie en presentatie 
van deze gegevens. 
 
NedBrowser heeft als belangrijk kenmerk dat het een stuurmodel bevat met 
(meta)gegevens. De inhoud van het stuurmodel bepaalt welke geografische en 
administratieve gegevens worden getoond en hoe ze worden gepresenteerd. NedBrowser 
is hiermee onafhankelijk van welke administratieve en geografische gegevens precies 
beschikbaar zijn. 
 
Het stuurmodel wordt beheerd met behulp van een webbased Oracle APEX (APplication 
Express) applicatie. De bediening van deze applicatie is het onderwerp van deze 
handleiding. De handleiding start met het beschrijven van het kader waarbinnen de 
beheerapplicatie opereert. De meest voorkomende handelingen die u als 
applicatiebeheerder zult uitvoeren worden beschreven in hoofdstukken 2 t/m 11 van deze 
handleiding.  
 
In deze handleiding wordt ervan uit gegaan dat u beschikt over enige kennis op het gebied 
van relationele databases zoals Oracle of DB/2.  
 
 

Gebruik van de handleiding 
NedGraphics streeft ernaar om de gebruikershandleiding eenvoudig in gebruik te houden. 
Daarom is dit document waar mogelijk voorzien van aanvullende opmerkingen. 
 
 
Er zijn twee soorten aanvullende opmerkingen. De eerste soort is de tip. Die wordt 
aangegeven met het volgende symbool: 
 
 

 

TIP: 
Een tip is een optionele zijsprong op het onderwerp. 

 
 
De tweede soort aanvullende opmerking is de waarschuwing. Die wordt aangegeven met 
het volgende symbool: 
 
 

 LET OP: 
Een waarschuwing geeft een verplichte instelling weer. Als die niet opgevolgd wordt 
kan dat gevolgen hebben voor het eindresultaat. 
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Graag wijzen wij u op het helpdesk portaal van NedGraphics: 
 
Het helpdesk portaal (www.nedgraphics.nl → Support & contact → Helpdesk 
portaal) is de centrale plek waar de gebruiker alle beschikbare informatie vindt over 
NedGraphics programmatuur. Het helpdesk portaal biedt toegang tot het 
kennissysteem. Indien het kennissysteem geen antwoord geeft op de gestelde vraag, 
dan kan de vraag worden geregistreerd. Na registratie wordt de gebruiker 
teruggebeld door een productspecialist. Na registratie is de helpdesk telefonisch 
(0347-329660) en/of per e-mail (helpdesk@nedgraphics.nl) te benaderen. Tevens 
zijn op het helpdesk portaal de NedGraphics programmatuur en de handleidingen te 
downloaden. 

 
 

 

De NedGraphics Gebruikers Vereniging 

 
 
Algemene info 
De NedGraphics Gebruikers Vereniging (NGV) is een onafhankelijke organisatie die 
de belangen behartigt van de gebruikers en afnemers van NedGraphics producten 
en diensten. De NGV werkt zonder winstoogmerk en wordt volledig gefinancierd uit 
de contributie van de leden. De NGV telt op het ogenblik rond de honderd leden die 
vooral bestaan uit gemeenten maar ook provincies, waterschappen en 
ingenieursbureaus zijn lid. Het gekozen bestuur voert het beleid uit wat door de 
leden wordt vastgesteld en zal het belang van een eindgebruiker altijd laten 
prevaleren. De NGV staat ingeschreven bij de Kamer van Koophandel. 
 
Doelstelling van de Vereniging 
De algemene doelstelling van de Vereniging is het maximaliseren van de 
tevredenheid over NedGraphics producten en diensten voor de leden. Ook het 
optimaliseren van het gebruik van de producten wordt hieronder verstaan. 
 
Activiteiten van de Vereniging 
De vereniging kent product- en projectgroepen die in samenwerking met 
NedGraphics zorgen dat de producten blijven voldoen aan de wensen en eisen die de 
eindgebruiker aan het pakket stelt. Deze product- en projectgroepen komen op 
regelmatige basis bij elkaar om de ontwikkeling van de producten te kunnen 
bepalen. 
 
Indien u interesse heeft in de NedGraphics Gebruikers Vereniging verwijzen wij naar 
de website van de vereniging: www.ngvereniging.nl of middels een email aan: 
secretariaat@ngvereniging.nl. 

 
 

outbind://736/www.nedgraphics.nl
mailto:helpdesk@nedgraphics.nl
http://www.ngvereniging.nl/
mailto:secretariaat@ngvereniging.nl
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 OVERZICHT BEHEER NEDBROWSER 

Met behulp van de NedBrowser beheerapplicatie worden allerlei instellingen bepaald die 
van invloed zijn op de werking van NedBrowser: hoe de NedBrowser website eruit ziet, 
welke koppelingen beschikbaar zijn, hoe deze koppelingen zich onderling verhouden, 
welke thematische presentaties aan de gebruiker worden aangeboden, etc. De 
NedBrowser beheerapplicatie kan dan ook worden gezien als de spin in het web. In 
onderstaande afbeelding wordt de beheerapplicatie in een kader geplaatst. 
 

 
In deze afbeelding zijn drie kolommen zichtbaar. Aan de rechterkant de databases met 
administratieve gegevens, over bijvoorbeeld kadastrale informatie, WOZ-gegevens, 
civieltechnische beheergegevens, GBA, of welke andere database dan ook. Via enkele 
protocollen worden het bestaan van allerlei tabellen in deze databases bekend gemaakt 
binnen het stuurmodel.  
 
N.B.: Er wordt in het stuurmodel dus nadrukkelijk geen administratieve data opgeslagen, 
alleen de koppeling naar deze externe databases wordt onderhouden. 
 
De linkerkolom omvat het geografische materiaal. De verschillende kaartlagen kunnen 
afkomstig zijn uit een database of uit een grafisch bestand. Ze worden geïnterpreteerd 
door de grafische motor (gebaseerd op Open Source library GeoTools) en via de webserver 
wordt uiteindelijk de webapplicatie met daarin het kaartmateriaal gepubliceerd op het 
intra- of internet. De inhoud van de webapplicatie wordt in sterke mate bepaald door het 
stuurmodel (de middelste kolom) – en het stuurmodel wordt beheerd door middel van de 
beheerapplicatie.  

 

 
Stuurmodel 

Beheerapplicatie 

 
DB 

 
DB 

 
DB 

Grafische motor 

Webserver 

W
eb 
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 Werkzaamheden voor de applicatiebeheerder 

Kijkend naar de zojuist besproken afbeelding zijn een aantal werkzaamheden te 
onderscheiden: 
 

• Conversie van kaartmateriaal naar het juiste formaat voor de browser. Zie hiervoor, 
afhankelijk van uw omgeving: 
▪ Gebruikershandleiding FME applicatiebeheer 
▪ Gebruikershandleiding NedConverteer 
▪ Handleiding SDF Loader  
▪ Handleiding SQL Loader  
▪ Handleiding Oracle Spatial 

(http://www.oracle.com/technology/documentation/spatial.html) 

• Presentatie van dit kaartmateriaal in de browser. Dit gebeurt met behulp van het 
stuurmodel.  

• Onderhouden of aanbrengen van koppelingen naar externe databases. 

• Het definiëren van kaartlagen. 

• Voorbereiden van thematische presentaties en labellingmogelijkheden. 

• Instellen van redliningmogelijkheden. 

• Aanpassen van print-templates. 

• Het samenstellen van productgroepen en producten. 

• Aanpassen van zoekresultaten, zoekingangen, relaties tussen kaarten en 
administratieve gegevens. 

• Toekennen van productgroepen aan verschillende gebruikersgroepen. 
 

 

In figuur 1.1 wordt duidelijk gemaakt hoe u het beste te werk kunt gaan bij het dagelijkse 
beheer van NedBrowser. 

 
Elke stap correspondeert met een menu-item in het stuurmodel (alle stappen en menu-

items hebben dezelfde kleur), zie figuur 1.2. 
 

 
Figuur 1.2 Stuurmodel menu 
 

Aan de hand van procesbeschrijvingen worden de meest voorkomende beheerstaken 

uitgebreid toegelicht in de volgende hoofdstukken. 
 

 
 

 
 

 

 
 

 
Figuur 1.1 Proces 

1. Datamodel 

2. Basislagen 

3. Kaartmenu 

4. Printen 

5. Producten 

6. Autorisatie 

Referenties 

Systeem 

Help 

Statistiek 

http://www.oracle.com/technology/documentation/spatial.html
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 DATAMODEL 

 Inleiding 

 
 

 

 
 

 
 

 
 

 

 
 

In het Datamodel menu kunnen nieuwe objecten worden ingelezen, objecten worden 
beheerd en domeinen worden aangemaakt. 

 

 Een nieuw schema of externe database bekend maken in het stuurmodel 

Het bekend maken van een ander schema binnen dezelfde Oracle database gaat op 
onderstaande wijze. 
 

• Zorg ervoor dat ‘select’-rechten worden uitgedeeld vanuit het bronschema voor de 
NBG-gebruiker. Gebruik hiervoor bijvoorbeeld het script uit Bijlage A: Select-rechten 
script. 
Tevens kan de NBG-gebruiker select rechten krijgen op een enkele tabel/view door in 

het bronschema het volgende statement te gebruiken: 
grant select on <objectnaam> to nbg;  

 

Nu heeft de NBG-gebruiker rechten om gegevens te selecteren uit het nieuwe object. 

• Kies in de beheerapplicatie onder menu Datamodel voor Inlezen.  
 
 
 
 
 
 
 

 
 

 

 

• Kies linksboven bij Connectie voor het juiste schema.  

• Gebruik het dropdown menu bij Connectie om de juiste entry uit de connecties aan te 
wijzen. 

• Bij Status zijn er 2 mogelijkheden:  
▪ Nieuw (object bevindt zich niet in het stuurmodel); 

1. Datamodel 

2. Basislagen 

3. Kaartmenu 

5. Producten 

6. Autorisatie 

Referenties 

Systeem 

Help 

Statistiek 

4. Printen 
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▪ Gewijzigd (er zijn attributen toegevoegd of verwijderd in het stuurmodel of in het 
datamodel). 

• Vink de objecten aan die ingelezen moeten worden of druk op het allerbovenste vinkje 
in het kolommenblad indien alle objecten ingelezen moeten worden. 

• Kies daarna voor Start inlezen. Het datamodel uit het andere schema wordt nu als een 
serie objecten en, indien bekend via foreign keys, als objectrelaties bekend gemaakt in 
het stuurmodel. 

 
Voor het bekend maken van een schema over een database link volgt u dezelfde 
handelswijze. Voorwaarde is natuurlijk dat er een database link bestaat. Met onderstaand 
commando maakt u een database link aan naar een schema in een andere instance: 
 

create [public] database link {naam} connect to {doel} 

identified by {password} using ‘{service name}’ 

 
En om te controleren of de database link werkt: 
 

select table_name from user_tables@[database link] 

 
Voor het aanmaken van een database link kunt u het beste contact opnemen met uw DBA, 
of raadpleegt u een consultant van NedGraphics.  
Wanneer u een datamodel afkomstig uit een externe database wilt inlezen, dat wil zeggen 
een niet-Oracle database zoals DB/2, MS Access, Informix, of welke ODBC-benaderbare 
database dan ook, dan kunt u gebruik maken van Oracle Heterogene Services (HS). 
 

 Datamodel beheren 

Na het inlezen van een datamodel kan het stuurmodel enige honderden objecten en 
relaties bevatten. Hieronder volgen enkele tips om deze gegevens goed te beheren. 
 
1. Werk zoveel mogelijk samen met iemand die de database goed kent. Een 

databasebeheerder of een applicatiebeheerder kan u helpen bij het zoeken naar de 
structuur binnen alle tabellen en views in de database. 

2. Probeer een schematische weergave van het datamodel te verkrijgen om zo snel 
mogelijk inzicht te krijgen in de structuur van de database. 

3. Maak voordat u grootscheepse wijzigingen in het stuurmodel aanbrengt altijd eerst 
een back-up met behulp van de exportoptie (onder menu systeem). 

4. Importeer niet meer objecten dan noodzakelijk. Selecteer de juiste objecten door deze 
aan- of uit te vinken. 

5. Verwijder overbodige, niet gebruikte objecten uit het stuurmodel. 
6. Geef de objecten en objectrelaties duidelijke, korte maar leesbare namen. Een geo-

object krijgt bijvoorbeeld als prefix ‘Geo_’, dus ‘Geo_Wegvakken’. De kaartlaag heet 
dan ‘Geo_Wegvakken’. Objectrelaties noemt u bijvoorbeeld ‘Geo_Wegvakken-
Wegvakken’ – in dit geval de relatie tussen de kaartlaag ‘Wegvakken’ en een algemene 
view over wegvakken in de database. 

7. Werk in kleine stappen en zorg ervoor dat u goed overzicht houdt over de te volgen 
werkwijze. Zie ook paragraaf 2.4. 
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 Een nieuwe koppeling maken 

Voor het inrichten van een nieuwe koppeling volgt u onderstaande aanpak.  
 
1. Maak een grafisch object bekend: Datamodel → Inlezen (B.V.: kadastrale kaart: 

Geo_Kad) 
2. Maak een administratief object bekend: Datamodel → Inlezen (B.V.: percelentabel in 

database: Kad) 
3. Maak een objectrelatie aan tussen deze beide objecten: Datamodel → Objecten →  

Edit  → tabblad Objectrelaties (Geo_Kad-Kad) 
4. Maak een relatieketen aan op basis van deze objectrelatie: Datamodel → Objecten Edit  

→ tabblad Relatieketens (Geo_Kad-Kad) 
5. Maak een product aan of selecteer een bestaand product: Producten → Producten 
6. Maak een productgroep aan of selecteer een bestaande productgroep: Producten → 

Productgroepen → Edit  en voeg het product toe. 
7. Maak een resultaatscherm aan voor het administratieve object: Producten → 

Producten → Zoekresultaten (resultaatscherm heet bijvoorbeeld : Kadastrale gegevens) 
8. Maak zoekingangen aan op basis van dit resultaatscherm: Producten → Producten → 

Zoekingangen 
9. Koppel één of meer resultaatschermen aan de kaartlaag: Producten → Producten → 

Productmenu’s → Productlagen →  Edit → Tabblad Laagresultaten 
10. Check of de autorisaties correct zijn ingesteld voor de productgroep: Autorisatie → 

Gebruikersgroepen 
11. Controleer of de koppeling in de browser werkt. 
 

 Werken met domeinen 

Binnen het stuurmodel kunt u gebruik maken van zogenaamde externe of interne 
domeinen om veel voorkomende afkortingen om te zetten naar een begrijpelijkere tekst. 
Denkt u bij voorbeeld aan de zakelijk-recht aanduiding ‘VE’, dat beter leesbaar wordt als u 
er ‘Volledig Eigendom’ van maakt. Of een kadastrale gemeentecode ‘ALM02’ wordt ‘Almelo 
Centrum’.  
 
Er zijn twee soorten domeinen, namelijk externe en interne domeinen. Externe domeinen 
zijn gebaseerd op een externe tabel waarin alle codes en betekenissen zijn opgeslagen. Het 
is dan niet mogelijk via de NedBrowser beheerapplicatie deze aan te passen. Interne 
domeinen zijn gebaseerd op de interne tabel NBG_CODELIJST in het NBG-schema. In dit 
geval moet de applicatiebeheerder zelf de codes en betekenissen toevoegen. 
 
Om een extern domein aan te maken volgt u onderstaande werkwijze: 
1. Definieer een lookup-tabel in een schema in de Oracle database waarbij steeds een 

codeattribuut en een betekenis worden gekoppeld, of zoek een tabel in de database 
die als lookup-tabel kan dienen. In dit voorbeeld bevat de tabel ‘lookup_gem_code’ de 
versleuteling van gemeentecode naar omschrijving. 
 

SQL> CREATE TABLE lookup_gem_code ( 

code varchar2(100) not null, omschr varchar2(240)); 

 

SQL> INSERT INTO lookup_gem_code (code, omschr) values  

(‘ESD00’, ‘Enschede’); 

 

SQL> commit; 
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SQL> GRANT SELECT ON lookup_gem_code to <user>; 

 

SQL> desc lookup_gem_code; 

Naam                                Null?    Type 

----------------------------------- -------- -------- 

CODE                                NOT NULL VARCHAR2(100) 

OMSCHR                                       VARCHAR2(240) 

 
2. Geef in het stuurmodel aan dat deze tabel als domein moet worden gebruikt. Maak 

een object bekend binnen Datamodel → Objecten.  
3. Maak onder Datamodel → Externe domeinen een nieuwe regel aan via de knop Voeg 

domein toe, en vul de juiste waarden in. Door gebruik te maken van de velden 

selectiewaarde en selectieattribuut kunt u eventueel een algemene lookup-tabel 
gebruiken waarin meerdere lookup-vertalingen zijn opgeslagen. 

 

 
 
4. Geef bij het object, waarvoor u een domein wilt gebruiken, aan dat u voor een bepaald 

attribuut wilt verwijzen naar een domein. 
5. De applicatie doet de rest van het werk. Overal waar het genoemde attribuut wordt 

getoond in de webapplicatie zal de versleutelde waarde worden gebruikt in plaats van 
de codering. 

 

Om een intern domein aan te maken volgt u onderstaande werkwijze: 
1. Maak onder Datamodel → Interne domeinen een nieuwe regel aan via de knop Voeg 

domein toe, en vul de juiste waarden in. Druk daarna op Opslaan. 
 

 
 

2. Voeg nieuwe domeinwaardes toe via de knop Voeg waarde toe, en vul de juiste 
waarden in. Druk daarna weer op Opslaan. 
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 StUF gegevensmagazijn aansluiten 

 Inleiding 

Binnen NedBrowser is het mogelijk om een koppeling te maken met een StUF 
gegevensmagazijn zoals NedMagazijn. Zoekresultaten kunnen uit een StUF 
gegevensmagazijn worden opgehaald. Tevens kunnen Oracle/WFS zoekresultaten 
gekoppeld worden met StUF zoekresultaten en vice versa. 
 
In het stuurmodel wordt dit mogelijk gemaakt door een connectie aan te maken van het 
type "StUF". Objecten van een StUF connectie kunnen gebruikt worden om zoekresultaten 
te definiëren die via een synchrone StUF vraag/antwoord query opgehaald worden uit een 
StUF gegevensmagazijn. In de StUF query worden applicatiecode en loginnaam van de 
gebruiker meegegeven. De StUF query wordt gedaan middels een Soap request naar een 
https-URL met een certificaat. 
 

 Stuurmodel instellingen 

Om een aansluiting te maken met een StUF gegevensmagazijn dienen de volgende stappen 
doorlopen te worden: 
 
1. Ten eerste moet er een connectie worden aangemaakt. Dit kan via menu Datamodel 

→ Connecties. Druk op de knop Voeg connectie toe. Kies hier voor type StUF en vul de 
naam en omschrijving in: 

 

 
 

De naam van de StUF connectie moet overeenkomen met de aanwezige "name" van 
een <stufservice> element in NBGWebserviceConfig.xml: 

 

 
 

De StUF velden in NBGWebserviceConfig.xml zijn ingevuld tijdens de NedBrowser 
Tomcat/GeoTools Installshield procedure, maar kunnen ook later 
toegevoegd/gewijzigd worden. 

 

 LET OP:  
Indien er achteraf wijzigingen plaatsvinden voor de StUF services in 
NBGWebserviceConfig.xml, dient de NedBrowser Tomcat Windows service herstart te 
worden. 
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2. Maak een nieuw object aan via menu Datamodel → Objecten. Druk op de knop Voeg 

object toe. Kies bij Connectie voor de zojuist aangemaakte StUF connectie en vul naam 
en naam op scherm in.  

 

 
 
Het veld StUF Entiteit type is alleen beschikbaar voor objecten met een StUF connectie 
en bestaat uit 3 hoofdletters, bijvoorbeeld PND voor panden, TGO voor 
verblijfsobjecten en NPS voor natuurlijke personen. 

 
3. Voeg vervolgens de attributen toe door middel van de knop Voeg attribuut toe. Vul het 

veld Naam in object in, deze naam is uniek binnen een object. Voor StUF objecten is dit 
een StUF attribuutnaam inclusief namespace BG of StUF met een : erachter. 

 
Een StUF attribuutnaam mag genest zijn, dit betekent dat ze verwijzen naar een 
attribuut op een dieper niveau in de XML, bijvoorbeeld uit een gerelateerd object. In 
dat geval mogen tussen haakjes de XML-attributen opgenomen worden die nodig zijn 
om de betreffende relatie te identificeren.  
 
Voorbeelden: 
 
1. 
BG:adresAanduidingGrp/BG:gor.openbareRuimteNaam 
 
2. 
BG:vbo.maaktDeelUitVan(StUF:entiteittype=VBOPND)/BG:gerelateerde(StUF:entiteitty
pe=PND)/BG:identificatie 
  
In voorbeeld 1 wordt bij een verblijfsobject (entiteittype=TGO) het attribuut "openbare 
ruimte of straatnaam" gedefinieerd. Aangezien er maar 1 is, zijn er geen XML-
attributen tussen haakjes nodig om de relatie te identificeren. 
  
In voorbeeld 2 wordt bij een verblijfsobject (entiteittype=TGO) het attribuut 
"pandidentificatie" gedefinieerd. Dit attribuut kan weer gebruikt worden om een 
objectrelatie tussen een StUF object verblijfsobject (TGO) en StUF object pand (PND) 
aan te maken. 

 
4. Maak een objectrelatie aan tussen het StUF object en elk gewenst ander object via 

tabblad Relaties. 
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5. Maak een relatieketen aan op basis van deze objectrelatie via tabblad Relatieketens. 
Let daarbij op dat ketenrelaties waarvan het start- of eindobject van een WFS- of StUF-
connectie is mogen maar uit 1 objectrelatie bestaan. 

 

 
   
6. Maak vervolgens een zoekresultaat aan gebaseerd op het gewenste object via menu 

Producten → Producten → Zoekresultaten. 
 

7. Na het aanmaken van een zoekresultaat, kan vervolgens een zoekingang gemaakt 
worden via menu Producten → Producten → Zoekingangen. Kies bij Zoekresultaat het 
zojuist aangemaakte zoekresultaat door middel van de dropdown list. 

 
8. Om informatie te kunnen opvragen van een object in de kaart, moet aan de laag een 

resultaatscherm gekoppeld worden. Dit gaat via menu Producten → Producten → 
selecteer een product → Productmenu’s → Productlagen → tabblad Laagresultaten. 

 
9. Maak kaartrelaties aan voor de koppeling tussen zoekresultaten/productlagen via 

Producten → Producten → admin → admin/geo en geo → admin. 
 

10. Check of de autorisaties correct zijn ingesteld voor de productgroep: Autorisatie → 
Gebruikersgroepen 

 
11. Controleer of de koppeling in de browser werkt. 

 

 Attributen indexeren 

Attributen kunnen geïndexeerd worden. In het Zoek locatie zoekveld bovenin NedBrowser 
kan vervolgens gezocht worden op de geïndexeerde attributen.  
 

 
 
In het stuurmodel, geef in het tabblad Attributen aan welke attributen gevonden moeten 
kunnen worden met algemene zoekfunctie in NedBrowser. Als een attribuut wordt 
aangevinkt worden de voorkomende unieke waarden van dit attribuut opgeslagen in een 
aparte attributen index. 
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In het tabblad 'Indexerings job' worden een aantal technische gegevens getoond van de 
achtergrondtaak die het indexeren van de attributen verzorgd. 
 
In het tabblad 'Resultaten' worden de logregels van de achtergrondtaak getoond. 
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 BASISLAGEN 

 Inleiding 

 
 

 
 

 
 

 

 
 

In menu Basislagen worden normale lagen en redline lagen vastgelegd. Tevens is het 
mogelijk om hier thematische presentaties te definiëren. 

 

Voor een overzicht van de afhankelijkheden van de basislagen zie Help in de 
beheerapplicatie. 

 

 Normale lagen beheren 

In het stuurmodel kunt u de algemene eigenschappen van de kaartlagen instellen via menu 
Basislagen → Normale lagen → Edit. Deze lagen worden later gebruikt om een product mee 

samen te stellen. 

 
De volgende opties zijn belangrijk: 

 
Objectnaam → Naam van het database object waarin de geo-component en/of sleutel is 

opgeslagen. Gebruik het drop-down menu om een object uit de lijst te kiezen. 

 
Laagnaam → Naam van de laag voor de presentatie van geografische objecten. 
 
Legenda items tonen in legenda → Indicatie (J/N) of de legenda items worden getoond in 
de legenda. 
Indien deze optie is uitgevinkt en er is maar 1 legenda-item, dan wordt in de legenda de 
afbeelding NIET voor de laagnaam afgebeeld. 
 
Raster → Indien aangevinkt dan wordt deze laag gezien als een rasterbestand. Dit betekent 
dat vlaklagen die bovenop deze laag liggen automatisch transparant worden als voor deze 
lagen de optie "Transparant indien raster" is aangevinkt in het productlagenscherm.  
Op deze manier kunnen b.v. RO lagen als raster aangemerkt worden zodat bovenliggende 
BGT lagen automatisch transparant worden.  

 

 Kaartpresentatie wijzigen 

Het wijzigen van de presentatie van een kaartlaag kan in het stuurmodel door gebruik te 
maken van de functionaliteit Thematisch presenteren. Voor een verklaring van deze 
methode wordt verwezen naar § 3.6: Thematische presentatie maken. 
 

1. Datamodel 

2. Basislagen 

3. Kaartmenu 

5. Producten 

6. Autorisatie 

Referenties 

Systeem 

Help 

Statistiek 

4. Printen 
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 Labels plaatsen 

In NedBrowser is het mogelijk om tekstlabels in de kaart te tonen. Het administratief 
attribuut wat hieraan ten grondslag ligt dient aangegeven te worden in het stuurmodel. 
 

Er wordt gedefinieerd in welke kaartlaag tekstlabels getoond kunnen worden en welk 

attribuut als basis dient voor de tekstlabels. Hiervoor dient de volgende werkvolgorde 

aangehouden te worden: 
 

Selecteer menu Producten → Producten → selecteer een product → Productmenu’s → 

Productlagen  
òf 
Producten → Productlagen → selecteer een product  
 

Vervolgens de productlaag bewerken waarin tekstlabels geplaatst dienen te worden en op 

tabblad Labels klikken. Klik nu op de knop Voeg label toe. 
 

 
 

Vul het Attribuut in door via het dropdown menu het juiste attribuut te kiezen, Naam op 

scherm invullen (willekeurig). Labels waarbij Initieel tonen is aangevinkt, worden standaard 
getoond.  
 
Vul bij Minimum/Maximum schaalfactor de schaal in waarop het label nog getoond moet 
worden. Indien niet ingevuld dan geldt die van de productlaag. Hiermee kan voorkomen 
worden dat de kaart vol komt te staan met onleesbare teksten op een lagere schaal. De 
performance kan zo ook aanzienlijk worden verhoogd.  
 
 

 
 

Opmerking: 
Het is mogelijk om zowel labels als aparte kaartlaag te definiëren als labels aan een 

bestaande kaartlaag toe te voegen. 
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 Themapaletten beheren 

Voor het aanmaken van een thematische presentatie heeft u een themapalet nodig. Dit 
palet bepaalt uit welke kleuren de legenda voor een thematische presentatie wordt 
opgebouwd. In het stuurmodel kunt u de themapaletten instellen via menu freferenties 
s → Themapaletten. 
 

 
 
Een themapalet bestaat uit een kleurenset. 
 
Het aanmaken van een palet houdt in dat u een selectie maakt uit de beschikbare kleuren, 
waarbij de kleuren die u selecteert een patroon hebben dat zich goed leent voor het thema 
waaraan u werkt. Overwegingen die daarbij een rol spelen zijn o.a.: 
 

• de opeenvolgende kleuren moeten goed van elkaar te onderscheiden zijn 

• het aantal kleuren in het palet moet minimaal gelijk zijn aan het aantal klassen in het 
thema 

 
Standaard wordt een serie themapaletten meegeleverd die in de meeste gevallen 
voldoende zal zijn om al uw thematische presentaties mee te maken. 
 

 Een thematische presentatie maken 

Om een thematische presentatie in het stuurmodel op te bouwen kunnen de volgende 
stappen doorlopen worden: 

 
Selecteer menu Datamodel → Objecten → tabblad Attributen → Edit. 
De gewenste attributen waarop thematisch gepresenteerd kan worden, worden hier 
vastgelegd: 

 
 
Selecteer menu Basislagen → Normale lagen → Edit thema´s → Knop voeg thema toe. 
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Er wordt nu een wizard gestart waarin eerst de algemene gegevens kunnen worden 
ingevuld en de keuze wordt gemaakt tussen de twee verschillende soorten thema’s. De 

waarde Naam op scherm is vrij in te vullen.  
 
Uitgeklapt tonen → Kan aangevinkt worden indien het gewenst is om de thematische 

presentatie uitgeklapt getoond moet worden in de legenda. 
 
Themanaam tonen bij printen → Kan aangevinkt worden indien het gewenst is om de 

themanaam te tonen bij het printen. 

 
Soort thema →Geometrie, dit type thema’s presentatie is er voor bedoeld om geometrieën 

o.b.v. een thematisering te tonen in NedBrowser. Tekst, deze geometrieën worden niet 

getoond, er wordt alleen een label aangemaakt.  
 

 
 

 Geometrische thematische presentatie 

Er is in de stap algemene gegevens voor de thematisering geometrie gekozen. In de stap 
Inhoud wordt er nu gevraagd welke klassenindeling er gebruikt gaat worden en welke type 
geometrie het geometrisch object bevat. 
 

 
 
Type klasseindeling → Er kunnen vier verschillende types gekozen worden: 

1. Geen → Kan gebruikt worden indien het om een lege thematische presentatie gaat. 

2. Nominaal → De verschillende attribuutwaarden zijn niet in klassen te vangen, het gaat 

hierbij om een kwalitatief gegeven wat thematisch gepresenteerd wordt. Als Nominaal 

gekozen wordt is het niet nodig de invulvelden Aantal klassen, Minimum waarde, 
Maximum waarde en Afrondingseenheid in te vullen. 

3. Equal ranges → De verschillende klassen waartoe de attribuutwaarden behoren hebben 

een gelijke klassebreedte. 
4. Equal counts → De verschillende klassen waartoe de attribuutwaarden behoren hebben 

een gelijk aantal attribuutwaarden. 

 
Attribuut → Het attribuut wat thematisch gepresenteerd wordt. 

 
Uitgeklapt tonen → Kan aangevinkt worden indien de thematische presentatie uitgeklapt 

getoond dient te worden in de legenda. 
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Met de knop Stijl verschijnt een nieuw scherm waarin de rand en de achtergrondkleur van 
het vlak ingesteld kunnen worden: 
 

 
 
Selecteer een vlakpatroon uit de lijst d.m.v. de drop-down lijst. U kunt nieuwe vlakpatronen 
definiëren via menu Referenties → Vlakpatronen. 

Opaciteit geeft aan of de vlakken gevuld (0% transparant) of transparant zijn. 

Selecteer de rand/lijnstijl uit de lijst d.m.v. de drop-down lijst. De kleur is bepalend welke 

kleur de buitenlijn van het geometrisch vlak krijgt. 
Indien u bij Type geometrie kiest voor type punt, dan vult u een puntstijl in. Wanneer u 

kiest voor lijn, dan kiest u een lijnstijl. U kunt nieuwe lijnpatronen definiëren via menu 
Referenties → Lijnpatronen. Meer informatie over lijnpatronen vindt u in bijlage E. 

 

 Lege thematische presentatie 

Wanneer voor de type klasseindeling Geen gekozen wordt, wordt er een lege thematische 
presentatie aangemaakt. Een lege thematische presentatie kan zowel gebruikt worden om 

een kaartlaag vorm te geven als om een thematische presentatie niet altijd actief te 

hebben. 
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In de stap Opmaak kan de kleur gedefinieerd worden welke achtergrond kleur het vlak dient 

te krijgen.  
 

 
 

In de stap Legenda items worden de legenda items gegenereerd.  
De kleur die is gekozen in de stap Opmaak is bepalend voor de kleur van de kaartobjecten. 

Deze kleur wordt nu toegepast in de kaart en in het legenda-item. Onderstaande afbeelding 

laat het enige legenda-item zien dat gegenereerd is. 
 

 
 

Een lege thematische presentatie kan niet alleen gebruikt worden i.c.m. een gevulde 
thematische presentatie (om deze laatste te deactiveren), maar ook om een kaartlaag en 

het bijbehorende legenda-item vorm te geven. Dit kan wel of niet in combinatie met een 

gevulde thematische presentatie. 
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 Thematische presentatie 

Wanneer er voor een ander klasseindeling wordt gekozen dan het type Geen, worden er 
meer velden getoond afhankelijk van de klasseindeling. 
 

 
 

Hieronder worden alle mogelijke invulvelden nader toegelicht: 
 
Stijl → Dient altijd te worden ingevuld. Een stijl bepaalt het uiterlijk van de kaartobjecten 

die binnen de thematische presentatie vallen. 
 

 
 
Attribuut →Het attribuut waarop de thematisering gebaseerd wordt. 

 



3. Basislagen 
 

Versie 1.0 18 NedBrowser Configuratiehandleiding 

Aantal klassen → Het aantal klassen dat gebruikt wordt bij het opbouwen van een 

thematische presentatie. Dit veld is alleen invulbaar en verplicht om in te vullen indien de 
klassenindeling Equal ranges of Equal counts wordt gebruikt.  

 
Minimum waarde → De laagste waarde die gebruikt wordt binnen de thematische 

presentatie. 

 
Maximum waarde → De hoogste waarde die gebruikt wordt binnen de thematische 

presentatie. 

 
Afrondingseenheid → Geeft aan op welke getal de verschillende klassen worden 

afgerond. Dit veld is verplicht om in te vullen indien de klassenindeling Equal ranges of 

Equal counts wordt gebruikt en mag niet 0 (nul) zijn. 

 
Er is een maximum aantal klassen gedefinieerd voor een nominaal thema in het menu 
Systeem → Instellingen → Beheeromgeving → Maximum aantal waarden in nominaal 
thema. 
 

 
 

In de volgende stap Legenda item “Overig”  kan aangegeven worden of er een legenda item 

Overig gegenereerd dient te worden en met welke kleur.  
 

 
 

In de opvolgende stap Opmaak is de mogelijkheid om of een themapalet (1) te gebruiken, 
een start- en eindkleur (2) of een attribuut (3) te gebruiken. 
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1. 

 
 

Themapalet → Hier kan aangegeven worden welke kleurenreeks er gebruikt wordt voor 
het opbouwen van de thematische presentatie. Een themapalet kan opgebouwd worden 
onder menu Referenties → Themapaletten. 
 
Startkleur palet → Hier kan een kleur uit het themapalet gekozen worden die wordt 
gebruikt als kleur voor de laagste/eerste waarde/klasse. 
 

 LET OP:  
Het aantal kleuren in het themapalet moet gelijk zijn of groter zijn dan het aantal klassen 
dat voorkomt in de thematische presentatie. Indien het palet minder kleuren heeft dan het 
aantal klassen zullen de kleuren van het themapalet opnieuw gebruikt worden (van voren af 
aan). 

 
2.

 
 

Kleur start → Kan gekozen worden indien geen themapalet wordt gekozen en waarbij de 
klasse-kleuren van de thematische presentatie geleidelijk dienen te verlopen tussen twee 
kleuren. Eén van deze twee kleuren wordt hier opgegeven.  
 
Kleur eind → Kan gekozen worden indien geen themapalet wordt gekozen en waarbij de 
klasse-kleuren van de thematische presentatie geleidelijk dienen te verlopen tussen twee 
kleuren. Eén van deze twee kleuren wordt hier opgegeven.  
Het gebruik van een start- en eindkleur geldt alleen indien het RGB palet wordt gebruikt. 
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3. 

 
 
Kleurattribuut → Indien de tabel een kolom bevat met kleurinformatie dan kan deze hier 
worden ingevuld. 
 
In de stap Legenda items is te zien is welke legenda items er zijn aangemaakt.  
 
Onderstaand figuur is hier een voorbeeld van: 
 

 
 
Voor iedere klasse van een thema wordt een legenda item gemaakt. Bij een legenda-item 
hoort een legenda-icoon dat in de legenda kan worden weergegeven.  
Het uiterlijk van een klasse wordt bepaald door de bij het thema gekozen stijl en de voor 
de klasse berekende kleur.  

 
Er is 1 bijzonder legenda-item (Overig of Default) om objecten te presenteren die niet in 1 
van de klassen valt van de legenda-items. Dit wordt aangegeven middels een lege waarde 
voor Ondergrens en Bovengrens. Het veld Naam op scherm is vrij invulbaar. Indien dit 
legenda-item niet aanwezig is worden dit soort objecten onzichtbaar, maar zijn nog steeds 
wel selecteerbaar.  
 
Gebruik de Where clause in de basislaag om ze niet selecteerbaar te maken. 
 
Legenda-items kunnen alleen worden bewerkt via de knop Edit. Er komt nu een extra 
scherm bij. 
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Volgnr → Dit is het volgorde nummer van de thematische presentatie zoals getoond wordt 
in de legenda van de webapplicatie. 
 
Naam op scherm → Deze is vrij invulbaar 
 
Ondergrens → De minimale waarde van de klasse 
Bovengrens → De maximale waarde van de klasse 
 
Type geometrie → Er zijn 3 mogelijkheden: Lijn, Vlak, Punt. 
 
Kleur → De kleur van het item. 
 
Stijl → De stijl van de legenda items kan handmatig worden aangepast (indien vinkje uit 
staat bij Legenda-items berekenen). Dit betekent dat binnen 1 thematische presentatie 
verschillende symbolen of patronen kunnen worden gebruikt. 
 

 Tekst thematische presentatie 

Indien in de stap Algemene gegevens voor de thematisering Tekst wordt gekozen, dan 

worden minder stappen doorlopen. 
 

 
 

Alleen de inhoud hoeft bepaald te worden, daarna kan worden vervolgd met autoriseren. 
 

Er dient in dit scherm aangegeven te worden welk type geometrie de tabel bevat, u kunt 
kiezen uit lijn of punt. Er kan worden aangegeven of het label de lijngeometrie volgt en 

welk attribuut er op het label dient te staan. 
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 Autoriseren 

In de laatste stap van de Wizard kunnen op reeds aangemaakte productlagen het thema 
geautoriseerd worden. 

 

 
 
Door de productlagen naar rechts te verplaatsen wordt de autorisatie geplaatst. In het 

midden staan hiervoor de knoppen. 
 

De thema’s kunnen ook handmatig geautoriseerd worden. Dit gaat via menu: 
Producten → Producten → selecteer een product → Productmenu’s → Productlagen →Edit. 
òf 
Producten → Productlagen → selecteer een productmenu → Selecteer de juiste laag  

→Edit. 
 

 
 

Op het tabblad Thema’s worden alle thema’s getoond die voor deze laag zijn gedefinieerd. 
Verplaats het thema naar rechts indien het thema voor dit product geautoriseerd dient te 

worden. 
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 Voorwaarden/opmerkingen 

 Algemeen 

Indien er geen Oracle object aanwezig is waarin zich de gewenste attributen bevinden, 
dient deze gemaakt te worden. Om een nieuw Oracle object (tabel/view/materialized 
view) te maken, zie bijlage B. 
 

 Redliningmogelijkheden instellen 

 Inleiding 

Om gebruikers te laten tekenen in NedBrowser (‘redlining’) zijn er twee mogelijkheden: 
- Redlining waarbij de data opgeslagen wordt in een redline tabel in een apart schema 

van dezelfde Oracle database als waar het NBG-stuurmodel is geïnstalleerd. 

- Redlining waarbij de data via een webservice, die de WFS-T standaard ondersteunt, 

wordt opgeslagen in een externe database. Dit kan een webservice op intranet maar 

ook op het internet zijn. Zo kunnen b.v. NedGlobe Mobile terugmeldingen worden 

gemuteerd. 

 Redlining via lokale redline tabel 

 Systeeminstellingen in groep Redlining controleren 

Voordat u met redlining aan de slag gaat, moeten de instellingen met betrekking tot 
redlining worden gecontroleerd via menu Systeeminstellingen → groep Redlining. 
 

 
 
Bij volgnummer 1 wordt het redline schema genoemd waar de redline tabellen zullen 
worden opgeslagen. Dit kan gewijzigd worden indien u een andere schemanaam wilt 
gebruiken. 
 
Volgnummers 2 t/m 5 bevatten de coördinaten van de minimum omhullende rechthoek 
van Nederland (dit zijn de coördinaten van de rechthoek waar precies het vasteland van 
Nederland helemaal inpast). In de meeste gevallen zal dit goed zijn ingevuld. 
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Volgnummer 6 is de tolerantie in meters, standaard staat dit op 0.0005 (dit is een halve 
millimeter). 
 
Volgnummer 7 is de standaard maximum lengte (in MB) van een bestand dat geüpload kan 
worden in een BLOB-attribuut in de database. Deze instelling kan per redline laag 
overruled worden. 
 

 Redline wizard scherm 1: Laag 

Start daarna de Redline wizard via menu Basislagen. Druk vervolgens op de knop Voeg 
redline laag toe. De eerste stap van de Redline wizard wordt getoond, in totaal zijn er 4 
stappen: 
 

 
 
Definieer in dit scherm de tabel en de naam van de redline laag: 
 

 
 
De volgende opties zijn belangrijk: 
 
Redline database schema → Naam van het database schema waarin de redline tabellen 
worden aangemaakt. De naam van het schema is niet wijzigbaar en kan ingesteld worden 
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via menu zie Systeeminstellingen → groep Redlining → database schema voor de redline 
tabellen. 
 
Tabelnaam → Vul hier de naam van de redline tabel in. De naam wordt automatisch in 
hoofdletters ingevuld. 
 
Er is weinig verschil tussen een redline tabel en een normale geo tabel. Dit betekent dat 
voor redline tabellen op dezelfde manier zoekresultaten, zoekingangen en relaties 
gedefinieerd kunnen worden als voor normale geo tabellen. 
 
Naam op scherm → Vul de naam van de redline laag in zoals dat in de webapplicatie 
getoond zal worden. 
 
Laagnaam → Naam van de redline laag voor intern gebruik in het stuurmodel. 
 
Laagprioriteit → Prioriteit nummer van de redline laag. 
 
Toon laagprioriteit → Met deze knop kunnen de laagprioriteiten van de overige lagen 
bekeken worden. De laag die bovenaan staat komt bovenop alle andere lagen in de kaart. 
Klik op een laag indien deze laagprioriteit gebruikt moet worden voor de redline laag. 
 
Productmenu → Deze keuzelijst wordt alleen getoond wanneer een nieuwe redline laag 
wordt gemaakt d.m.v. knop 'Voeg redline laag toe'. Kies hier een productmenu waarin de 
nieuwe redline laag geplaatst moet worden. Tevens worden automatisch een bijbehorend 
zoekresultaat, zoekingang, admin-geo en geo-admin relaties aangemaakt.  
  
Indien een reeds aangemaakte redline laag gewijzigd wordt m.b.v. knop 'Wijzig laag', dan 
is deze keuzelijst dus niet zichtbaar. Het productmenu kan dan als volgt verplaatst worden 
naar een ander product:  
 
1. Zorg ervoor dat de redline laag afgezonderd is in een apart productmenu van het 

product.  
2. Middels de knop 'Verplaatsen' kan het productmenu worden verplaatst naar een ander 

product.  
3. Het redline zoekresultaat kan naar het andere product worden verplaatst met de knop 

'Verplaatsen' in het Zoekresultaatscherm. De zoekingang en relaties verplaatsen dan 
automatisch mee. 

 
Documenten submap → Dit is de naam van de map onder NBG_Share/Documents waarin 
de documenten staan voor deze redline laag. 
 
Maximum lengte bestand (MB) → Dit is de maximum lengte (in MB) van een bestand dat 
geupload kan worden in een BLOB-attribuut in de database. 
Indien leeg dan wordt de Redlining systeeminstelling Maximum lengte bestand (MB) 
gebruikt. 
  
URL naar help document → URL van het optionele help document. #ROOT# en 
#NBG_ROOT# mag hierin worden gebruikt: 
 
- #ROOT# 
Dit is een verwijzing naar de root URL van de website, bijvoorbeeld http://nedbrowser/ 
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Let op: gebruik ROOT in hoofdletters, de URL bevat reeds een afsluitende / 
 
- #NBG_ROOT# 
Dit is een verwijzing naar de root URL van de NedBrowser website, bijvoorbeeld 
http://nedbrowser/nbg/ 
Let op: gebruik NBG_ROOT in hoofdletters, de URL bevat reeds een afsluitende / 
 
Voorbeeld: #NBG_ROOT#NBG_CUSTOM/NBG_CUSTOM_help_redlining.pdf 
NBG_CUSTOM_help_redlining.doc in de map Webapplicatie/NBGShare/NBG_CUSTOM kan 
als template dienen voor een aangepast help document voor Redlining. 
 
Venster eigenschappen → Alle eigenschappen die aan het te openen venster van het help 
document meegegeven kunnen worden. Het is de features parameter van Javascript 
functie 'window.open' 
Voorbeeld: 
width=800, height=500, left=250, top=50, toolbar=yes, resizable=yes 
 
Indien niet ingevuld dan wordt de waarde overgenomen van Webapplicatie 
systeeminstelling "Info venster eigenschappen". 
 
Toon knop "Object overnemen als redline object" → Geeft aan of de knop Bestaand(e) 
object(en) overnemen als redline object moet worden getoond in redline knoppenbalk:  
 

 
 
Toon knop "Wijzig geometrie" → Geeft aan of de knop Geometrie wijzigen moet worden 
getoond in redline knoppenbalk:  
 

 
 

Overzicht laaggebruik → Met deze knop wordt een overzicht getoond van het laaggebruik. 
 
Druk in de Redline wizard op de knop Volgende. 
 

 Redline wizard scherm 2: Attributen 
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In het tweede scherm worden de gegevens gedefinieerd die in de webapplicatie kunnen 
worden ingevuld bij het aanmaken van een nieuw redline element. Bijvoorbeeld: 
 

 
 

Met de knop Voeg attribuut toe kan een nieuw attribuut toegevoegd worden. 
 

 
 
De volgende opties zijn belangrijk: 

 

Naam in object → Vul hier de database kolomnaam in. Deze naam is uniek binnen de 
redline laag. De naam wordt automatisch in hoofdletters ingevuld. 
 
Naam op scherm → Naam van het attribuut zoals deze in de webapplicatie getoond zal 
worden. 
 
Datatype → Geef aan of het attribuut gegevens in alfanumeriek-, numeriek-, datum- of 
BLOB-formaat bevatten. 
 
Wanneer gekozen wordt voor datatype "BLOB", dan kan de gebruiker een bestand 
uploaden naar de database. 
 



3. Basislagen 
 

Versie 1.0 28 NedBrowser Configuratiehandleiding 

 
 
In de redline wizard bij stap 1 kan bij instelling Maximum lengte bestand (MB) aangegeven 
worden wat de maximum lengte (in MB) van een bestand is dat geüpload kan worden. 
Indien deze instelling leeg gelaten wordt, dan wordt de Redlining systeeminstelling 
Maximum lengte bestand (MB) gebruikt. 
 
Resultaat in NedBrowser: 
 

 
 
Lengte → Maximale invoerlengte van numerieke en alfanumerieke attributen. 
 
Decimalen → Voor numerieke velden is dit het aantal cijfers achter de komma (of punt). 
 
Lengte op scherm → De lengte in tekens van het invoerveld op het scherm. 
 
Lijst type → Voor een attribuut kan een lijst met mogelijke waarden worden getoond 
afhankelijk van deze instelling. Er zijn 4 mogelijke waarden:  
 
1. Geen lijst 

Er wordt geen lijst getoond. In de webapplicatie kan de gebruiker zelf een waarde 
invoeren.  

 
2. Drop down list 

In de webapplicatie wordt bij dit invulveld een lijst getoond waaruit de gebruiker een 
waarde dient te kiezen. Vrije invoer van het invulveld is niet mogelijk.  
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Voorbeeld stuurmodel: 
 

 
 

Resultaat in NedBrowser: 
Bij het invulveld Monument kan een naam van een monument worden geselecteerd 
via een uitklapmenu: 
 

 
 

3. Keuzelijst 
In de webapplicatie is voor dit invulveld een lijst opvraagbaar. Deze lijst wordt 
samengesteld aan de hand van het ingevoerde argument. Indien voor het attribuut 
STRAATNAAM het argument bos is ingevoerd zullen alle straatnamen die bos bevatten 
getoond worden in de lijst. Uit de lijst kan een waarde worden geselecteerd. Deze 
waarde wordt in het invulveld geplaatst. 
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Voorbeeld stuurmodel: 
 

 
 
Resultaat in NedBrowser: 
Bij het invulveld Straatnaam kan een gedeelte van de naam worden opgegeven: 
 

 
 

Wanneer nu op de lijst-knop wordt geklikt, dan worden alleen de waarden die bos 
bevatten getoond: 
 

 
 

4. Hyperlink  
In de webapplicatie wordt achter dit invulveld een knop geplaatst waarmee een 
document geselecteerd kan worden.  
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Voorbeeld stuurmodel: 
 

 
 
Resultaat in NedBrowser: 
Bij het invulveld Hyperlink kan een URL van een internetpagina worden ingevuld of een 
verwijzing naar een document op de server.  
 

 
 
Achter het invulveld worden 3 knoppen getoond:  
 

 De documentnaam kan worden ingetypt of geselecteerd worden met deze knop. 
 

 Met deze knop kunnen bestanden worden toegevoegd (uploaden). 
 

 Met deze knop kan de ingevulde hyperlink bekeken worden. 
 

Domein → Indien bij 'Lijst type' de optie 'Drop down list' of 'Keuzelijst' is gekozen dan dient 
hier een domein ingevuld te worden. In de webapplicatie wordt dan een lijst met waarden 
getoond in een uitklapmenu of keuzelijst.  
  
Een domein is een tabel met waarden en bevat een betekenis kolom en een code kolom. 
Bijvoorbeeld:  
  
code: betekenis:  
projectnummer projectnaam  
  
Domeinen kunnen worden gedefinieerd in het stuurmodel via menu Datamodel → 
Domeinen. Het betekenis-attribuut van het Domein wordt getoond in de lijst maar het code-

attribuut van het Domein wordt opgeslagen. 
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Objectattribuut voor lijst → Indien bij 'Lijst type' de optie 'Drop down list' of 'Keuzelijst' is 
gekozen, dan kan hier een objectattribuut ingevuld te worden. Voor het samenstellen van 
de lijst worden de verschillende waarden van het objectattribuut bepaald of als ook een 
Domein is ingevuld dan gelden de verschillende waarden van het Domein. 
 
Indien verschillende redline attributen gebaseerd zijn op objectattributen van hetzelfde 
object dan geldt dat de redline attributen automatisch afhankelijk van elkaar zijn in 
volgorde van tonen. De lijst van waarden van redline attribuut 2 wordt dan beperkt door 
de gekozen waarde van redline attribuut 1. Redline attribuut 2 kan pas worden ingevuld als 
de waarde van redline attribuut 1 bekend is. 
Bijvoorbeeld: woonplaats-straatnaam-huisnummer-huisletter-toevoeging. 
 
Resultaat in NedBrowser: 
 

 
 
Druk in de Redline wizard op de knop Volgende. 
 

 Redline wizard scherm 3: Tekenfuncties 

 
 
In het derde scherm moet allereerst een themanaam worden opgegeven. Dit is de naam 
van de thematische presentatie zoals getoond wordt in het lagenmenu (legenda) van de 
webapplicatie. 
 
Bij tekst functie attribuut kan via een uitklapmenu een attribuut worden gekozen, die is 
gedefinieerd in het vorige scherm. Indien dit veld is ingevuld (niet verplicht), dan verschijnt 
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dit als tekst-label in de kaart. Dit veld moet verplicht ingevuld worden indien een tekst 
tekenfunctie wordt gebruikt in de redline laag. Bijvoorbeeld: 
 

 
 
Vervolgens dienen één of meerdere tekenfuncties aangemaakt te worden. Eén bepaalde 
tekenfunctie omvat een type geometrie. Er zijn lijn-, punt-, tekst- en vlakfuncties. Als 
voorbeeld maken we van elk type 1 functie: 
 

 
 
Met de knop Voeg tekenfunctie toe kan er een tekenfunctie worden toegevoegd. 
 

 
 
De volgende opties zijn belangrijk: 
 
Naam in legenda → Naam van de redline tekenfunctie zoals deze in de webapplicatie 
wordt getoond. 
 
Naam in tabel → Naam van de redline tekenfunctie zoals deze in de tabel wordt 
opgeslagen.  
 
Type functie → Geeft aan welke redline tekenfunctie van toepassing is. 
 
Kleur → Kleur van de redline tekenfunctie. Met een knop kan een kleur uit het 
kleurdialoogvenster gekozen worden. 
 
Stijl knop → Met deze knop kan de stijl voor deze redline tekenfunctie worden ingesteld. 
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Vlakvisualisatie → Deze instelling wordt alleen gebruikt bij vlakken en bepaalt of een 
vlakstijl voor de vlakvulling en de rand toegepast moet worden en/of een puntstijl voor de 
vlakcentroïdes. 
 
Druk in de Redline wizard op de knop Volgende. 
 

 Redline wizard scherm 4: Autorisatie 

 
 
Tot slot kan in het laatste scherm aangegeven worden of de gebruikers uit een bepaalde 
gebruikersgroep redline elementen uit de redline laag mogen bekijken (oftewel 
geautoriseerd zijn) en of de gebruikers elementen mogen toevoegen/verwijderen aan 
redline lagen (optie Muteren). 
 
Indien de gebruikersgroep gedeautoriseerd is voor het redline object van de redline laag 
dan verschijnt een rood kruis in de kolom Geautoriseerd  en zijn de kolommen bij Muteren 
en Gebruikers leeg. Deautorisatie is in te stellen via menu Datamodel, optie Objecten of via 
Autorisatie, optie Gebruikersgroepen. 
 

 
 
Via de Edit knop in de kolom Gebruikers wordt een overzicht getoond van alle gebruikers 
van een gebruikersgroep en een vinkje Muteren. Met dit vinkje kunnen gebruikers 
geautoriseerd worden voor muteren ook als de gebruikersgroep zelf niet is geautoriseerd 
om te muteren.  
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Indien de Muteren-autorisatie voor bepaalde gebruikers afwijkt van Muteren-autorisatie 
van de gebruikersgroep, dan wordt achter de gebruikersgroep de melding Er zijn 
afwijkende Muteren-instellingen gevonden voor één of meer gebruikers getoond.  
 

 
 
Druk op de knop Voltooien. 
 

Na het opslaan wordt het hoofdscherm van de Redline wizard weer getoond. De redline 
laag Verkeersongelukken is nu succesvol toegevoegd: 
 

 
 

 Redlining via WFS-T webservice 

Start daarna de WFS Redline wizard via menu Basislagen. Druk vervolgens op de knop Voeg 
WFS redlining toe. De eerste stap van de Redline wizard wordt getoond, in totaal zijn er 4 
stappen net als bij de normale Redline Wizard. 
We zullen deze stappen hier niet herhalen maar beperken ons tot de verschillen. 

 Overzichtsscherm 

 
 
De verschillen in het overzichtsscherm t.o.v. de normale Redline Wizard zijn: 

 
- De kolommen Bevat data, Status, Rechten, Spatial index status en Thema’s zijn niet 

van toepassing voor WFS redline lagen en worden daarom niet getoond. 

- Via Importeer data kan een bulk import van data worden gedaan in een WFS redline 

laag. Als bron kan een willekeurige Oracle tabel worden gekozen waarvoor de NBG-

user select-rechten heeft.  

- Via Verwijder data kan alle data in de WFS redline laag worden verwijderd. Let op: 

alle elementen worden definitief verwijderd. Dit kan niet worden teruggedraaid. 
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- Er is geen mogelijkheid om data te exporteren. 

 Stap 1: WFS laag 

De verschillen in stap 1 t.o.v. de normale Redline Wizard zijn: 
 

- In plaats van een tabelnaam moet een WMS-laag gekozen worden waarvoor geldt 

dat het WFS-object ingevuld moet zijn. Er kan maar één WFS redline laag voor een 

WMS-laag worden gemaakt. 

- Er kan geen productmenu worden gekozen. Er wordt niet automatisch een 

productlaag aangemaakt en ook geen zoekingang, laagresultaat (geo->admin relatie) 

en admin->geo-relatie aangemaakt.  

- Er kunnen geen documenten geüpload worden in een attribuut van een WFS redline 

laag. De velden Documenten submap en Maximum lengte bestand (MB) ontbreken 

daarom t.o.v. de normale Redline Wizard.  

 Stap 2: Attributen 

De verschillen in stap 1 t.o.v. de normale Redline Wizard zijn: 
 

- De attributen worden automatisch bepaald aan de hand van het WFS object van de 

gekozen WMS laag.  

Deze attributen zijn ingelezen met Inlezen Datamodel. Ze hoeven en kunnen dus niet 

handmatig toegevoegd worden. Er kunnen per attribuut nog wel zaken aangepast 

worden door op de Edit-knop te drukken en dan Opslaan. Sommige attributen 

worden automatisch ingevuld bij het aanmaken, wijzigen of verwijderen van een 

redline element. Dit gaat via Automatisch invullen met. Indien dit veld is ingevuld dan 

zijn de andere velden niet van belang en worden niet getoond. Vergeet niet om op 

Opslaan te drukken indien dit wordt gewijzigd. Voor NedGlobe terugmeldingen 

wordt dit veld automatisch ingevuld aan de hand van de naam van het attribuut. Dit 

zijn de volgende attribuutnamen in kleine letters: 

- aanmaker (vullen met emailadres aanmaker of indien leeg de loginnaam) 

- aanmaakdatum (ook tijdstip) 

- gewijzigddoor (vullen met emailadres muteerder of indien leeg de loginnaam) 

- wijzigingdatum (ook tijdstip) 

 

- Er kunnen geen afhankelijkheden ingesteld worden voor het invullen van 

attribuutwaarden tussen verschillende attributen via Objectattribuut voor lijst. 

 Stap 3: Tekenfuncties 

De verschillen in stap 3 t.o.v. de normale Redline Wizard zijn: 
- Er is geen instelling voor Tekst teken functie.  

- Bij een tekenfunctie kan niet gekozen worden voor cirkel. 

- Er is geen instelling voor Naam in tabel (redline type). De presentatie in de kaart vindt 

namelijk plaats aan de webservice kant via een WMS-stijl (=thema van een WMS-

laag). 
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 Stap 4: Autorisatie 

Geen verschil met de normale Redline Wizard. 
 

 Redline laag toekennen aan product 

Tenslotte kunt u via menu Producten → Producten → Productmenu’s → Productlagen → 
Knop voeg productlaag toe of via menu Producten → Productlagen → Knop voeg 
productlaag toe deze redline laag aan een product toekennen. 
 

 
 

 Zoekingang en resultaatscherm maken 

Het is ook mogelijk om op redline elementen te zoeken. Hiervoor dient er een zoekingang 
in het stuurmodel aangemaakt te worden. Hanteer de volgende werkwijze: 

 
Maak allereerst een zoekresultaat aan gebaseerd op het object Verkeersongelukken via 
menu Producten → Producten → Zoekresultaten. 
 

 
 

 
 

Na het aanmaken van een zoekresultaat, kan vervolgens een zoekingang gemaakt worden 
via menu Producten → Producten → Zoekingangen. Kies bij Zoekresultaat het zojuist 
aangemaakte zoekresultaat door middel van de dropdown list. 
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In de webapplicatie wordt onderstaand zoekscherm getoond: 
 

 
 

Voor meer informatie over zoekingangen en resultaatschermen wordt verwezen naar 
hoofdstuk 7: Zoekingangen en resultaatschermen maken. 
 

 Laagresultaat maken 

Om informatie te kunnen opvragen van een redline element, moet aan de redline laag een 
resultaatscherm gekoppeld worden.  
 
Dit gaat via menu Producten → Producten → selecteer een product → Productmenu’s → 
Productlagen → tabblad Laagresultaten (zie onderstaande afbeelding). 
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Voor meer informatie over laagresultaten wordt verwezen naar § 7.3.1: Relaties tussen een 
resultaatscherm en een kaartlaag. 
 

 Extra thema’s aanmaken voor redlining met lokale redline tabel 

Voor redline lagen gebaseerd op een lokale redline tabel kunnen, net zoals bij gewone 
lagen, thema’s worden gedefinieerd. Voorbeeld: 
 

 
 

 Resultaat in NedBrowser 

In NedBrowser is er nu een nieuwe kaartlaag Verkeersongelukken te zien. Indien dit niet 
gelijk het geval is dient de website één of meerdere keren opnieuw opgestart te worden. 
De legenda ziet er als volgt uit voor redline lagen gebaseerd op een lokale redline tabel: 
 

 
 
Wanneer de laag Verkeersongelukken actief wordt gemaakt, dan verschijnt er een extra 
knoppenbalk linksboven in het kaartvenster met de tekenfuncties: 
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Onder de tekenfuncties zijn de volgend knoppen zichtbaar: 
 

 Optie Snap naar dichtstbijzijnde punt aan- of uitzetten. 
 

 Geometrie wijzigen (indien ingesteld in de redline wizard bij stap 1: Toon knop 
"Wijzig Geometrie"). 
 

 Gegevens van een element wijzigen. 
 

 Bestaand(e) object(en) overnemen als redline object (indien ingesteld in de redline 
wizard bij stap 1: Toon knop "Object overnemen als redline object"). 
 

 Element(en) verwijderen uit de kaartlaag. 
 

 Help opvragen (indien ingesteld in de redline wizard bij stap 1: Toon knop "URL naar 
help document"). 
 

 Annuleren (knoppenbalk sluiten). 
 
De overige knoppen in de knoppenbalk zijn tekenfuncties die gedefinieerd zijn in het 
stuurmodel (Redline wizard scherm 3) en dienen voor het toevoegen van redline 
elementen aan de redline laag. 
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Wanneer op de knop van een tekenfunctie wordt gedrukt, kan het redline element 
getekend worden in de kaart. Daarna wordt er een invulscherm getoond (Redline wizard 
scherm 2), die er als volgt uit ziet: 
 

 
 
De gebruiker vult de invulvelden in en drukt op de knop OK. In de kaart verschijnt het 
redline element. Naast het element wordt de omschrijving getoond. Deze omschrijving is in 
het stuurmodel (Redline wizard scherm 3) ingevuld bij tekst functie attribuut. 
 

 
 

Indien de knop  wordt gebruikt en de redline-kaartlaag is actief kunnen gegevens van 
het element worden opgevraagd. Het redline object wordt geselecteerd in de kaart en de 
bijbehorende administratieve gegevens verschijnen in het gegevensvenster onder de 
detailkaart: 

 

 
 

Zo kunnen verschillende gebruikers(groepen) die geautoriseerd zijn voor dit product 
verkeersincidenten tekenen, bevragen en verwijderen. Gebruikers die geen muteer-
rechten hebben op een redlinelaag, krijgen ook geen extra knoppenbalk in hun 
NedBrowser-scherm te zien indien ze op deze redlinelaag klikken in de legenda. 
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 WMS/WFS-lagen beheren 

 Inleiding 

Naast de basislagen (gebaseerd op Oracle geometrie objecten) kan ook extern 
kaartmateriaal toegevoegd worden aan NedBrowser. Dit wordt gedaan met behulp van 
Web Map Service (WMS) of Web Feature Service (WFS), open standaarden van het Open 
GIS Consortium (OGC) voor het uitwisselen van kaartmateriaal.  
 
WFS biedt de mogelijkheid om geografische objecten middels allerlei 
selectiemogelijkheden (zowel via een geografische als een administratieve zoekopdracht) 
te zoeken. Dit is tegenstelling tot WMS, waar naast het opvragen van een plaatje alleen 
geografisch objectgegevens op één specifieke X/Y locatie opgevraagd kunnen worden. 

 
De eindgebruiker merkt niet veel of een laag gebaseerd is op een Oracle object of een 
WMS/WFS. Er zijn de volgende verschillen: 
 
WMS 

• Op WMS-lagen zijn alleen puntselecties mogelijk met pijltje of doorprikknop.  
o Er wordt een foutmelding (“Voor deze laag zijn alleen puntselecties mogelijk”) 

getoond indien de gebruiker een rechthoek-, cirkel-, polygoon of buffer-selectie 
probeert te doen op de actieve laag. 

• WMS-lagen verschijnen niet in de doorpriklijst indien andere selectie-knoppen actief 
zijn.  

• WMS-lagen verschijnen ook niet in de lijst met lagen in het buffer-scherm.  

• Van WMS-lagen worden wel resultaten getoond, maar vanuit deze resultaten kunnen 
geen kaartobjecten worden opgelicht of geselecteerd.  
Het is dus éénrichtingsverkeer.  

• Voor een WMS-laag kunnen geen zoekingangen gedefinieerd worden. 

• Het is niet mogelijk administratieve en geografische relaties te leggen. 

• Ook de andere knoppen voor WMS resultaten zijn niet zichtbaar (exporteren naar 
Excel, etc.), behalve de knop Afdrukken. 

• Het WMS-zoekresultaat kan afgedrukt worden, zowel via het Totaalrapport als via het 
printonderdeel “Resultaten” in een print template. 

 
WFS 

• Voor WMS lagen gebaseerd op een WFS object zijn punt-, cirkel-, rechthoek- en 
polygoon-selecties mogelijk. 

• Het is mogelijk om kaartobjecten te selecteren of op te lichten met een WFS 
zoekresultaat. 

• Geselecteerde c.q. opgelichte objecten van WFS-lagen worden op dezelfde manier 
ingekleurd als geselecteerde c.q. opgelichte objecten uit normale lagen. 

• WFS-lagen worden wel getoond in de doorpriklijst. 

• WFS-lagen verschijnen niet in de lijst met lagen in het buffer-scherm.  

• Voor een WFS-laag kunnen zoekingangen/zoekresultaten gedefinieerd worden. 

• Het is mogelijk administratieve relaties te leggen naar andere zoekresultaten voor een 
WFS-zoekresultaat. De relatieketen mag echter maar uit één objectrelatie bestaan. 

• Het is mogelijk geografische relaties te leggen naar andere kaartlagen voor een WFS-
zoekresultaat. De relatieketen mag echter maar uit één objectrelatie bestaan. 

• Het WFS-zoekresultaat kan afgedrukt worden, zowel via het Totaalrapport als via het 
printonderdeel “Resultaten” in een print template. 
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 Stuurmodel instellingen 

In het stuurmodel kunt u de WMS/WFS-lagen instellen via menu Basislagen → WMS lagen. 
In dit scherm worden de URL’s van de WMS-en vastgelegd en per WMS een aantal lagen. 
De volgende opties zijn belangrijk: 
 
Url → URL van de Web Map Service of Web Feature Service. 
 
Bijvoorbeeld: 
http://geodata.nationaalgeoregister.nl/bestuurlijkegrenzen/ow

s 

 

 LET OP:  
De webapplicatie server moet toegang tot internet hebben. Dit is nodig zodat in de 
beheeromgeving op de WMS-lagen pagina de ‘Voeg WMS laag toe’ knop gebruikt kan 
worden om de lagen op te vragen van een bepaalde WMS. 
 
Indien de locatie van de URL zich achter een firewall bevindt en niet direct benaderd 
kan worden, dient er een proxy server ingesteld te worden via de systeeminstelling 
onder de groep ‘Proxy instellingen’ 

 
Druk vervolgens in het lagenscherm op de knop: 
 

 
 
De volgende zaken worden dan gecontroleerd: 
1. Of de WMS bestaat; 
2. Of de WMS minimaal de systeeminstelling Formaat van plaatje dat gegenereerd moet 

worden ondersteunt (zie stuurmodel menu Systeeminstellingen → groep GeoTools); 

3. Of de WMS image formaat PNG ondersteunt, dit wordt namelijk altijd voor printen 
gebruikt. 

 
Indien de volgende melding bovenin getoond wordt, betekent dit dat de WMS bestaat en 
kan doorgegaan worden met het invullen van de overige velden in het stuurmodel. 
 

 
 
Image formaat → Selecteer het formaat van het plaatje dat gegenereerd moet worden. 
Kies formaat image/gif voor een beste performance. Kies image/png (indien aanwezig) 
voor de beste kwaliteit. 
 
Info Format → Selecteer een formaat uit de lijst d.m.v. het drop-down menu. 
In de webapplicatie kunnen van een WMS-laag gegevens opgevraagd worden door middel 
van een puntselectie in de kaart. Voor WMS lagen gebaseerd op een WFS object zijn punt-, 
cirkel-, rechthoek- en polygoon-selecties mogelijk. In het resultaten gedeelte wordt dan de 
informatie getoond. Per WMS kunnen de gegevens in verschillende formaten worden 
beantwoord. Afhankelijk van de WMS kunnen dit zijn: 
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1. application/vnd.ogc.gml  
2. application/vnd.ogc.wms_xml 
3. text/html 
4. text/plain 
5. text/xml 
 
Kies indien mogelijk application/vnd.ogc.gml of text/xml. Deze formaten worden op 
dezelfde manier gepresenteerd als normale zoekresultaten en kunnen ook getoond 
worden in het Totaalrapport en als Print zoekresultaat. Dat geldt niet voor de formaten 
text/plain en text/html. 
 
WMS Specifieke Parameters → Ruimte voor specifieke parameters (niet WMS-standaard) 
is optioneel. Vraag bij de leverancier van de WMS wat hier ingevuld moet worden. 
 
Bijvoorbeeld:  
DATASOURCE=GIE of STYLES= 

 
Na het invullen van de verplichte velden Image formaat en Info formaat, drukt u op de 
knop:  
 

 
 

WFS 
Indien er geen WFS informatie aanwezig is, kan verder gegaan worden met het toevoegen 
van WMS lagen. 
 
Indien de WMS server ook als WFS server kan dienen, dan wordt de volgende knop 
getoond: 
 

 
 
Druk op bovenstaande knop. De WFS versie wordt bepaald (NedBrowser ondersteunt 
alleen WFS versie 1.1.0) en de volgende knop wordt getoond: 
 

 
 
Om objecten uit de WFS server te kunnen opslaan in het stuurmodel moet er eerst een 
connectie te worden aangemaakt waaronder deze objecten vallen. Bovenstaande knop 
zorgt daarvoor. 
 

 
 
Om de WFSconnectie te verwijderen drukt u op bovenstaande knop. Deze knop zorgt 
ervoor dat de WFS connectie wordt verwijderd. Alle objecten en daaraan gerelateerde 
lagen, zoekresultaten e.d. worden daarmee ook verwijderd. 
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Gebruik deze knop om voor WFS gegevens objecten aan te maken in de beheeromgeving. 
Op basis hiervan kunnen op de gebruikelijke wijze zoekresultaten en zoekingangen 
aangemaakt worden.  
WFS zoekresultaten kunnen als gekoppeld (Geo->Admin en Admin->Geo) worden aan een 
WMS product laag. Daarvoor moet eerst bij de WMS laag een WFS object zijn vastgelegd 
(=gekoppeld). 
Er kunnen geen lagen of thema's gemaakt worden op basis van WFS objecten en 
attributen. In de WMS laag kan de stijl (=thematische presentatie) worden gekozen uit de 
lijst van stijlen die door de WMS leverancier beschikbaar is gesteld. 
 
Lagen toevoegen 
Voeg een laag toe d.m.v. de knop Voeg WMS laag toe. Er wordt een nieuwe pagina 
geopend. De volgende velden zijn belangrijk: 
 
WMS Laagnaam → Hier kan een laag d.m.v. de drop-down lijst worden gekozen. In de lijst 
worden alle lagen binnen de WMS getoond. 
 
Laagnaam in NedBrowser → De naam van de laag zoals hij in de Webapplicatie getoond 
wordt. 
 
WMS 

 
 
Maximum aantal te selecteren objecten zonder WFS → Maximaal aantal te selecteren 
objecten indien er geen WFS object voor de WMS laag wordt gebruikt. 
In dat geval wordt er een WMS GetFeatureInfo request gedaan.  
 
Achtergrond transparant → Indicatie (J/N) of de achtergrond van de WMS-laag 
transparant is of niet. 
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WFS 

 
 
Maximum aantal te selecteren objecten zonder WFS → Voor een WFS object mag 
“Maximum aantal objecten” leeg gelaten worden. In dat geval wordt Beheeromgeving 
systeeminstelling "Maximum aantal records in een zoekresultaat" overgenomen.  
 

 WMS-laag stijlen 

Nadat een nieuwe WMS laag is opgeslagen middels de knop Opslaan worden de 
beschikbare stijlen (“WMS styles”) zichtbaar.  
 

 
 
WMS stijlen zijn vergelijkbaar met thema’s van normale lagen. Ze worden in het 
productlaag-scherm ook getoond en geautoriseerd als thema’s. Van een WMS stijl (thema) 
kan o.a. de naam en de volgorde in de legenda worden aangepast met de Edit knop. 
 

 WMS-laag prioriteit 

In menu Basislagen → Laagprioriteit (Edit of Drag&drop) worden de WMS-lagen getoond. 
Middels deze pagina kunnen de prioriteiten van de lagen worden ingesteld. De laag die 
bovenaan staat, komt bovenop alle andere lagen in de kaart. 
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 WMS-laag toekennen aan product 

WMS 
Tenslotte kunt u via menu Producten → Producten → Productmenu’s →Productlagen → 
Knop voeg productlaag toe of via menu Producten → Productlagen → Knop voeg 
productlaag toe deze WMS-lagen aan een product toekennen. Vul de minimum en 
maximum schaalfactor in. 

 
Aangezien er geen laagresultaten/zoekingangen/kaartrelaties gedefinieerd hoeven te 
worden, zal de WMS-laag nu zichtbaar zijn in NedBrowser. 
 
WFS 
Indien de WMS server ook als WFS server dient, dan zijn in de beheeromgeving objecten 
aangemaakt m.b.v. de knop Inlezen datamodel . Op basis hiervan kunnen op de 
gebruikelijke wijze lagen, zoekresultaten, zoekingangen e.d. worden gedefinieerd. 
 

 LET OP:  
Om WMS lagen te kunnen ontsluiten moeten de webserver en de 
Tomcat/GeoTools server verbinding met internet hebben. 

 

 WMTS-lagen beheren 

Aan NedBrowser kan ook extern kaartmateriaal toegevoegd worden met behulp van een 
Web Map Tiling Service (WMTS), een standaard van het Open GIS Consortium (OGC) voor 
het ontsluiten van kaarten. 
 
Sinds NedBrowser 7.0 kan dit niet meer rechtstreeks via het stuurmodel. Er dient een WMS 
gemaakt te worden op basis van de WMTS via NedGeoservices-MapProxy. 

  



3. Basislagen 
 

Versie 1.0 48 NedBrowser Configuratiehandleiding 
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 KAARTMENU 

 Inleiding 

 
 
 
 
 
 
 
 

 

 

 

De webapplicatie bevat een drietal kaartmenu’s (knoppenbalken), te weten: 
 
1. Menu boven de kaart 
2. Menu onder de kaart 
3. Print menu 

 
Een kaartmenu bevat onderdelen waarmee functionaliteiten worden aangeroepen om de 
detailkaart te bewerken. Elke gebruikersgroep kan een ander kaartmenu (boven en onder) 
hebben. Ook kan per printtemplate het print menu verschillen.  
 
 
 

 
 
Figuur 4.1 Overzicht van de afhankelijkheden van de kaartmenu’s. 

 

 Onderdelen 

De inhoud van de kaartmenu’s en de volgorde van de knoppen en velden kunt u zelf 

bepalen. Een kaartmenu bestaat uit verschillende onderdelen, zoals: 
 

1. Knoppen 
Een knop in de knoppenbalk kan ingedrukt 

worden waarmee acties op de detailkaart 

uitgevoerd kunnen worden. 
 

 

1. Datamodel 

2. Basislagen 

3. Kaartmenu 

5. Producten 

6. Autorisatie 

Referenties 

Systeem 

Help 

Statistiek 

4. Printen 
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Knoppen worden in het stuurmodel vastgelegd 
via menu Kaartmenu’s → Knoppen. 

 

Standaard wordt in het stuurmodel een aantal 
knoppen meegeleverd. U kunt hier ook nieuwe 

knoppen aan toevoegen, zie § 4.2.1: Zelf 
knoppen definiëren. 

 

2. Invoervelden 
Er wordt een tekstvak getoond waar een 

willekeurige tekst ingevuld kan worden. Druk op 
<enter> om de ingevoerde waarde toe te 

passen. 

 
Invoervelden worden in het stuurmodel 
vastgelegd via menu Kaartmenu’s → 
Invoervelden. 
 

 

3. Keuzelijsten 
Er wordt een lijst getoond met beschikbare 

waarden. Deze waarden zijn in het stuurmodel 

gedefinieerd als optielijst via menu Referenties 
→ Optielijsten. 

 

Keuzelijsten worden in het stuurmodel 
vastgelegd via menu Kaartmenu’s → 
Keuzelijsten.  

 
4. Tekstvelden 

Een tekstveld is een read-only veld. 
 

Tekstvelden worden in het stuurmodel 
vastgelegd via menu Kaartmenu’s → 
Tekstvelden. 

 

 

 Zelf knoppen definiëren 

Naast de standaard meegeleverde knoppen kunt u ook eigen knoppen definiëren.  
Er kan gebruik gemaakt worden van de standaard functie NBG_MAP_open_url. Dit is een 
procedure om een URL te tonen in een nieuw venster. 
 
Parameters van NBG_MAP_open_url zijn: 
 
1. Naam van het te openen venster 
Gebruik een willekeurige naam zodat de URL telkens in hetzelfde venster wordt geopend. 
Bijvoorbeeld: 'OBLIQUE_SP' 
 
2. Venster eigenschappen 
Dit zijn alle eigenschappen die je aan een venster kunt geven. Dit is de features parameter 
van Javascript functie 'window.open'. 
 
3. URL adres 
Dit is de URL die gestart moet worden wanneer op de knop wordt geklikt met de 
linkermuisknop. 
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4. Open venster (Y/N) 
 
Deze parameter geeft aan of meteen een venster geopend moet worden ('Y') of dat er 
eerst in de kaart geklikt moet worden ('N'). Indien 'Y' dan moet "Actief maken" uitgevinkt 
zijn, anders aangevinkt. 
 
5. Houd statistieken bij (Y/N) 
Indien 'Y' dan dient via menu Referenties, optie Statistieken een statistiek toegevoegd te 
worden met dezelfde naam als de functie (knop). 
 
Voorbeeld: 
NBG_MAP_open_url('OBLIQUE_SP','toolbar=no,location=no,directories=no,status=no,men
ubar=no,scrollbars=no,resizable=yes,copyhistory=no','http://obliek.slagboomenpeeters.co
m/index_popup.php?appcode=[APPCODE]&x=#RD_X#&y=#RD_Y#','N','Y'); 
 
Let op: Voor de knop OBLIQUE_SP geldt dat [APPCODE] vervangen moet worden door de 
waarde van de applicatie code die de klant van Slagboom en Peeters krijgt. Deze is per 
klant uniek. 
 
In de derde parameter van functie NBG_MAP_open_url kan een aantal constanten worden 
gebruikt tussen twee # tekens. De constanten zijn: 
 
- #RD_X# 
Dit is een verwijzing naar de X-coördinaat (RD) van het huidige kaartcentrum. 
Let op: gebruik RD_X in hoofdletters. 
 
- #RD_Y# 
Dit is een verwijzing naar de Y-coördinaat (RD) van het huidige kaartcentrum. 
 
Let op: gebruik RD_Y in hoofdletters. 
 
- #WGS84_X# 
Dit is een verwijzing naar de X-coördinaat (WGS84=GPS) van het huidige kaartcentrum. 
Let op: gebruik WGS84_X in hoofdletters. 
 
- #WGS84_Y# 
Dit is een verwijzing naar de Y-coördinaat (WGS84=GPS) van het huidige kaartcentrum. 
Let op: gebruik WGS84_Y in hoofdletters. 
 
- #RD_MIN_X# 
Dit is een verwijzing naar de minimum X-coördinaat (RD) van het huidige kaartvenster. 
Let op: gebruik RD_MIN_X in hoofdletters. 
 
- #RD_MIN_Y# 
Dit is een verwijzing naar de minimum Y-coördinaat (RD) van het huidige kaartvenster. 
Let op: gebruik RD_MIN_Y in hoofdletters. 
 
- #RD_MAX_X# 
Dit is een verwijzing naar de maximum X-coördinaat (RD) van het huidige kaartvenster. 
Let op: gebruik RD_MAX_X in hoofdletters. 
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- #RD_MAX_Y# 
Dit is een verwijzing naar de maximum Y-coördinaat (RD) van het huidige kaartvenster. 
Let op: gebruik RD_MAX_Y in hoofdletters. 
 
- #WGS84_MIN_X# 
Dit is een verwijzing naar de minimum X-coördinaat (WGS84=GPS) van het huidige 
kaartvenster. 
Let op: gebruik WGS84_MIN_X in hoofdletters. 
 
- #WGS84_MIN_Y# 
Dit is een verwijzing naar de minimum Y-coördinaat (WGS84=GPS) van het huidige 
kaartvenster. 
Let op: gebruik WGS84_MIN_Y in hoofdletters. 
 
- #WGS84_MAX_X# 
Dit is een verwijzing naar de maximum X-coördinaat (WGS84=GPS) van het huidige 
kaartvenster. 
Let op: gebruik WGS84_MAX_X in hoofdletters. 
 
- #WGS84_MAX_Y# 
Dit is een verwijzing naar de maximum Y-coördinaat (WGS84=GPS) van het huidige 
kaartvenster. 
Let op: gebruik WGS84_MAX_Y in hoofdletters. 
 
- #SCALE# 
Dit is een verwijzing naar de huidige schaal van de kaart 
Let op: gebruik SCALE in hoofdletters. 
 
- #ROOT# 
Dit is een verwijzing naar de root URL van de website, bijvoorbeeld http://nedbrowser/ 
Let op: gebruik ROOT in hoofdletters, de URL bevat reeds een afsluitende / 
 
- #NBG_ROOT# 
Dit is een verwijzing naar de root URL van de NedBrowser website, bijvoorbeeld 
http://nedbrowser/nbg/ 
Let op: gebruik NBG_ROOT in hoofdletters, de URL bevat reeds een afsluitende / 
 
Hanteer de volgende werkwijze: 
 
1. In het stuurmodel, ga naar menu Kaartmenu → Knoppen → Knop voeg knop toe. Vul 

de volgende velden in: 
 

Naam → Naam van de functie. 
 
Procedure aanroep → Procedure aanroep met een aantal parameters 
 
Hint Tekst → Hint tekst (tooltip) die zichtbaar wordt wanneer de gebruiker met de 
muis over de knop beweegt. 
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Filenaam symbool Normaal, Over, Actief → Maak 3 iconen aan: 1 icoon voor de knop 
in normale toestand, 1 icoon als de muis over de knop beweegt en 1 icoon als op de 
knop wordt geklikt. Vul hier de bestandsnamen in. 

 
Actief Maken → Indicatie (J/N) die aangeeft of de knop ingedrukt blijft nadat er op 
geklikt is. 
 

 
 

2. Ga vervolgens naar menu Kaartmenu → Kaartmenu’s → Edit en voeg de zojuist 
aangemaakte knop, via de knop voeg functie toe, OPEN_WINDOW toe aan een 
kaartmenu: 

 

 
 

 Kaartmenu’s 

Via menu Kaartmenu → Kaartmenu’s  → Voeg kaartmenu toe  kunnen met deze 
onderdelen verschillende kaartmenu’s samengesteld worden. Geef het kaartmenu een 
Naam en sla dit op. Druk op  Voeg functie toe en selecteer een Kaartmenu functie d.m.v. de 
drop down box Geef de kaartmenu functie het juiste Volgnr en vink aan of er een 
Scheidingsteken getoond moet worden na de kaartmenu functie. Kies voor Opslaan. 
 
Selecteer vervolgens m.b.v. het dropdown menu een Standaard knop. Deze knop zal initieel 
aan staan in het kaartmenu. Indien er geen Standaard knop wordt ingevuld, zal 
automatisch de eerste knop in het kaartmenu de actieve knop worden. 
 
Tot slot dienen de kaartmenu’s toegekend te worden aan gebruikersgroepen en 
printtemplates. 
 
Ga naar menu Autorisatie → Gebruikersgroepen → Edit en geef bij Kaartmenu op welk 
kaartmenu voor boven en onder gebruikt moet worden: 
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Geef bij menu Printen → Print Templates →  Edit op welk menu moet worden getoond bij 
de betreffende printtemplate: 
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 PRINTEN 

 Inleiding 

 
 
 
 
 
 
 

 

NedBrowser bevat een uitgebreide printmodule. Als applicatiebeheerder definieert u de 

zogenaamde printtemplates. De gebruiker van de webapplicatie kiest tijdens het printen één 
van de printtemplates waarvoor hij geautoriseerd is. 

 
 

 

 
 

 
 

 
 

 

 
 

 
 

 
Figuur 5.1 Overzicht van de afhankelijkheden in de printmodule. 

 
 

Iedere printtemplate is gebaseerd op een bepaald papierformaat en bestaat uit: 
1. Vaste printonderdelen: deze worden getoond op een door de applicatiebeheerder 

voorgedefinieerde positie, zoals detailkaart, overzichtskaart, legenda, schaalbalk, etc. 
2. Optionele printonderdelen: deze onderdelen kunnen door de gebruiker aan- en 

uitgezet worden. 
3. Printparameters: dit zijn instellingen die de opmaak van de printonderdelen kunnen 

wijzigen, zoals lettertype, kleur, etc. 
 
Standaard wordt in het stuurmodel een serie printtemplates meegeleverd die in de meeste 
gevallen voldoende zal zijn om een afdruk te maken op de meeste gangbare 
papierformaten. 
 
Voor het inrichten van de printmodule volgt u de volgende werkwijze: 
1. Printmenu beheren; 
2. Zoompercentages definiëren; 
3. Papierformaten beheren; 
4. Kaartlagen beheren; 
5. Laagresultaten beheren; 

Papierformaten 

Printparameter
s 

Printonderdelen 

Printtemplates 

Kaartmenu’s 
 

Optielijsten 
 

Zoompercentages 
 

1. Datamodel 

2. Basislagen 

3. Kaartmenu 

5. Producten 

6. Autorisatie 

Referenties 

Systeem 

Help 

Statistiek 

4. Printen 
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6. Redlining categorieën beheren; 
7. Printparameters beheren; 
8. Printonderdelen beheren; 
9. Printtemplates beheren; 
10. Printtemplates aan gebruikersgroepen toekennen; 
11. ActiveX instellingen wijzigen. 
 
Dit werkproces zal in de volgende paragrafen worden toegelicht. 
 

 Printmenu beheren 

 
 

De knoppenbalk boven het printvoorbeeld bevat knoppen waarmee het kaartonderdeel in 
het printvoorbeeld bewerkt kan worden; zoals het zoomen naar vorige kaart. In het 
stuurmodel wordt deze knoppenbalk gedefinieerd als Print_menu via menu Kaartmenu → 
Kaartmenu’s → Edit. 
 

 Zoompercentages definiëren 

De gebruiker van de NedBrowser printmodule kan door middel van het tweede 
uitklapmenu in de knoppenbalk het printvoorbeeld in- of uitzoomen. De waarden in deze 
lijst worden in het stuurmodel gedefinieerd als PRINT_ZOOM_PERCENTAGE via menu 
Referenties → Optielijsten → Edit. 
 

 Papierformaten beheren 

 
 

Het papierformaat wordt gebruikt voor het afdrukken van kaarten. Via menu Printen → 
Papierformaten → Edit  kunnen de afmetingen van het papier en de marges in een 
bepaalde eenheid worden opgegeven. 
 
De volgende optie is belangrijk: 
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Default zoom percentage → Dit is het percentage waarin het printvoorbeeld wordt 
getoond indien door de gebruiker een nieuwe printtemplate wordt gekozen. Om de gehele 
pagina op het scherm te kunnen tonen, zal voor papierformaat A0 een kleiner default 
zoompercentage worden ingesteld dan voor papierformaat A4. 
 

 Kaartlagen beheren 

 
 

Wanneer de printtemplate een legendaonderdeel of een copyrightonderdeel bevat dienen 
er in het stuurmodel per laag de volgende instellingen gemaakt te worden via menu 
Basislagen → Normale lagen→ Edit : 
 
Copyright regel → De regel die hier ingevuld wordt, wordt zichtbaar in het 
copyrightonderdeel indien de kaartlaag zichtbaar is op het printvoorbeeld. 
 
Print legenda → Kies een waarde uit de volgende opties: 
1. Actief en zichtbaar → opnemen in print legenda indien de kaartlaag actief én zichtbaar 

is; 
2. Zichtbaar → opnemen in print legenda indien de kaartlaag zichtbaar is; 
3. Nooit → nooit opnemen in print legenda. 
 

 Laagresultaten beheren 

 
 

Voor het printen van administratieve gegevens van geselecteerde kaartobjecten dient via 
menu Producten → Producten → Productmenu’s → Productlagen→ Edit → tabblad 
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Zoekresultaten of via menu Producten → Productlagen → Edit → tabblad Zoekresultaten 
vastgelegd te worden hoe de zoekresultaten getoond moeten worden. Kies bij Type relatie 
voor optie Print of Normaal + Print. 

 Printparameters beheren 

Printparameters zijn instellingen die de opmaak van de printonderdelen kunnen 
beïnvloeden, zoals lettertype, kleur, etc. Zodra de gebruiker van de NedBrowser 
printmodule één van deze instellingen wijzigt, zullen de desbetreffende printonderdelen in 
het printvoorbeeld automatisch worden aangepast. 
De printparameters kunt u onderverdelen in groepen. Zo kan er bijvoorbeeld onderscheid 
worden gemaakt tussen wijzigbare en niet wijzigbare printparameters. Wijzigbare 
printparameters zullen op het scherm worden getoond, wanneer de gebruiker een bepaald 
printtemplate kiest. Wijzigbare printparameters kan de gebruiker aanpassen, niet 
wijzigbare printparameters worden vooraf door de applicatiebeheerder ingesteld. 
 
De volgende opties zijn belangrijk: 
 
Volgnr → Dit nummer geeft aan in welke volgorde de printparameters in het printscherm 
te zien zijn, indien de printparameter wijzigbaar is door de gebruiker. 
 
Type → Er zijn vijf mogelijkheden: 
 

1. Normaal → Indien dit type wordt 
gekozen, wordt de parameter als 
tekstvak getoond waar een 
willekeurige tekst ingevuld kan 
worden. 

 

  
2. Checkbox → De parameter wordt 

als zogenaamde checkbox getoond, 
deze kan aan- of uitgevinkt 
worden. 

 

  
3. Schaal → Er wordt een lijst 

getoond met beschikbare schalen. 
Deze schalen zijn in het stuurmodel 
gedefinieerd als optielijst SCALE via 
menu Referenties → Optielijsten. 

 

  
4. Kaartstatus → Dit is een interne 

parameter die NIET zichtbaar zal 
zijn voor de gebruiker van de 
NedBrowser printmodule. Deze 
parameter bevat de status van de 
kaart die door de kaartgenerator 
wordt meegegeven. Deze 
parameter is nodig bij de standaard 
printonderdelen CHART, 
OVERVIEW, LEGEND, RESULTS en 
COPYRIGHT. 

Niet zichtbaar voor de gebruiker. 
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5. Huidige datum/tijd → Indien dit 
type wordt gekozen, wordt in het 
tekstvak standaard de huidige 
datum/tijd ingevuld. 

 

  
Datatype → Er zijn drie mogelijkheden: 
 

1. Alfanumeriek → In de 
printparameter kan een 
alfanumerieke waarde worden 
ingevuld. 

 

  
2. Datum → In de printparameter 

moet een geldige datum/tijd 
worden ingevuld. Indien de 
parameter wijzigbaar is en de 
gebruiker vult geen geldig 
datum/tijd in, dan zal de volgende 
foutmelding worden getoond 
indien op de knop Toepassen wordt 
gedrukt: 

 

  
3. Numeriek → Indien dit type is 

ingesteld, mag de in 
printparameter alleen een 
numerieke waarde worden 
ingevuld. Indien dit niet het geval 
is, zal de volgende foutmelding aan 
de gebruiker worden getoond: 

 
 

 
Optielijst → Indien de gebruiker een waarde uit een lijst moet kiezen (zie onderstaande 
afbeelding), dan kan hiervoor een optielijst worden ingesteld. Deze optielijsten worden in 
het stuurmodel gedefinieerd via menu Referenties → Optielijsten. 
 

 
 
Maximale invoerlengte → Dit is het maximaal aantal karakters dat de gebruiker kan 
invullen.  
 
Display breedte → Indien geen breedte ingevuld wordt, dan zal automatisch de breedte 
worden bepaald. Wanneer hier bijvoorbeeld breedte 3 wordt ingevuld, zal in het invulveld 
er als volgt uit zien: 
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Display hoogte → Indien geen hoogte ingevuld wordt, dan zal het invulveld van de 
printparameter met een standaard hoogte worden getoond. Indien hoogte 2 wordt 
ingevuld, kan de gebruiker een tekst invullen die meerdere regels kan beslaan. 
 

 
 
Verplicht → Indicatie of de parameter verplicht moet worden ingevuld indien de 
parameter wijzigbaar is. 
 
Wanneer de gebruiker geen waarde invult en de parameter is verplicht, dan zal de 
volgende foutmelding aan de gebruiker worden getoond indien op de knop Toepassen 
wordt gedrukt: 
 

 
 
Wijzigbaar → Geeft aan of de parameter wijzigbaar is door de gebruiker. Wanneer de 
parameter NIET wijzigbaar, zal de applicatiebeheerder een standaard waarde in moeten 
vullen. Indien dit niet het geval is dan zal de volgende foutmelding links onder in het 
stuurmodel scherm worden getoond: 
 

 
 

 Parameter CHART_ROTATION 

Voor parameter CHART_ROTATION in groep Kaart geldt: Raster kaartlagen (ECW) en WMS 
kaartlagen kunnen niet geroteerd worden. Zet deze lagen dus uit wanneer een kaart 
geroteerd geprint moet worden. 
 

 Printonderdelen beheren 

Standaard zullen in het stuurmodel de volgende printonderdelen meegeleverd worden: 
1. Detailkaart 
2. Overzichtskaart 
3. Legenda 
4. Resultaten 
5. Copyright 
6. Schaal-afbeelding 
7. Schaal-tekst 
8. Disclaimer 
9. Titel 
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10. Vrije tekst 
11. Logo 
12. Noordpijl 
13. Datum 
 
Er wordt onderscheid gemaakt tussen optionele- en niet optionele printonderdelen. Niet-
optionele onderdelen zullen standaard voor de gebruiker zichtbaar zijn. 
 
Optionele onderdelen kunnen door de gebruiker aan- en uitgezet worden. Dit kan door het 
desbetreffende printonderdeel aan- of uit te vinken, zodat deze gelijk zichtbaar of 
onzichtbaar wordt in het printvoorbeeld. 
Als de gebruiker een printtemplate heeft gekozen, wordt er een lijst met optionele 
printonderdelen getoond aan de linkerkant van het scherm (zie onderstaande afbeelding).  
 

 
 
De volgende opties zijn belangrijk: 
 
Laagnr → Wanneer onderdelen elkaar overlappen, dan ligt het onderdeel met het hoogste 
nummer bovenop. Wanneer bij het legenda-onderdeel laagnr 3 is ingesteld en het kaart-
onderdeel heeft laagnr 1, dan zal de legenda boven op de kaart worden afgebeeld in het 
printvoorbeeld: 
 

 
 
Breedte & Hoogte → Hier kan de breedte en de hoogte van het printonderdeel worden 
opgegeven in de eenheid die is ingesteld. 
 
Randstijl → Hier kan een stijl voor de rand van het onderdeel worden ingesteld. Er kan 
gekozen worden uit randstijlen die zijn gedefinieerd als optielijst PRINT_BORDER via menu 
Referenties → Optielijsten. 
 
Aanpassen aan inhoud → Wanneer deze optie is uitgevinkt zal het printonderdeel altijd de 
opgegeven breedte en hoogte behouden. Als deze optie wordt aangevinkt, dan zullen de 
breedte en de hoogte van het onderdeel worden aangepast aan de inhoud.  
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Bijvoorbeeld:  
 

Aanpassen aan inhoud: 
 

 

NIET aanpassen aan inhoud: 
 

 

 
Tonen → Er zijn drie mogelijkheden: 
1. Verplicht, altijd tonen → Dit onderdeel zal standaard zichtbaar zijn voor de gebruiker. 
2. Optioneel, initieel aan → De gebruiker heeft de mogelijkheid om dit onderdeel in- of 

uit te schakelen. Standaard zal dit onderdeel ingeschakeld zijn, dus getoond worden in 
het printvoorbeeld. 

3. Optioneel, initieel uit→ De gebruiker heeft de mogelijkheid om dit onderdeel in- of uit 
te schakelen. Standaard zal dit onderdeel niet ingeschakeld zijn, dus niet getoond 
worden in het printvoorbeeld. 

 

 Parameters 

Na het vastleggen van de onderdelen, dient u aan te geven uit welke parameters de 
onderdelen bestaan. 
 

 
 
De volgende opties zijn belangrijk: 
 
Naam → Naam van een eerder vastgelegde parameter, deze is uit een lijst te selecteren 
(drop-down menu). 
 
Naam in URL → Dit is een interne naam van de parameter zoals die wordt doorgegeven 
aan het printonderdeel. Kies hier een van de voorgedefinieerde URL namen. Voor een 
compleet overzicht van de URL namen zie de help. 
 
Tekst voor → Tekst die voor de parameter wordt geplakt. Als bijvoorbeeld bij scale-tekst-
onderdeel 'Schaal:1' wordt ingesteld, dan ziet dit printonderdeel er als volgt uit: 
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Tekst na → Tekst die achter de parameter wordt geplakt. 
 

 Printtemplates beheren 

Standaard zal in het stuurmodel een aantal templates aanwezig zijn die zijn gebaseerd op 
de meest gangbare papierformaten. 
 
Voor iedere printtemplate wordt een naam en omschrijving vastgelegd, welk 
papierformaat wordt gebruikt, welke onderdelen op welke positie op het printvoorbeeld 
verschijnen en welke kaartknoppen er gebruikt worden. 
 

 Onderdelen 

Op het eerste tabblad heeft u de mogelijkheid om onderdelen aan een printtemplate toe 
kennen. Een printonderdeel kan worden toegevoegd door op de knop Voeg print onderdeel 
toe te kiezen. Hier kan er gekozen worden uit een lijst van bestaande printonderdelen door 
middel van drop-down menu. 
 
Behalve Volgnr, X en Y positie worden de volgende eigenschappen standaard gevuld met 
de waarden van het printonderdeel uit paragraaf 5.8. Indien u wilt afwijken van de 
standaard waarden, kunt u deze waardes overschrijven. 

• Laagnr 

• Ankerpunt 

• Eenheid 

• Breedte 

• Hoogte 

• Randstijl 

• Aanpassen aan inhoud 

• Optioneel 
 
De volgende opties zijn belangrijk: 
 
Volgnr → Dit nummer geeft aan in welke volgorde de optionele printonderdelen in het 
linker gedeelte van het printscherm te zien zijn. 
 
X & Y → De X en Y positie van het ankerpunt van het onderdeel in het printvoorbeeld. 
Het nulpunt van X en Y ligt links boven.  
 

 Parameters 

Voeg hier alleen parameters toe indien de parameter eigenschappen voor de gekozen 
printtemplate afwijken van de standaard eigenschappen. 
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 Autoriseren printtemplates 

Tot slot dienen de printtemplates toegekend te worden aan een gebruikersgroep via menu 
Autorisatie → Gebruikersgroepen → Printtemplates. Verschuif de printtemplate naar 
rechts als de printtemplate onderdeel moet uitmaken van deze gebruikersgroep. 
 

 
 
Indien een gebruiker op geen enkel template rechten heeft, dan zal de volgende melding te 
zien zijn in de webapplicatie: 
 

 
 
Per gebruikersgroep kan de default printtemplate worden aangegeven via menu 
Autorisatie → Gebruikersgroepen → Edit . Gebruik het drop-down menu om een template 
uit de lijst te kiezen. Dit template krijgt de gebruiker als eerst te zien als de printmodule 
opgestart wordt. 
 

 
 

 ActiveX instellingen wijzigen 

Wanneer de gebruiker een afdruk gaat maken, dienen de volgende instellingen in Internet 
Explorer door iedere gebruiker handmatig aangepast te worden: 
 
1. Op het papieren printresultaat staat een kop- en een voettekst. Deze teksten bevatten 

de paginanummers, de URL en de naam van de applicatie (NedBrowser). 
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Kies in Internet Explorer Bestand → Pagina-instelling. Hier kan zowel de koptekst als 
de voettekst verwijderd worden. 

 
2. Aangezien de printtemplates in de NedBrowser printmodule eigen marges hanteren, 

dienen de standaard pagina-instellingen van Internet Explorer voor marges aangepast 
te worden voordat er een afdruk wordt gemaakt. 

 
In Internet Explorer dient Bestand → Pagina-instelling gekozen te worden. De marges 
die gedefinieerd zijn in het stuurmodel dienen ingevuld te worden bij Links/Rechts en 
Boven/Onder. 

 
3. Om achtergrondkleuren en afbeeldingen te kunnen printen vanuit Internet Explorer 

(o.a. nodig voor de legenda en schaalbalk), dient elke gebruiker de volgende instelling 
aan te passen: in Internet Explorer, ga naar menu Extra → Internet Opties → tabblad 
Geavanceerd. Zet het vinkje aan bij Afdrukken achtergrondkleuren en plaatjes. 
 

Instelling UIT: Instelling AAN: 

  
 

  
 
U als applicatiebeheerder kunt ervoor zorgen dat deze handmatige aanpassingen niet meer 
nodig zijn. Dit gaat als volgt: 
 
1. In het stuurmodel, ga naar menu Systeem → Instellingen → groep Webapplicatie. Zet 

de instelling Indicatie of ActiveX gebruikt mag worden op Ja (zie onderstaande 
afbeelding).  
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2. Bij iedere gebruiker zal in Internet Explorer een instelling moeten worden gewijzigd: 
 

Wanneer NedBrowser geen intranet website is: 
 

• Voeg de NedBrowser website toe aan de lijst van vertrouwde websites in Internet 
Explorer van de client PC’s. 

 

 LET OP:  
Zet eerst het vinkje UIT bij Serververificatie (https) voordat de site wordt 
toegevoegd. 

 

• Vervolgens dient voor iedere eindgebruiker binnen de vertrouwde websites de 
volgende optie ingeschakeld te zijn: 'ActiveX-besturingselementen die niet zijn 
gemarkeerd als veilig initialiseren en uitvoeren in scripts'. 

 

• Zie Internet Explorer → menu Extra → optie Internet Opties → tabblad Beveiliging. 
 

Wanneer NedBrowser een intranet website is: 
 

• Het is voldoende om binnen lokaal intranet alleen de volgende optie op 
ingeschakeld te zetten: 'ActiveX-besturingselementen die niet zijn gemarkeerd als 
veilig initialiseren en uitvoeren in scripts'. 

 

• Zie Internet Explorer → menu Extra → optie Internet Opties → tabblad Beveiliging. 
 
Indien in het stuurmodel de systeeminstelling Indicatie of ActiveX gebruikt mag worden op 
Ja staat, maar bij de gebruiker is in Internet Explorer de optie ‘ActiveX-besturingselementen 
die niet zijn gemarkeerd als veilig…’ nog niet ingeschakeld, dan zal aan de gebruiker de 
volgende melding getoond worden. 
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   LET OP:  
ActiveX wordt alleen ondersteund in Internet Explorer. In andere browsers dienen de 
opties voor kop- en een voettekst, marges en achtergrondkleuren printen handmatig 
aangepast te worden. 
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 PRODUCTEN 

 Inleiding 

  

 
 

 

 
 

 
 

 
 

Onder productfunctionaliteit wordt verstaan het kunnen bundelen van gegevens en 
functionaliteit die logisch gezien bij elkaar horen (= productgroep) om dat aan de 
eindgebruiker ter beschikking te stellen.  
 
Een productgroep bestaat uit een aantal basisproducten. Aan een gebruikersgroep 
worden één of meer productgroepen toegekend. Een productgroep kan gebruikt worden 
bij meerdere gebruikersgroepen. 
 
Basisproducten zijn complementair, dat betekent dat ze geen gemeenschappelijke 
basislagen, zoekresultaten, zoekingangen en relaties hebben. 
 
Voordelen van complementaire basisproducten zijn: 

• Productlagen, zoekresultaten, zoekingangen en relaties worden maar één keer 
vastgelegd. Dit betekent minder beheer en onderhoud voor u als applicatiebeheerder. 

• Complementaire basisproducten kunnen makkelijker worden geëxporteerd en 
geïmporteerd. 

 
Een basisproduct bestaat uit één of meer productlagen. Relaties tussen zoekresultaten en 
productlagen van verschillende basisproducten zijn mogelijk. Dit worden 
productkoppelingen genoemd. Productkoppelingen zijn relaties (admin → admin/geo, geo 
→ admin) tussen zoekresultaten/productlagen van twee verschillende basisproducten. 
Voordeel hiervan is dat zoekresultaten/productlagen maar één keer gedefinieerd hoeven 
te worden. 
 
Objecten en attributen kunnen per gebruikersgroep worden gedeautoriseerd. Op deze 
manier kan bijvoorbeeld het attribuut “WOZ-waarde” onzichtbaar worden gemaakt voor 
bepaalde gebruikersgroepen. Dit heeft als voordeel dat hetzelfde basisproduct 
herbruikbaar is voor meerdere gebruikersgroepen. 
 

1. Datamodel 

2. Basislagen 

3. Kaartmenu 

5. Producten 

6. Autorisatie 

Referenties 

Systeem 

Help 

Statistiek 

4. Printen 
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In de webapplicatie zal in het lagenmenu er als volgt uit zien: 
 

Een productgroep heeft een aantal 
basisproducten. 
 
Een product heeft een aantal 
productmenu’s. 
 
Een productmenu heeft een aantal 
(redline)lagen. 
 
Een laag heeft een aantal thema’s en 
labels. 
 
Indien er maar 1 productgroep, 1 product 
of 1 menu aanwezig is, dan wordt dit 
niveau niet getoond in het lagenmenu. 
 

 
 
 

 
Figuur 6.1 Overzicht van de afhankelijkheden van producten 
 

 Producten samenstellen 

Producten worden in het stuurmodel gedefinieerd via menu Producten → Producten. 
 

Per product kunnen instellingen worden gedaan wat betreft: 

• De toegankelijkheid voor zoekingangen, resultaatschermen en kaartlagen; 

• Autorisatie voor raadplegen, toevoegen of verwijderen van elementen op redlinelagen; 
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 Producten kopiëren 

 
Met deze knop kunnen producten op twee manieren worden gekopieerd:  
  
1. Naar een nieuw leeg product. Op deze manier ontstaat een exacte kopie.  
2. Naar een bestaand product. De inhoud van het product wordt aan een ander product 

toegevoegd. Dit kan alleen als de producten geen overeenkomende zoekingangen, 
zoekresultaten en productmenu's hebben. Hierdoor is het mogelijk om standaard 
producten te maken die gebruikt kunnen worden in een ander product. 

 

 Productmenu’s beheren 

Lagen binnen een product worden onderverdeeld in menu's. Via menu Producten → 
Producten → Productmenu’s kunnen menu’s worden aangemaakt. 
 
De volgende opties zijn belangrijk: 
 
Transparantie instellen → Indien aangevinkt, kan de eindgebruiker de mate van 
transparantie van alle lagen van dit productmenu tegelijk instellen in het lagenmenu m.b.v. 
een dropdownlijst, beginnend met 100% = geen transparantie t/m 10% = 90% transparant. 
 

 LET OP:  
Voor ECW lagen (b.v. luchtfoto's) heeft deze instelling geen effect aangezien die geen 
transparantie ondersteunen. Voor WMS lagen geldt dat dit afhankelijk is van de WMS 
service en het formaat van het plaatje dat in te stellen is bij de WMS. 

 
Zichtbaarheid → Standaard waarde voor de transparantie. 
 
Eén laag tegelijk tonen → Indien aangevinkt, kan in het lagenmenu van dit productmenu 
slechts één laag tegelijkertijd zichtbaar worden gemaakt d.m.v. een "radio button". Dit is 
handig voor een productmenu met alleen volledig dekkende lagen zoals luchtfoto’s van 
meerdere jaren. Voorbeeld webapplicatie: 
 

 
 

 Productmenu met ondergrondlagen 

Het is mogelijk om links onder in de kaart met een icoon snel te wisselen van 
ondergrondlaag, b.v. van PDOK BRT achtergrondkaart naar een luchtfoto. Dit kunnen er 
ook meer dan twee zijn, er wordt steeds gewisseld naar de volgende ondergrondlaag in de 
reeks. Om dit mogelijk te maken zijn de volgende stappen nodig: 
 
1. Productmenu maken met daarin de productlagen die dienen als ondergrondlaag. Het 

vinkje Eén laag tegelijkertijd tonen moet zijn aangevinkt. 
De basislagen (normale laag of WMS-laag) die hierin opgenomen zijn mogen niet 
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gebruikt zijn in een andere productlaag die is geautoriseerd aan de gebruiker. Maak 
eventueel een kopie van zo’n normale laag of WMS-laag. Voor een redline 
ondergrondlaag kan een normale laag op basis van het redline object worden gemaakt. 

2. Ondergrondlaag-productmenu voor gebruikersgroepen kiezen via Autorisatie → 
Gebruikersgroepen → Edit. 

3. Ondergrondlaag-icoon-bitmaps maken en vervolgens importeren via Systeem → 
Bitmap upload →Voeg bitmap toe. 

4. Ondergrondlaag-iconen kiezen via Basislagen → Normale lagen → Edit en Basislagen 
→ WMS lagen → Edit → WMS laag → Edit. 

 

 Productgroepen beheren 

Productgroepen worden in het stuurmodel gedefinieerd via menu Producten → 
Productgroepen → Edit of menu Producten → Productgroepen → knop Voeg productgroep 
toe. 
Selecteer vervolgens de producten die tot deze productgroep behoren. 
 

 Productlagen beheren 

In het stuurmodel kunt u de algemene eigenschappen van de kaartlagen instellen via menu 
Basislagen → Normale lagen → Edit. Vervolgens kunt u via menu Producten → Producten 
→ Productmenu’s → Productlagen → knop Voeg productlaag toe of via menu Producten 
→ Productlagen → Knop Voeg productlaag toe deze basislagen aan een product 
toekennen. 
 
De lagen worden in de webapplicatie in het lagenmenu getoond, gegroepeerd per 
productgroep/product/menu en op volgorde van hun volgnummer. Vanuit het lagenmenu 
kan een aantal acties worden uitgevoerd die invloed hebben op de inhoud van het 
kaartvenster, zoals: 

• Actief maken van een laag; 

• Zichtbaar/onzichtbaar maken van lagen; 

• Selecteren van thema’s; 

• Selecteren van labels. 
 
De volgende opties zijn belangrijk: 
 
Laagnaam→ Dit is de laagnaam van de normale, redline of WMS laag voor de presentatie 
in de kaart. Een normale, redline of WMS laag mag maar één keer gebruikt worden in het 
lagenmenu dat geautoriseerd is aan een gebruiker. 
 
Naam op scherm → Tekst die in het lagenmenu wordt gebruikt om de laag aan te duiden. 
 
Volgnr → Dit nummer geeft aan in welke volgorde de kaartlagen in het productmenu te 
zien zijn. 
 
Minimum/maximum schaalfactor → Dit geeft het bereik voor de zichtbaarheid van de 
productlaag in de kaart. Voor WMS lagen geldt dat het bereik voor zichtbaarheid tevens 
afhankelijk is van de achterliggende WMS. 
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Productmenu → Het productmenu waarin de laag wordt geplaatst. 
 
Default thema (optioneel) → Het thema (styling/thematisering) dat standaard wordt 
toegepast. 
 
Label scheidingsteken → Teken dat als scheiding wordt gebruikt tussen de waarden van 
verschillende label-attributen. 
 
Selectie basislaag (optioneel) → Naam van de normale laag voor de selectie van 
geografische objecten. Indien dit attribuut niet is ingevuld dan wordt de presentatie laag 
ook gebruikt voor selectie. Dit is de normale situatie. 
 
Referentie productlaag (optioneel) → Dit is de laag die als referentie wordt gebruikt bij de 
presentatie van geografische objecten (bijvoorbeeld de contouren van flatgebouwen bij de 
presentatie van verblijfsobjecten). De referentie productlaag wordt automatisch aangezet 
indien de laag wordt aangezet. Van de referentie productlaag kunnen geen objecten 
worden geselecteerd.  
 
In de webapplicatie wordt de referentielaag in het lagenmenu cursief weergegeven. 
De referentielaag kan niet actief gemaakt worden aangezien in deze laag geen objecten 
kunnen worden geselecteerd. 
 
Onderscheidend attribuut (optioneel) → Onderscheidend attribuut dat wordt gebruikt bij 
het doorprikken indien objecten van dezelfde laag elkaar overlappen of als precies op een 
grens wordt doorgeprikt. 
 
Tooltip attribuut (optioneel) → Attribuut dat wordt gebruikt in de tooltip indien "Tooltip 
tonen" is aangevinkt. 
 
Trefwoorden (optioneel) → De trefwoorden die hier zijn ingevuld kunnen worden gebruikt 
om te zoeken in het onderwerpen-zoekveld bovenin NedBrowser.  
 

 
 
Er kunnen meerdere trefwoorden opgegeven worden gescheiden door puntkomma (;). 
Trefwoorden kunnen in de beheeromgeving worden toegevoegd bij productlagen, 
productmenu’s en producten. 
 
Minimum selectie schaal (optioneel) → Minimum schaalfactor voor het inzoomen op 
geselecteerde zoekresultaten. 
 
Tonen in → Geeft aan of de laag in Detailkaart (grote kaartvenster) en/of in de 
Overzichtskaart getoond moet worden.  
De afbeeldingen die worden getoond in de overzichtkaart worden hergebruikt, zodat niet 
bij ieder kaartbeeld een nieuwe afbeelding gegenereerd hoeft te worden. Na het aan/uit 
vinken van deze optie is het nodig om NedBrowser te forceren een nieuwe overzichtskaart 
te genereren. Dit gaat als volgt:  
In het stuurmodel, ga naar menu Systeem → Systeeminstellingen → groep GeoTools → 
Overzichtskaart: Prefix voor de bestandsnaam.  
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Hoog bijvoorbeeld de numerieke waarde op met 1. Bijvoorbeeld: NBG_ov1 wordt 
NBG_ov2.  
Eventueel de cache van Internet Explorer leegmaken (tijdelijke internetbestanden 
verwijderen). 
 
Initieel tonen → Geeft aan of deze laag in eerste instantie (d.w.z. bij het laden) aan staat 
en getoond moet worden in het kaartvenster. 
 
Uitgeschakeld → Indien de laag is uitgeschakeld dan wordt deze niet meegenomen in het 
lagenmenu. 
 
Aanvinkbaar → Geeft aan of deze laag aan/uitgevinkt kan worden door de eindgebruiker.  
 
Actief (selecteerbaar) maken → Geeft aan of deze laag actief gemaakt kan worden. Dit 
betekent dat er in deze laag objecten geselecteerd mogen worden. 
 
Selecteren na PDOK zoeken met huisnummer → Indicatie of na het zoeken op een PDOK 
adres met huisnummer automatisch doorgeprikt en geselecteerd moet worden in deze 
laag. 
 
Uitgeklapt tonen → Indicatie of deze laag in eerste instantie (d.w.z. bij het laden) 
uitgeklapt is in het menu en meteen alle bijbehorende legenda-items, thematische 
presentaties en labels laat zien. 
 
Info/metadata tonen → Indien deze optie is aangevinkt, dan wordt een info (metadata) 
knop getoond achter de laagnaam in het lagenmenu: 
 

 
 
Hiermee kan de gebruiker informatie opvragen van de betreffende laag. 
Indien de gebruiker op deze knop drukt wordt er een venster geopend. Geef bij Info 
venster eigenschappen alle eigenschappen op die aan het te openen venster meegegeven 
kunnen worden. Het is de features parameter van Javascript functie 'window.open'. 
  
Voorbeeld:  
width=800, height=500, left=250, top=50, toolbar=yes, resizable=yes 

 

Deze info knop opent een nieuw venster met daarin 
NBG_CUSTOM/NBG_CUSTOM_layer_info.asp. Dit is een voorbeeld ASP voor het tonen van 
metadata van een laag en kunt u naar uw wensen aanpassen of raadpleeg hiervoor een 
consultant van NedGraphics. 
 
Voor meer informatie, zie bijlage C. 
 
Tooltip tonen → Op basis van het onderscheidend attribuut wordt er in de website een 
tooltip getoond. Deze tooltip wordt na 2 seconde getoond, bijvoorbeeld bij het geo-
kadaster het perceelnummer. 
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Transparantie instellen → Indien aangevinkt dan kan de eindgebruiker de mate van 
transparantie van de laag instellen in het lagenmenu m.b.v. een dropdownlijst, beginnend 
met 100% = geen transparantie t/m 10% = 90% transparant. 
 

 
 
Let op: Voor WMS lagen geldt dat dit afhankelijk is van de WMS service en het formaat van 
het plaatje dat in te stellen is bij de WMS. 
Bij Zichtbaarheid kan de standaard (initiële) transparantie worden ingesteld. 
 
Labels / symbolen / lijnpatroon / lijnen schalen → Hiermee wordt aangegeven of labels, 
symbolen, lijnpatronen en lijnen groter afgebeeld moeten worden als er ingezoomd wordt 
en kleiner als er uitgezoomd wordt. De ingestelde groottes van labels (via Tekststijl), 
symbolen (via legenda-item), lijnpatronen (via Lijnpatroon) of lijnen (via legenda-item) 
gelden dan voor schaal 1:1000. 
 
Transparant indien raster → Indicatie of de vlakvulling uit moet gaan indien een raster 
laag zichtbaar is onder deze laag. Een normale laag of WMS laag is een raster laag indien 
het vinkje Raster aangevinkt is in het normale laagscherm of WMS laagscherm. Niet van 
toepassing voor WMS lagen omdat de transparantie daarvan niet uitgeschakeld kan 
worden. 
 
Label conflicten oplossen → Indien aangevinkt dan worden labels verschoven of niet 
allemaal getoond indien er reeds andere labels aanwezig zijn. Dit geldt alleen voor labels 
van dezelfde laag of andere lagen waarbij deze instelling is aangevinkt. Tevens geldt dat 
labels van onderliggende lagen (=hoger laagprioriteitsnummer) als eerste worden getekend 
en labels van bovenliggende lagen zich daaraan aanpassen maar alleen als voor de 
onderliggende laag de instelling ook is aangevinkt. Door in de Tekststijl de grootte kleiner 
te maken zullen er meer labels getoond kunnen worden. 
Indien uitgevinkt dan worden labels altijd getoond op de plaats waar ze horen maar 
kunnen dan overlappen met andere labels waardoor het onleesbaar kan worden. 
Let op: Dit wordt niet ondersteund voor WMS lagen. 
 
Labels lijnpositie → Mogelijke opties zijn “Op lijn” en “Boven lijn”. Bij “Op lijn” wordt de 
labeltekst verticaal gecentreerd op de lijn. Bij “Boven lijn” wordt de labeltekst precies op 
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de lijn geplaatst. Geldt ook voor labels van lijngeometrie die niet zichtbaar wordt gemaakt 
(b.v. straatnamen).  
Let op: Dit wordt niet ondersteund voor WMS lagen. 
  
Tabblad Thema’s → Verschuif de thema’s naar rechts die bij dit product moeten worden 
getoond. 
 

 
 
Tabblad Labels → Definieer de labels voor de geselecteerde laag. Maak een keuze uit 
attributen van het geo object (of een hieraan gerelateerd object) van de normale laag 
waarop de productlaag is gebaseerd. Een gerelateerd object moet een directe objectrelatie 
hebben met het geo object. Relatieketens worden niet ondersteund. De objectrelatie mag 
maar 1 relatie-attribuut bevatten. Tevens moet het gerelateerde object dezelfde connectie 
hebben als het geo object. 
 

 
 
Let op: Zijn de labels niet zichtbaar in NedBrowser? Bijvoorbeeld wanneer een heel groot 
object wordt afgebeeld in de overzichtskaart. Er is dan geen tekst te zien omdat deze heel 
klein wordt afgebeeld. Dit is als volgt op te lossen: 
  
1. Schakel het meeschalen van de labels uit. 
Selecteer de betreffende laag en schakel het vinkje 'Labels schalen' uit. 
  
of 
  
2. Wijzig de tekst grootte van de labels. 
Selecteer de betreffende laag en kies de knop 'Label tekststijl'. 
 
Tabblad Buffer-filters → Definieer hier de filterattributen die gebruikt worden voor een 
bufferselectie in de browser. Maak een keuze uit attributen van het geo object (of een 
hieraan gerelateerd object) van de normale laag waarop de productlaag is gebaseerd. Een 
gerelateerd object moet een directe objectrelatie hebben met het geo object. 
Relatieketens worden niet ondersteund. De objectrelatie mag maar 1 relatie-attribuut 
bevatten. Tevens moet het gerelateerde object dezelfde connectie hebben als het geo 
object. 
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Tabblad Laagresultaten → Definieer administratieve resultaten voor de geselecteerde 
laag. Elk zoekresultaat verschijnt in een aparte tab in de webapplicatie na een selectie van 
1 of meer objecten in de kaart van de betreffende laag. 
 

 
 
Tabblad Legenda-filters → Definieer hier de filterattributen die gebruikt worden in de 
legenda in de browser. Legenda-filters zijn niet beschikbaar voor WMS lagen. 
Maak een keuze uit attributen van het geo object. Het is niet mogelijk te filteren met 
attributen uit een gerelateerd object. 
 

 
 
Resultaat in NedBrowser: 
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 ZOEKINGANGEN EN RESULTAATSCHERMEN MAKEN 

Een zoekingang is altijd gekoppeld aan een resultaatscherm. In dit resultaatscherm worden 
de zoekresultaten getoond waarvan de criteria ingevuld zijn in de zoekingang. 
 

 Resultaatscherm 

Allereerst dient dus een resultaatscherm gedefinieerd te worden via Producten → 
Producten → Zoekresultaten → knop Voeg zoekresulaat toe. 
 

 
 
De volgende opties zijn belangrijk: 
 
Object → Door een bestaand object te selecteren (via het drop-down menu) wordt 
aangegeven van welk object het resultaatscherm de gegevens toont. 
 
Naam → Een willekeurige naam waarmee het resultaatscherm wordt benoemd. 
 
Order by clause → Hiermee kan aangegeven worden in welke volgorde de gegevens 
getoond worden in het resultaatscherm. Er geldt dat attributen moeten worden voorzien 
van ##. Tevens kan aangegeven worden of de gegevens oplopend (asc) of aflopend (desc) 
gerangschikt dienen te worden. 
 
Voorbeeld:  
#naam# desc 

 

Where clause → Indien alleen een gedeelte van de gegevens getoond dient te worden kan 
een where-clause gebruikt worden. Tevens geldt deze opgelegde beperking voor de 
zoekingang. Hier geldt net als bij de order by-clause dat attributen moeten worden 
voorzien van ##.  
 
Voorbeeld:  
#datum_registratie# > to_date('01-01-2003','DD-MM-YYYY') 

 

Distinct → Geeft aan of het zoekresultaat gegarandeerd unieke resultaten oplevert of niet.  
  

 LET OP:  
Aanvinken van 'Distinct' heeft geen effect wanneer het zoekresultaat een 
administratieve-relatie of kaart-relatie heeft. In dat geval wordt het primary key veld 
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automatisch mee geselecteerd (dit is nodig voor de koppeling). In dat geval worden er 
dubbele records getoond.  
Om dit te voorkomen dient een apart zoekresultaat gedefinieerd te worden dat geen 
administratieve- of kaart-relaties heeft. 

 
Regelnummer tonen → Hiermee kan aangegeven worden of een regelnummer getoond 
moet worden vóór het administratief gegeven in het resultaatscherm (zie onderstaande 
afbeelding). 
 

 
 

Rapport URL → Indien Rapport URL is ingevuld, dan wordt een knop getoond (gedefinieerd 
bij Icoon URL over/normal) boven de zoekresultaten in de webapplicatie: 
  

 
 
Indien de gebruiker een aantal zoekresultaten aanvinkt en op deze knop drukt, wordt er 
een venster geopend (eigenschappen volgens Venster eigenschappen) met een aanroep 
naar een gedefinieerd rapport (Rapport URL).  
 
Voor meer informatie, zie bijlage D. 
 
Info/metadata opvragen → Indien deze optie is aangevinkt, dan wordt een info 
(metadata) knop getoond boven de zoekresultaten in de webapplicatie (zie onderstaande 
afbeelding). 
 

 
 

Indien de gebruiker op deze knop drukt wordt er een venster geopend. Geef bij Info 
venster eigenschappen alle eigenschappen op die aan het te openen venster meegegeven 
kunnen worden. Het is de features parameter van Javascript functie 'window.open'. 
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Voorbeeld:  
width=800, height=500, left=250, top=50, toolbar=yes, resizable=yes 

 

Deze info knop opent een nieuw venster met daarin 
NBG_CUSTOM/NBG_CUSTOM_result_info.asp. Dit is een voorbeeld ASP voor het tonen van 
metadata van een zoekresultaat en kunt u naar uw wensen aanpassen of raadpleeg 
hiervoor een consultant van NedGraphics. 
 
Voor meer informatie, zie bijlage C. 
 
Exporteren naar spreadsheet → Indien deze optie is aangevinkt, dan wordt een extra knop 
getoond boven de zoekresultaten in de webapplicatie (zie onderstaande afbeelding). 
Hiermee kunnen gegevens worden geëxporteerd naar Microsoft Excel of Open Office Calc 
(afhankelijk van systeeminstelling ‘Spreadsheet programma’ onder de groep 
‘Webapplicatie’). 
 

 
 
Indien de gebruiker op deze knop drukt wordt er een venster geopend. Geef bij Info 
venster eigenschappen alle eigenschappen op die aan het te openen venster meegegeven 
kunnen worden.  
 

 Te tonen attributen 

Per resultaatscherm kan worden bepaald welke attributen uit het object getoond dienen te 
worden. 
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De volgende opties zijn belangrijk: 
 
Attribuut → Het gewenste attribuut kan uit een lijst geselecteerd worden (drop down 
menu). 
 
Indien 2x hetzelfde attribuut in het zoekresultaat wordt opgenomen, dan wordt er een 
foutmelding getoond.  
  
Door gebruik te maken van SQL expressie is het wel mogelijk om 2x hetzelfde attribuut te 
gebruiken. Attribuut moet dan leeg gelaten worden.  
Gebruik bijvoorbeeld sum(#OPPERVLAKTE#) of avg(#OPPERVLAKTE#) als aparte 
zoekresultaat-attributen. "Sommatie" blijft dan op "Geen" staan.  
Of gebruik bijvoorbeeld #STRAATNAAM#, zodat deze gebruikt kan worden in de procedure 
aanroep. 
 
SQL expressie → In de SQL expressie mogen de attribuutnamen van het object waarop het 
zoekresultaat is gebaseerd gebruikt worden tussen #. De attribuutnamen moeten exact 
(hoofdlettergevoelig) overeenkomen.  
 
Voorbeelden:  
1. Samenvoegen straatnaam (1e letter van ieder woord is een hoofdletter), huisnummer 

en huisletter  
 

Initcap(#NAAM#) || ' ' || #HUISNUMMER# || #HUISLETTER#  

 

2. Afronden (op 2 cijfers) en formatteren van een numeriek veld zodat het rechts uitlijnt.  
 

Lpad(Round(#OPP_PERCEEL#,2),8)  

 

3. X- en y-coördinaat tonen bij bijvoorbeeld redline elementen. 
 

#GEOMETRIE#.sdo_point.x  

#GEOMETRIE#.sdo_point.y 

 
Hierbij is de coördinaat van een polygoon het zwaartepunt. 
  
Afronden op gehele getallen: 
round(#GEOMETRIE#.sdo_point.x) 

 
Afronden op 1 cijfer achter de komma: 
round(#GEOMETRIE#.sdo_point.x,1) 
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 LET OP:  
Het is niet mogelijk om een admin-geo koppeling te maken als er de volgende SQL 
expressie in het resultaatscherm staat:  
 

sum(#GRONDOPPERVLAKTE#)  
 
Reden: Als sommaties worden gebruikt, dan zijn er geen relaties mogelijk. Dat is 
logisch, want als van een aantal percelen de oppervlakte gesommeerd wordt, dan zijn 
er geen individuele percelen meer.  
 
Alleen bij niet-sommatie sql-expressies zijn relaties wel mogelijk. 

 
Naam in lijst / details → Een willekeurige naam waarmee de attribuutnaam wordt 
getoond in het resultaatscherm. 
 
Tonen in lijstoverzicht → Hiermee kan aangegeven worden dat het gegeven wordt 
getoond in het resultaatscherm onder de kaart. 
 

 
 
Tonen in detailoverzicht → Hiermee kan aangegeven worden dat het gegeven wordt 
getoond in het resultaatscherm links van de kaart. 
 

 
 

 Zoekingangen 

Nadat een resultaatscherm is vastgelegd kan een zoekingang gemaakt worden via 
Producten → Producten → Zoekingangen → Knop Voeg zoekingang toe. 
 
De volgende opties zijn belangrijk: 
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Zoekresultaat → Naam van een eerder vastgelegd resultaatscherm, deze is uit een lijst te 
selecteren (Drop down menu). 
 
Naam op scherm → Naam van de zoekingang zoals deze verschijnt in de webapplicatie. 
 

Zoekmogelijkheid tonen → Indicatie (J/N) 
of de zoekmogelijkheid getoond moet 
worden in de webapplicatie.  
Standaard Zoekmogelijkheid → Geef aan 
welke waarde initieel getoond moet 
worden voor deze zoekingang. 
 

 

Geo Afbakening tonen → Indicatie (J/N) of 
de optie geografische afbakening getoond 
moet worden in de webapplicatie. 

 
 
Standaard Geo Afbakening → Geef aan 
welke waarde initieel getoond moet 
worden voor deze zoekingang. 

 

 

 LET OP:  
Indien u de optie “Geo Afbakening tonen” aanvinkt, dan dient in het stuurmodel bij het 
object waar het zoekresultaat op is gebaseerd een geometrie attribuut aanwezig te zijn. 

 
Selecteer menu Datamodel → Objecten → Edit →tabblad Attributen. 
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Indien dit attribuut niet is gedefinieerd in het stuurmodel, zal - wanneer de gebruiker via 
de zoekingang probeert te zoeken binnen het huidige kaartbeeld - de volgende 
foutmelding getoond worden: 
 

 
 
Na het vastleggen van een zoekingang kunnen de zoekvelden vastgelegd worden.  
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De volgende opties zijn belangrijk: 

 
Attribuut → Het attribuut uit het object dat als zoekveld gaat dienen 

 

 
 
Verplicht → Geeft aan of een zoekveld verplicht moet worden ingevuld. Dit kan gewenst 

zijn zodat er niet te veel zoekresultaten worden opgehaald en getoond. 
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Type lijst → Er zijn drie mogelijkheden: 
 

1. Geen lijst → Er wordt alleen een tekstvak 
getoond. Dit type kan gewenst zijn indien 
er veel verschillende waarden 
beschikbaar zijn. 

 

  
2. Alle waarden → Alle beschikbare 

waarden worden getoond. Dit type kan 
gewenst zijn indien er niet te veel 
verschillende waarden beschikbaar zijn. 
De NedBrowser website wordt traag met 
opstarten indien er te veel verschillende 
waarden moet worden opgehaald om dit 
pulldown-menu te vullen. 

 

  
3. Lijst knop → Indien dit type wordt 

gekozen kan een deel van de waarde 
opgegeven worden. Nadat op de knop 
naast het zoekveld gedrukt wordt zullen 
alle waarden getoond worden die 
beginnen met de ingevulde waarde. Bij 
dit type is het niet mogelijk wildcards te 
gebruiken. 

 
 

 

 

 
Zoekingangen kunt u definiëren op basis van een zoekresultaat. Zorgt u er dus allereerst 

voor dat er een zoekresultaat bestaat – daarna pas kunt u zoekingangen aanmaken. Een 
zoekingang definieert u voor één of meer attributen uit het zoekresultaat.  
 

Hieronder volgen enkele tips voor het werken met zoekingangen. 

 

 

De tekst bij ‘Naam op scherm’ is 
wat de gebruiker ziet – kiest u 
hier dus een duidelijke 
aanduiding. 
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 Relaties tussen resultaatschermen en de kaart 

Het invullen en activeren van een zoekingang levert een resultaatscherm op waarin 
gegevens getoond worden. Vanuit dit resultaatscherm is het mogelijk een kaartrelatie te 
gebruiken om een object in de kaart te tonen. Dit kaartobject heeft dan een relatie met 
een administratief gegeven uit het resultaatscherm. Tevens is het mogelijk een relatie te 
definiëren tussen verschillende resultaatschermen. Hiermee wordt bereikt dat van één 
administratief gegeven uit een resultaatscherm gerelateerde administratieve gegevens 
opgevraagd worden. Om deze gerelateerde gegevens te tonen dient een nieuw 
resultaatscherm gedefinieerd te worden. 
 

 Relaties tussen een resultaatscherm en een kaartlaag 

Een relatie tussen een kaartlaag en een 
resultaatscherm is nodig om administratieve 
gegevens op te kunnen vragen van een 
object in de kaart. Hiervoor dient het 
kaartobject geselecteerd te worden (zie 
afbeelding hiernaast). Vervolgens worden er 
in een resultaatscherm onder de kaart 
administratieve gegevens getoond (zie 
onderstaande afbeelding) die gerelateerd 
zijn aan het kaartobject. 

 
 

 
 

Om een relatie tussen een kaartlaag en een resultaatscherm te definiëren dient de 
volgende werkvolgorde aangehouden te worden: 
 

Voor een database waarin alle 
informatie in hoofdletters is 
opgeslagen zet u dit vinkje uit. 

Hiermee test u hoeveel tijd nodig 
is voor het ophalen van alle 
attribuutwaarden. 
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In het NBG-stuurmodel een resultaatscherm definiëren. Het object dat als basis dient voor 
dit resultaatscherm dient een relatie te hebben met het object waarop de betreffende 
kaartlaag gebaseerd is.  
 
In het NBG-stuurmodel een objectrelatie en een relatieketen definiëren tussen het  object 
dat als basis dient voor de betreffende kaartlaag en het object dat als basis dient voor het 
resultaatscherm. Indien bron- of doelobject geen Oracle object is dan geldt dat de 
relatieketen maar één objectrelatie mag hebben. 
 
Aan de kaartlaag kunnen één of meer resultaatschermen gekoppeld worden. In het NBG-
stuurmodel kan dit op 3 verschillende manieren gedefinieerd worden: 
 
1. Via menu Producten → Producten → selecteer een product → Productmenu’s → 

productlagen → Edit →  tabblad Laagresultaten (zie onderstaande afbeelding). 
 
2. Via menu Producten → Productlagen → selecteer een productmenu → Edit →   tabblad 

Laagresultaten (zie onderstaande afbeelding). 
 

 
 

3. Via menu Producten → Producten → Geo → admin. 
 

De resultaatschermen worden als 'tabs' getoond onder het kaartvenster na een selectie 
van objecten in de kaartlaag. De Relatienaam dient als naam voor de 'tab'. Kies de 
Relatieketen en Resultaatscherm uit een lijst (drop down menu). 
 
Het is mogelijk om vanuit een resultaatscherm het bijbehorende kaartobject te tonen in de 
kaart. Dit kan door een administratief gegeven in het resultaatscherm aan te vinken en op 
de rood omcirkelde knop te klikken (zie onderstaande afbeelding). 
 

 
 
Om dit te bereiken dient een relatie gedefinieerd te worden tussen het resultaatscherm en 
de kaartlaag. In het NBG-stuurmodel kan dit via het menu Producten → Producten → 
admin -> admin /geo  
 
In het veld Relatienaam kan een willekeurige waarde ingevuld worden, deze waarde komt 
niet terug in de NBG-website. De velden Relatieketennaam en Naam kunnen worden 
gevuld met de beschikbare waarden uit een lijst (drop down menu). 
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 Relaties tussen resultaatschermen 

Een relatie tussen meerdere resultaatschermen vereist dat er een relatie bestaat tussen de 
Oracle objecten (tabellen/views) die als basis dienen voor de verschillende 
resultaatschermen. Bijvoorbeeld een relatie tussen Perceel gegevens en Zakelijk recht 
gegevens op basis van de sleutel gemeentecode-sectie-perceelnummer.  
 
Om een relatie tussen twee resultaatschermen te definiëren in het NBG-stuurmodel dient 
de volgende werkvolgorde aangehouden te worden: 
 
1. In het NBG-stuurmodel meerdere resultaatschermen definiëren. Eén van deze 

resultaatschermen dient getoond te kunnen worden in de NBG-website, na gebruik van 
een zoekingang of na het selecteren van een kaartobject. 

 
2. Een objectrelatie en een relatieketen definiëren in het NBG-stuurmodel, en wel tussen 

de objecten die als basis dienen voor de resultaatschermen uit a. 
Indien bron- of doelobject geen Oracle object is dan geldt dat de relatieketen maar één 
objectrelatie mag hebben. 

 
3. Een relatie definiëren tussen de resultaatschermen. In het NBG-stuurmodel kan dit via 

menu Producten → Producten → admin -> admin /geo. Links in het scherm staan alle 
resultaatschermen. Indien op een resultaatscherm geklikt wordt verschijnen rechts in 
het scherm alle relaties die het betreffende resultaatscherm heeft.  
Onder Administratieve relaties kan een relatie met een ander resultaatscherm ingevuld 
worden.  

 

 
 
Het veld Relatienaam is een willekeurige naam die als naam van de relatie in de 
NedBrowser website verschijnt (zie onderstaande afbeelding). 
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De velden Relatieketennaam en Resultaatscherm kunnen worden gevuld met de 
beschikbare waarden uit een lijst (Drop Down menu). 
 
Indien al deze stappen doorlopen zijn kan vanuit een resultaatscherm een ander 
resultaatscherm opgeroepen worden. Dit kan door op een gegeven uit het eerste 
resultaatscherm te klikken met de rechtermuisknop. 
 
Terug gaan naar het eerste resultaatscherm kan op twee manieren: 
 
1. Door een nieuwe relatie te definiëren. Hierbij dient voor onderstaand voorbeeld in het 

NBG-stuurmodel een relatie aan het resultaatscherm Adressen toegevoegd te worden, 
en wel een relatie naar het resultaatscherm Percelen. 

 

 
 
2. Door bovenin het resultaatscherm op de link Percelen te klikken. Hierdoor wordt deze 

link vet gedrukt en wordt terug gegaan naar de beginsituatie. 
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 AUTORISATIE 

 Inleiding 

 

 
 

 

 
 

 
 

 
 

 

 
 

 

Tot slot dienen de productgroepen toegewezen te worden aan bepaalde 
gebruikersgroepen.  
 

 
 

 

 
 
 
 
 
 
 
 
 
Figuur 8.1 Overzicht van de afhankelijkheden van de autorisatie. 
 
 

 

 
 

 
 

 Autoriseren: werken met gebruikersgroepen 

Indien met een Windows netwerk wordt gewerkt is het mogelijk om de Internet 
Information Server gebruikersnamen te laten afvangen.  
 
Hiervoor is de volgende instelling in Internet Information Services (IIS) nodig: 
Start IIS-beheer en selecteer de toepassing/webshare van NedBrowser. 
Dubbelklik op 'Verificatie'. 

Gebruiker 

Gebruikersgroep 

Productgroepen Kaartmenu’s Printtemplates 

1. Datamodel 

2. Basislagen 

3. Kaartmenu 

5. Producten 

6. Autorisatie 

Referenties 

Systeem 

Help 

Statistiek 

4. Printen 
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Hier is het van belang dat Windows-verificatie ingeschakeld (enabled) is en dat Anonieme-
verificatie uitgeschakeld (disabled) is (zie onderstaande afbeelding). 
 

 
 
Via Systeem → Instellingen → groep Beheeromgeving dient aangegeven te worden dat de 
Windows authenticatie gebruikt wordt (zie onderstaande afbeelding).  
 

 
 
Nadat deze instelling is gedaan worden door NedBrowser alle Windows gebruikersnamen 
afgevangen.  
 
Een Windows gebruikersnaam kan worden ingevoerd in het stuurmodel: Autorisatie → 
Gebruikers, maar eerst dient een gebruikersgroep gedefinieerd te worden via: Autorisatie 
→ Gebruikersgroepen (zie onderstaande afbeelding). 
 

 
 
Per gebruikersgroep kunnen instellingen worden gedaan wat betreft: 

• Beschikbare kaartmenu’s boven en onder de kaart; 

• X- en y-coördinaten van de initiële overzichtskaart en detailkaart; 

• Beschikbare printtemplates; 

• Welke productgroepen zijn geautoriseerd (via knop Productgroepen) 
 
Verder zijn de volgende opties belangrijk: 
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Default product → De default actieve laag en default actieve zoekingang die voor de 
gebruikersgroep wordt getoond is de default actieve laag en default actieve zoekingang 
van het default product van de gebruikersgroep. Indien dit veld niet ingevuld is, dan is het 
eerste product in de lijst het actieve product. 
 
Standaard doorprikselectie → Geeft aan welke manier van doorprikken standaard aan 
staat bij het selecteren van objecten.  
 
1. Zichtbare → Bij het doorprikken worden alleen de onderliggende zichtbare en 

activeerbare lagen getoond. 
2. Alles → Niet alleen de actieve laag wordt getoond in een keuzescherm, maar ook de 

daaronder liggende activeerbare lagen.  
3. Actieve → Objecten worden op normale wijze geselecteerd (d.w.z. alleen objecten uit 

de actieve laag). 

 
Deze optie kan nog 'overruled' worden, door: 
 
1. Het opnemen van keuzelijst DRILL_DOWN_ON_OFF in het onderste kaartmenu. De 

gebruiker kan vervolgens kiezen welke vorm van doorprikken gewenst is. 
 

 
 
2. Het opnemen van extra kaartknoppen in het bovenste kaartmenu via Kaartmenu → 

Kaartmenu’s:  
 

       
 

• RECTANGLE_DRILL_DOWN (doorprikken van op elkaar liggende objecten in 
rechthoek) 

• CIRCLE_DRILL_DOWN (doorprikken van op elkaar liggende objecten in cirkel) 

• POLYGON_DRILL_DOWN (doorprikken van op elkaar liggende objecten in 
polygoon) 

• BUFFER_DRILL_DOWN (doorprikken van op elkaar liggende objecten in de buffer) 
 
Actieve laag keuze tonen → Geeft aan of de gebruiker een actieve laag moet kunnen 
kiezen. Indien deze optie niet is aangevinkt, dan wordt in de browser de keuzelijst voor actieve 

laag niet getoond en heeft het klikken op een laag geen effect.  

 
Actieve laag keuze tonen → Geeft aan of de gebruiker een actieve laag moet kunnen 
kiezen.  
Indien voor de gebruikersgroep deze optie niet is aangevinkt, dan wordt in de legenda in 
de browser de keuzelijst voor actieve laag niet getoond en heeft het klikken op een laag 
geen effect. 
  
Optie "alle lagen tonen" weergeven in legenda → Geeft aan of de optie "Toon alles" 
wordt weergegeven in de legenda. Hiermee kunnen de lagen waarvan de optie "Initieel 
zichtbaar in legenda" in uitgevinkt getoond worden in de legenda. 
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Indien voor de gebruikersgroep deze optie niet is aangevinkt, dan wordt in de browser de 
optie "Toon alles" niet getoond. 
  
Productselectielijst tonen in legenda en zoeken → Hiermee wordt aangegeven of de 
productselectielijst wordt weergegven in de legenda en bij de zoekingangen. 
  

 
 

 Gebruikers 

Een Windows gebruikersnaam kan worden ingevoerd in het stuurmodel: Autorisatie → 
Gebruikers (zie onderstaande afbeelding). 
  

 
 
De Loginnaam is de Windows gebruikersnaam van een gebruiker, de Volledige naam kan 
een willekeurige waarde hebben en de Groep is een gebruikersgroep waaraan rechten 
worden gegeven. Deze groep kan gekozen worden (drop down menu) uit een lijst met 
beschikbare gebruikersgroepen.  
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Een gebruiker kan meerdere gebruikersgroepen toegewezen krijgen door in het tabblad 
Gebruikersgroepen een vinkje te zetten bij de gebruikersgroep en dan op Opslaan te 
drukken. 
Indien meerdere gebruikersgroepen zijn toegewezen aan een gebruiker dan wordt voor die 
gebruiker in de NedBrowser webapplicatie rechts boven naast de Menu-knop een 
dropdown-keuzelijst getoond  met de toegewezen gebruikersgroepen. De gebruiker kan zo 
wisselen naar een andere gebruikersgroep. NedBrowser wordt dan ververst (kaartmenu, 
lagen, etc.). De kaartpositie en schaal wordt wel behouden. 
 

 
 
Een gebruiker kan geautoriseerd worden voor het bevragen van persoonsgegevens in het 
tabblad AVG autorisatie (huidig).  
Voor het bevragen van persoonsgegevens is het volgens de AVG (Algemene Verordening 
Gegevensbescherming) noodzakelijk om naast protocollering (autorisatie, logging) vast te 
leggen wat de reden van bevraging van persoonsgegevens is geweest. Een reden van 
bevraging wordt vastgelegd via Referenties → AVG redenen van bevraging 
persoonsgegevens. Een reden van bevraging kan vervolgens voor een bepaalde periode 
worden toegekend aan een gebruiker via het tabblad AVG autorisatie (huidig). Indien een 
gebruiker geen AVG-autorisatie heeft dan ziet hij geen zoekingangen en zoekresultaten van 
StUF-connectie-objecten met entiteittype NPS of NNP. 
In tabblad AVG autorisatie (historie) kan opgevraagd worden of en welke AVG autorisatie 
er was in het verleden. 
 

 Standaard gebruiker 

De gewenste gebruikersgroepen en de gewenste gebruikers dienen dus te worden 
gedefinieerd en gekoppeld. Indien een gebruiker niet is gedefinieerd in het stuurmodel en 
toch NedBrowser opstart, is het mogelijk deze gebruiker toch middels autorisatie rechten 
te geven op bepaalde onderdelen in NedBrowser. 
Via Systeem → Instellingen → groep Authenticatie kan een naam worden gegeven aan alle 
niet-gedefinieerde gebruikers (zie onderstaande afbeelding).  
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Deze gebruiker dient wel eerst gedefinieerd te worden onder Autorisatie → Gebruikers. 
Vervolgens kan deze gebruiker worden toegekend aan een gebruikersgroep. 
 

 Authenticatie methoden 

In bovengenoemd voorbeeld wordt uitgegaan van Windows authenticatie. In totaal zijn er 
4 authenticatie methoden beschikbaar: 
 
1. Windows 

Gebruik standaard Windows Authenticatie, zoals is ingesteld voor de website in 
Internet Information Services. Dit is verreweg de meest geprefereerde methode.  

 
2. Registry 

De loginnaam van de eindgebruiker wordt uit het register van de PC gehaald. Deze 
methode is alleen bruikbaar in Internet Explorer via ActiveX met beperkte beveiliging 
en daarom geniet deze methode niet de voorkeur. 

 
3. Single Sign On (LDAP) 

Authenticatie via de LDAP server op basis van ip-nummer. Omdat alleen op basis van 
ip-nummer een gebruiker kan worden geïdentificeerd is deze methode zeer beperkt 
bruikbaar.  

 
4. Environment 

De loginnaam van de eindgebruiker wordt uit een omgevingsvariabele gelezen. Deze 
methode is alleen bruikbaar in Internet Explorer via ActiveX met beperkte beveiliging 
en daarom geniet deze methode niet de voorkeur. 

 

 LET OP:  
Niet alle webbrowsers ondersteunen deze authenticatie methoden. Voor meer 
informatie, zie bijlage H. 

 

 De-autorisatie 

Het kan zijn dat sommige gebruikersgroepen bepaalde zoekresultaten of bepaalde 
attributen van zoekresultaten niet mogen zien. 
In dat geval kan gebruik gemaakt worden van de-autorisatie (Autorisatie → 
Gebruikersgroepen → Object Deautorisatie). Objecten en attributen kunnen gede-
autoriseerd worden. Op deze manier kan de presentatie van een product (zoekresultaten 
en relaties) beïnvloed worden voor verschillende gebruikersgroepen. 
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 Refresh 

Per gebruiker kan worden ingesteld of de refresh waarden moeten worden opgeslagen.  
 

 
 
Indien optie Refresh is aangevinkt dan wordt voor de betreffende gebruiker het laatste 
kaartbeeld onthouden en zal na een refresh (F5) in de webapplicatie worden teruggegaan 
naar dit laatste kaartbeeld (kaartcentrum, schaal, welke lagen aan/uitstaan, actieve laag en 
actieve zoekingang). De eventuele selectie en buffer is verdwenen. 
 
Indien optie refresh is uitgevinkt en de gebruiker heeft een standaard favoriet 
aangemaakt, dan zal na een refresh (F5) in de webapplicatie het kaartbeeld van de favoriet 
worden gebruikt (kaartcentrum, schaal, welke lagen aan/uitstaan, actieve laag, actieve 
zoekingang). De eventuele selectie en buffer is verdwenen. Indien er geen standaard 
favoriet is dan start het kaartbeeld in beginpositie, dat ingesteld is bij de gebruikersgroep. 
  

 LET OP:  
Indien een onbekende gebruiker NedBrowser opstart (d.w.z. de gebruiker is niet 
gedefinieerd in het stuurmodel), dan worden aan deze onbekende gebruiker de 
rechten toegekend van de standaard gebruiker. Zie Systeeminstellingen → groep 
Beheeromgeving → Standaard gebruiker loginnaam. 
Voor de standaard gebruiker zal de refresh informatie NIET worden opgeslagen 
(ongeacht of de optie Refresh is aangevinkt), om te voorkomen dat de standaard 
gebruiker een kaartbeeld te zien krijgt van een andere gebruiker die onder de 
standaard gebruiker valt. 

 

 Favorieten 

Een gebruiker kan het huidige kaartbeeld (kaartcentrum, schaal, welke lagen aan/uitstaan, 
actieve laag, actieve zoekingang) opslaan in een lijst met favorieten. De autorisatie voor 
het beheer van favorieten vindt plaats op twee niveaus:  
1. Gebruikersgroep  
2. Gebruiker  
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Als bij de gebruiker niets wordt ingesteld worden de instellingen van de groep gevolgd. Per 
gebruiker kan daar vervolgens van worden afgeweken. De gebruikersinstelling gaat voor de 
groepsinstelling. 
 
Er zijn drie soorten favorieten:  
 
1. Individueel 

Alleen zichtbaar voor de gebruiker die ze heeft aangemaakt.  
 
2. Groep  

Zichtbaar voor iedereen binnen dezelfde gebruikersgroep (die tevens lees-autorisatie 
heeft op groep-favorieten).  

 
3. Publiek  

Zichtbaar voor alle gebruikers (die tevens lees-autorisatie hebben op publieke 
favorieten). 

 

 Gebruikersgroepen 

In stuurmodel menu Autorisatie → Gebruikersgroepen → Edit wordt aangegeven welke 
soort favorieten de gebruikers uit de groep mogen lezen, toevoegen en verwijderen.  
 

 
 
Tevens zijn alle favorieten te zien (Autorisatie → Favorieten)  die aangemaakt zijn door de 
gebruikers. Deze kunnen verwijderd worden door een selectie te maken en op de knop 
verwijder selectie te drukken: 
 

 
 

 
 

 Gebruikers 

In stuurmodel menu Autorisatie → Gebruikers → Edit wordt aangegeven welke soort 
favorieten de gebruikers mogen lezen, toevoegen en verwijderen.  
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Volgt groepsinstelling → Geeft aan of de gebruiker de groepsinstellingen gebruikt of dat 
deze zijn eigen instellingen heeft. Door dit gegeven aan te vinken worden 
gebruikerinstellingen verwijderd en de groepsinstellingen hersteld. 
 
Ook hier zijn alle favorieten te zien die aangemaakt zijn door de gebruikers. Deze kunnen 
verwijderd worden. 
 
Door op de kolomknop Groep te klikken kan er gesorteerd worden op groep. Hierdoor 
staan alle gebruikers van dezelfde groep bij elkaar. 
 

 Overzicht actieve gebruikers 

Dit scherm toont de emailadressen van gebruikers die binnen het opgegeven aantal uren 
actief zijn geweest en waarvan de activiteit is gelogd in functie- en/of objectstatistiek. 
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 REFERENTIES 

 Inleiding 

 

 
 

 

 
  

 
 

 
  

 

 
 

 
 

 

 

In stuurmodel menu Referenties worden optielijsten vastgelegd. Deze optielijsten worden 
in verschillende andere stuurmodel menu’s gebruikt.  

 
Naast optielijsten, worden tevens themapaletten, vlak- en lijnpatronen vastgelegd. Deze 
dienen als basis voor de thematische presentaties. 
 
 

 
 

 

 
 

 
 

 
 

 

 
 

 

 Themapaletten 

Voor het aanmaken van een thematische presentatie is er een themapalet nodig. Een 
themapalet is een verzameling kleuren. Door aan een thema een themapalet te koppelen 
worden de kleuren van de legenda-items ingesteld. Voor meer informatie wordt verwezen 
naar § 3.5: Themapaletten beheren. 
 

1. Datamodel 

2. Basislagen 

3. Kaartmenu 

5. Producten 

6. Autorisatie 

Referenties 

Systeem 

Help 

Statistiek 

4. Printen 
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 Optielijsten 

In het stuurmodel zijn standaard een aantal optielijsten opgenomen. Een optielijst is een 
lijst met waarden die bijvoorbeeld gebruikt worden voor kaartmenu functies (keuzelijsten), 
printparameters en systeeminstellingen. 
 

Een voorbeeld van een optielijst is de keuzelijst met beschikbare schalen onder de 
detailkaart (SCALE). Aan deze optielijst kunnen nieuwe schalen worden toegevoegd. 

 
Voorbeelden van andere optielijsten die kunnen worden uitgebreid zijn: 

• HTML_COLOR  

• SCALE  

• FONT 

• Etc. 
 

 Vlakpatronen 

Vlakpatronen kunnen gebruikt worden in een vlakstijl bij het aanmaken van thema's voor 
normale lagen en bij het aanmaken van vlakfuncties voor redlinelagen. 
 
In het stuurmodel zijn standaard een aantal vlakpatronen aanwezig, deze kunnen 
uitgebreid worden. 
 

 Lijnpatronen 

Lijnpatronen kunnen gebruikt worden in een lijnstijl bij het aanmaken van thema's voor 
normale lagen en bij het aanmaken van lijnfuncties voor redlinelagen.  
 
In het stuurmodel zijn standaard een aantal lijnpatronen aanwezig, deze kunnen uitgebreid 
worden. Voor meer informatie wordt verwezen naar bijlage E. 

 

 Font symbolen 

Fontsymbolen kunnen gebruikt worden in een puntstijl bij het aanmaken van thema’s voor 
normale lagen en bij het aanmaken voor puntfuncties voor redlinelagen. 

 

 Statistiek functies 

Naast de meegeleverde statistiek functies kunnen er ook nieuwe statistiek functies worden 
aangemaakt. De naam van zo'n nieuwe statistiek functie wordt gebruikt in een parameter 
van de procedure aanroep NBG_MAP_open_url van een kaartmenu-knop. 
 

 AVG: redenen van bevraging persoonsgegevens 

Voor het bevragen van persoonsgegevens is het volgens de AVG (Algemene Verordening 
Gegevensbescherming) noodzakelijk om naast protocollering (autorisatie, logging) vast te 
leggen wat de reden van bevraging van persoonsgegevens is geweest. Voor een reden van 
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bevraging zijn een zestal grondslagen die nader gepreciseerd kunnen worden en gelden 
voor een bepaalde periode. Een reden van bevraging kan vervolgens voor een bepaalde 
periode worden toegekend aan een gebruiker in het Gebruikersscherm via tabblad AVG 
autorisatie (huidig). Indien een gebruiker geen AVG-autorisatie heeft dan ziet hij geen 
zoekingangen en zoekresultaten van StUF-connectie-objecten met entiteittype NPS of NNP. 
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 SYSTEEM 

 Inleiding 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
In het stuurmodel menu Systeem zijn de systeeminstellingen ondergebracht.  
 
Tevens is er de mogelijkheid om de inhoud van het stuurmodel te exporteren/importeren. 
 
 
 
 
 
 
 
 
 

 

 Systeeminstellingen 

Voor een overzicht en uitleg van alle systeeminstellingen, zie de online help. 
 

 Exporteren 

Gebruik deze functie om de inhoud van het stuurmodel te exporteren. Het verkregen 
bestand kan als back-up worden bewaard of kan gebruikt worden om een ander NBG 
stuurmodel te vullen m.b.v. de import functie. 
 

1. Datamodel 

2. Basislagen 

3. Kaartmenu 

5. Producten 

6. Autorisatie 

Referenties 

Systeem 

Help 

Statistiek 

4. Printen 
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 Importeren 

Gebruik deze functie om het stuurmodel te vullen met data uit een eerder aangemaakt 
exportbestand.  
 
Het importeren gaat in 3 stappen. 
1. Selecteren en laden van een exportbestand. 

2. Koppelen van connecties en producten. 

3. Verwerken van exportbestand. 

 
Stap 1: Selecteren en laden van een exportbestand. 
  
Selecteer een exportbestand een laad de gegevens in. 
Als de gegevens geladen zijn worden de opties die bij het aanmaken van de export waren 
gekozen in het scherm weergegeven. Deze opties kunnen niet worden aangepast.  
  
Stap 2: Koppelen van connecties en producten. 
  
1. Bij het importeren van connecties en producten zijn er 2 mogelijkheden.  

Er wordt een nieuwe connectie / product aangemaakt en alle gegevens worden onder 
deze nieuwe connectie / product geplaatst. 

2. De connectie / product wordt gekoppeld aan een reeds in het stuurmodel aanwezig 
connectie / product en de gegevens worden onder deze reeds aanwezige connectie / 
product geplaatst. 

 
Als het exportbestand is geladen dan worden de daarin aanwezige connecties en 
producten getoond in het scherm. Vervolgens moet worden aangegeven waaronder de 
gegevens moeten worden geplaatst.  
  
Stap 3: Verwerken van exportbestand. 
  
De gegevens uit het exportbestand worden toegevoegd aan het stuurmodel. 
 
De volgende velden zijn belangrijk: 
 
Bestand → Geef hier de naam en locatie op van het importbestand. 
Start het standaard bestandsdialoogvenster met behulp van de knop naast het 
bestandsnaam veld. 
 
Knop: Laden → Haal de gegevens van het importbestand over naar de database. 
 
Knop: Verwerk → Verwerk de gegevens van het importbestand. 
 
Logging → Keuze voor het soort informatie dat in de logging wordt opgenomen: 
  
1- Fouten 
2- Fouten en totalen 
3- Fouten, totalen en overige informatie. 
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Knop: Stuurmodel legen → Met deze knop worden alle gegevens uit het stuurmodel 
verwijderd. 
  
Knop: Reset refresh gegevens van gebruikers → Met deze knop worden de refresh 
gegevens van alle gebruikers verwijderd. 
Dat wil zeggen dat de laatste kaartstand en laaginstellingen wordt gereset en bij de 
volgende start van NedBrowser de beginstand wordt genomen zoals in het stuurmodel is 
vastgelegd. 
Dit kan soms nodig zijn na een import waarbij bestaande producten opnieuw zijn 
ingelezen. De verwijzingen naar de oorspronkelijke productlagen zijn dan verdwenen en 
die productlagen worden dan ook niet meer getoond. Dat geldt overigens ook voor de 
favorieten die in dat geval opnieuw aangemaakt moeten worden, althans de 
laaginstellingen moeten opnieuw goed worden gezet via de legenda. 
 

 Export/Import Log 

Iedere export/import maakt loginformatie aan. Deze informatie is met behulp van dit 
scherm in te zien. Het scherm bevat een overzicht van alle keuzes die bij de export/import 
zijn gemaakt en geeft de logregels weer.  
De logregels zijn in dit scherm te bekijken maar zijn ook als tekstbestand op te vragen. 
Wanneer er een fout is opgetreden in de export/import dan wordt de regel rood 
weergegeven: 

 

 
 

 Importeren gebruikers 

Gebruikersnamen kunnen worden ingelezen vanuit een CSV bestand. Het bestand dient 2 
kolommen te bevatten: een loginnaam en een volledige naam.  
Eventueel reeds voorkomende gebruikers worden overgeslagen. 
 
 

  



10. Systeem 
 

Versie 1.0 110 NedBrowser Configuratiehandleiding 

  



11. Statistiek 
 

NedBrowser Configuratiehandleiding 111 Versie 1.0 

 STATISTIEK 

 Inleiding 

 
  
 
 
 

 
 
 
 
 

 
 
 
 
 
 
In de statistieken wordt weergegeven hoe vaak en wanneer een bepaalde functie of object 
weergegeven. Dit kan per totaal, gebruikersgroep of gebruiker worden getoond. 
 

 Statistiek 

U kunt per gebruiker, gebruikersgroep en over het geheel opvragen hoe vaak een bepaalde 
functie is gebruikt.  
 
De volgende functies zijn standaard beschikbaar: 
1. Opstarten NedBrowser; 
2. Opstarten Globespotter; 
3. Opstarten StreetSmart; 
4. Opstarten Cyclorama (oude viewer); 
5. Opstarten Maxiviewer; 
6. Opstarten FIS; 
7. Opstarten Orbit; 
8. Aerorama's CycloMedia; 
9. Oblieke foto’s CycloMedia; 
10. Oblieke foto’s Slagboom en Peeters; 
11. RO-online; 
12. Risicokaart; 
13. Zoek locatie; 
14. Afdrukken op printer via print template; 
15. Welke lagen zijn gebruikt; 
16. Welke object via het zoekresultaat is opgevraagd en hoeveel records dat heeft 

opgeleverd. 
 
De volgende menu-items zijn beschikbaar: 

1. Datamodel 

2. Basislagen 

3. Kaartmenu 

5. Producten 

6. Autorisatie 

Referenties 

Systeem 

Help 

Statistiek 

4. Printen 
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Totaal per functie 
Op dit tabblad wordt voor iedere functie het totale gebruik per maand getoond. 
 
Totaal per object 
Op deze pagina wordt voor ieder object het totale gebruik per maand getoond. De 
statistieken worden alleen bijgehouden voor administratieve zoekresultaten en niet voor 
het raadplegen van de lagen. 
 
Totaal per laag 
Op deze pagina wordt voor iedere laag het totale gebruik per maand getoond. 
 
Gebruikersgroep-Functie statistiek 
Op deze pagina wordt het functiegebruik per gebruikersgroep weergegeven. Gekozen 
wordt de gebruikersgroep en de functie waarvan het gebruik moet worden weergegeven. 
 
Gebruikersgroep-Object statistiek 
Op deze pagina wordt het objectgebruik per gebruikersgroep weergegeven. Gekozen 
wordt de gebruikersgroep en het object waarvan het gebruik moet worden weergegeven. 
De statistieken worden alleen bijgehouden voor administratieve zoekresultaten en niet 
voor het raadplegen van de lagen. 
 
Gebruikersgroep-Laag statistiek 
Op deze pagina wordt het laaggebruik per gebruikersgroep weergegeven. Gekozen wordt 
de gebruikersgroep en de laag waarvan het gebruik moet worden weergegeven. 
 
Gebruiker-Functie statistiek 
Op deze pagina wordt het functiegebruik per gebruiker weergegeven. Gekozen wordt de 
gebruiker en de functie waarvoor de statistiek moet worden getoond. 
 
Gebruiker-Object statistiek 
Op deze pagina wordt het objectgebruik per gebruiker weergegeven. Gekozen wordt de 
gebruiker en het object waarvoor de statistiek moet worden getoond. De statistieken 
worden alleen bijgehouden voor administratieve zoekresultaten en niet voor het 
raadplegen van de lagen. 

 
Gebruiker-Laag statistiek 
Op deze pagina wordt het laaggebruik per gebruiker weergegeven. Gekozen wordt de 
gebruiker en de laag waarvoor de statistiek moet worden getoond. 
 
Verwijderen statistiek 
Verwijder statistieken tot en met de opgegeven jaar en maand. 
 
Download statistieken 
Hiermee kunnen de verzamelde statistieken worden geëxporteerd. 
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 BIJLAGE A: SELECT-RECHTEN SCRIPT 

De Oracle-gebruiker NBG heeft select-rechten nodig op alle Oracle tabellen/views die 
benaderd worden vanuit NedBrowser. Dit kan op twee manieren: 
 

• In het schema van de Oracle-gebruiker waarin de betreffende Oracle tabel/view zich 
bevindt het statement grant select on <tabel-/view-naam> to nbg; 

• Onderstaand script gebruiken. Dit script dient vanuit de Oracle-gebruiker uitgevoerd te 
worden waarin de ontsloten tabellen/views zich bevinden. Dit script zorgt er voor dat 
de NBG-gebruiker op alle tabellen/views select-rechten heeft. 

 
 
REM **************************************************************** 

REM  * Copyright NedGraphics B.V., Utrecht, Netherlands 

REM  * SYSTEM    : NEDBROWSER 

REM  * PROGRAM   : Grant select on all tables/views to an Oracle user  

REM  * FILE      : nbg_grant_select.sql 

REM  * 

REM  * PURPOSE   : Give select-grants on all tables/user owned by the 

REM  *             Oracle user that executes the script 

REM  *             to another Oracle user. 

REM  * 

REM  * PARAMETERS : 1. Oracle user 

REM  * 

REM  * CREATION   : 01-07-2004 

REM  * AUTHOR     : Ron Lindhoudt 

REM  * 

REM  **************************************************************** 

 

Accept ORACLE_USER prompt 'Oracle user die de select-grants krijgt op alle 

tabellen/views: ' 

 

SET VERIFY OFF 

 

SET SERVEROUTPUT ON SIZE 100000 

 

DECLARE 

    CURSOR c_tab IS 

        SELECT table_name 

          FROM user_tables 

         UNION  

        SELECT view_name table_name 

          FROM user_views; 

BEGIN 

    FOR r_tab IN c_tab LOOP 

 

        BEGIN 

            EXECUTE IMMEDIATE 'grant select on "'||r_tab.table_name||'" to 

&&ORACLE_USER'; 

        EXCEPTION 

            WHEN OTHERS THEN  

                DBMS_OUTPUT.PUT_LINE('Fout voor: ' || r_tab.table_name); 

                DBMS_OUTPUT.PUT_LINE(SQLERRM); 

        END; 

    END LOOP; 

END; 
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 BIJLAGE B: ORACLE OBJECTEN T.B.V. THEMATISCH 
PRESENTEREN 

Indien er een nieuw Oracle object gedefinieerd moet worden om een thematische 
presentatie te maken kan er gekozen worden uit de volgende soorten Oracle objecten: 

 

 Tabel 

Verklaring:  
Een tabel is een object in een relationele database waarin gegevens zijn opgeslagen. Deze 
gegevens zijn zowel de eigenlijke te ontsluiten gegevens als gegevens m.b.t. gebruikers en 
rechten die betrekking hebben op de tabel. 
 
Werkwijze voor administratieve tabel: 

• Tabel definiëren 

• Grant select uitdelen op tabel 
 
Werkwijze voor spatial tabel: 

• Tabel definiëren 

• Oracle Spatial metadata bijwerken 

• Spatial index maken op het geometrie-veld 

• Nieuwe tabel gebruiken als basis voor bijbehorende kaartlaag in het NBG-stuurmodel. 

• Grant select uitdelen op tabel 
 

 View 

Verklaring: 
Een view is een object in een relationele database waarin gegevens zijn opgeslagen. De 
eigenlijke te ontsluiten gegevens bevinden zich niet in een view maar in de onderliggende 
tabel(len) waar de view naar verwijst. Bij iedere bevraging van de view worden de 
onderliggende tabellen ook bevraagd. 
Gegevens die wel in een view zijn opgeslagen zijn o.a. de definitie van de view, naar welke 
tabellen verwezen wordt en gegevens m.b.t. gebruikers en rechten die betrekking hebben 
op de tabel. 
 
Werkwijze voor view op spatial tabellen: 

• View definiëren 

• Oracle Spatial metadata bijwerken 

• Nieuwe view gebruiken als basis voor bijbehorende kaartlaag in het NBG-stuurmodel. 

• Grant select uitdelen op view 
 
Opmerkingen: 
Bij gebruik van een view is het belangrijk dat er geen Full Table Scan plaatsvindt als de view 
de onderliggende tabellen bevraagt. Een Full Table Scan houdt in dat er niet gezocht wordt 
met behulp van een indexveld. Er mag bijvoorbeeld geen Full Table Scan plaatsvinden als 
het volgende statement uitgevoerd wordt: 
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select * from <naam object> where mi_prinx=1; 
 
In bovenstaand geval dient er een index aanwezig te zijn op het veld MI_PRINX. 
 
Om er achter te komen of er een Full Table Scan gaat plaatsvinden, kan een Explain Plan 
gedaan worden voordat de view gaat gebruiken. Een Explain Plan toont hoe een bepaald 
SQL-statement zoekt binnen een tabel/view. Een Explain Plan kan opgevraagd worden in 
bijvoorbeeld Toad of PL/SQL Developper. 
 
Let erop dat het select count(*)-statement pas gedaan wordt nadat bekend is dat er geen 
Full Table Scan gedaan wordt. Anders kan het lang duren voordat er resultaat wordt 
gegeven. 
 

 Materialized view 

Verklaring: 
Een materialized view is een object in een relationele database waarin gegevens zijn 
opgeslagen. De eigenlijke te ontsluiten gegevens bevinden zich niet in een materialized 
view maar in de onderliggende tabellen waar de materialized view naar verwijst. Echter in 
tegenstelling tot een view worden niet bij iedere bevraging van een materialized view de 
onderliggende tabellen benaderd. Dit wordt veroorzaakt doordat een materialized view 
het resultaat van een query op de onderliggende tabellen blijft onthouden. Door deze 
query periodiek uit te voeren blijven de gegevens die een materialized onthoudt recent.  
Een materialized view kan gezien worden als een kruising tussen een tabel en een view. 
 
Werkwijze: 

• Materialized view definiëren  

• Oracle Spatial metadata bijwerken 

• Primary key zetten op ID-veld 

• Spatial index maken op het geometrie-veld 

• Nieuwe materialized view gebruiken als basis voor bijbehorende kaartlaag in het NBG-
stuurmodel. 

 
Opmerkingen: 
Om de gegevens in een materialized view te verversen kan de volgende werkvolgorde 
aangehouden worden: 

• Spatial index verwijderen 

• Materialized views verversen (zie handleiding Gebruik materialized views) 

• Spatial index opnieuw aanmaken. 
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 BIJLAGE C: INFO/METADATA KNOP TONEN IN LEGENDA EN 
ZOEKRESULTAAT 

 Inleiding 

Het is mogelijk om in het lagenmenu een info (metadata) knop achter de 
productgroepnaam/productnaam/menunaam/laagnaam te tonen waarmee de gebruiker 
informatie kan opvragen over desbetreffende productgroep/product/menu/laag (zie 
onderstaande afbeelding). 
 

 
 
Het is ook mogelijk om in het resultaatscherm een info (metadata) knop boven de 
zoekresultaten te tonen waarmee de gebruiker informatie kan opvragen over het 
desbetreffende zoekresultaat (zie onderstaande afbeelding). 
 

 
 
Hoe u dit kunt bewerkstelligen wordt in de onderstaande paragrafen beschreven. 
 

 Info/metadata knop tonen bij productgroep/product/menu  

Deze mogelijkheid kunt u in het stuurmodel als volgt instellen: 
 

Productgroepen: 
Via menu Producten → Productgroepen → selecteer een productgroep → Edit 
 
Producten: 
Via menu Producten → Producten → selecteer een product → Edit 
 
Productmenu’s: 
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Via menu Producten → Producten → Productmenu’s → selecteer een menu → Edit 
 
Vink vervolgens de optie Info/metadata tonen aan: 
 

 
 
Indien de gebruiker in NedBrowser op de  knop achter productgroep/product/menu 
drukt, wordt er een venster geopend. De eigenschappen van dit venster (positie, grootte, 
etc.) kunt u opgeven bij Info venster eigenschappen. Dit zijn alle eigenschappen die aan het 
te openen venster meegegeven kunnen worden. Het is de features parameter van 
Javascript functie 'window.open'.  
 
Voor de specificaties van de ‘window.open’ methode, zie www.msdn.com → zoek op 
‘window.open’’. 
  
Voorbeeld:  
width=800, height=500, left=250, top=50, toolbar=yes, resizable=yes 

 

Het veld Info venster eigenschappen mag ook leeg gelaten worden. In dat geval wordt de 
syteeminstelling Info venster eigenschappen onder de groep Webapplicatie gebruikt. 
 
Na deze instellingen gedaan te hebben in het stuurmodel, zult u nu moeten bepalen welke 
metadata getoond wordt in het venster. 
 
Dit kan op 2 manieren gerealiseerd worden: 
1. Info tonen uit XML bestand. 
2. Info tonen uit een tabel in de database. 
 

 Info tonen uit XML bestand  

In map <pad>\NBG_Share\NBG_CUSTOM staan voor productgroep/product/menu 3 
voorbeeld bestanden: 
 
Productgroepen: 
1. NBG_CUSTOM_productgroup_info.xml 
2. NBG_CUSTOM_productgroup_info.xsl 
3. NBG_CUSTOM_productgroup_info.asp 
 
Producten: 
1. NBG_CUSTOM_product_info.xml 
2. NBG_CUSTOM_product_info.xsl 
3. NBG_CUSTOM_product_info.asp 

http://www.msdn.com/


14. Bijlage C: Info/Metadata knop tonen in legenda en zoekresultaat 

Versie 1.0 118 NedBrowser Configuratiehandleiding 

 
Productmenu’s: 
1. NBG_CUSTOM_menu_info.xml 
2. NBG_CUSTOM_menu_info.xsl 
3. NBG_CUSTOM_menu_info.asp 
 
1. NBG_CUSTOM_<…>_info.xml 
Dit bestand bevat XML met de metadata. De XML-structuur ziet er als volgt uit: 
 
<objects> 

   <object name="Object naam" display_name="Object naam om te tonen" 

   html_url=""> 

       

<attribute display_name="Attribuut1 naam om te tonen" 

display_type='Text'>hier komt de waarde van het attribuut</attribute> 

       

<attribute display_name="Attribuut2 naam om te tonen" 

display_type='Image'>http://nedbrowser.nedgraphics.nl//NBG_CUSTOM/NBG_

CUSTOM_logo.gif</attribute> 

       

<attribute display_name="Attribuut3 naam om te tonen" 

display_type='Hyperlink' hyperlink_text='Hyperlink 

tekst'>http://nedbrowser.nedgraphics.nl/NBG_CUSTOM/NBG_CUSTOM_logo.gif

</attribute> 

 

   </object> 

</objects> 

 
U dient dit bestand handmatig aan te passen. Vul waarden in voor tag <object>: 

• name  

• display name 

• html_url (optioneel). Indien ingevuld, dan wordt deze URL direct geopend in het info 
venster (de waarden voor de <attribute> tags worden genegeerd) 

 
Vul waarden in voor tag <attribute>: 

• display_name 

• display_type 

- Text  → (niet verplicht) voor het tonen van tekst 

- Image → voor het tonen van een afbeelding 

- Hyperlink → voor het tonen van een URL, met extra instelling: 

- hyperlink_text → (niet verplicht) tekst die als ‘link’ getoond wordt. Indien niet 
ingevuld, dan wordt standaard het volgende getoond: 
Klik hier voor <inhoud van display_name> 

• waarde van het attribuut 
 
Om meerdere objecten te definiëren kopieert u de regels <object name….. tot en met 
</object> 
 

 LET OP:  
Voor sommige tekens moeten de volgende speciale karakters in de tekst gebruikt 
worden: 

 

Karakter Vervangen 
door 

< &lt;  



14. Bijlage C: Info/Metadata knop tonen in legenda en zoekresultaat 

NedBrowser Configuratiehandleiding 119 Versie 1.0 

> &gt;  

& &amp;  

 
 
2. NBG_CUSTOM_<…>_info.xsl 
Zorgt voor de XML naar HTML conversie van de XML structuur in 
NBG_CUSTOM_<…>_info.xml. 
 
3. NBG_CUSTOM_<…>_info.asp 
Dit is een voorbeeld ASP voor het tonen van metadata van een 
productgroep/product/menu. U kunt deze ASP naar eigen wensen aanpassen (ASP kennis 
is een vereiste) of raadpleeg hiervoor een consultant van NedGraphics. 
Het asp-bestand heeft de volgende Request parameters (de waarden van deze parameters 
kunnen gebruikt worden in de ASP): 
1. NAAM_PRESENTATIE: Laagnaam in kaartmotor. 
 
In het asp-bestand worden de volgende stappen uitgevoerd (zie methode 1): 
1. Laden van bestand NBG_CUSTOM/NBG_CUSTOM_<…>_info.xml; 
2. Toevoegen van XML-attribuut “search_name” aan XML-tag “objects”.  

“search_name” wordt gevuld met de inhoud van Request parameter “OBJECT_NAAM” 
om het object te identificeren waarvan info getoond moet worden.  

3. XML naar HTML conversie middels NBG_CUSTOM/NBG_CUSTOM_<…>_info.xsl. 
 
Voorbeeld XML-bestand: 
 

 
 

Voorbeeld info venster: 
 

 
 

 Info tonen uit een tabel in de database 

In het asp-bestand is ook een voorbeeld opgenomen hoe de gegevens uit een database 
gehaald kunnen worden (zie methode 2). De volgende stappen worden uitgevoerd: 
1. Uitvoeren van een query; Pas de tabelnaam en kolomnamen in deze query aan. 
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2. Resultaat van de query in een XML variabele zetten. (Op deze manier wordt de data 
van de presentatie gescheiden gehouden). Pas de tabelnaam en kolomnamen in deze 
XML variabele aan. 

3. XML naar HTML conversie middels NBG_CUSTOM/NBG_CUSTOM_<…>_info.xsl. 
 

 Info/metadata knop tonen bij laag  

Deze mogelijkheid kunt u in het stuurmodel als volgt instellen: 
 
1. Via menu Producten → Producten → selecteer een product → Productmenu’s → 

Productlagen → selecteer een laag → Edit 
2. Via menu Producten → Productlagen → selecteer een laag → Edit 
 

 
 
Selecteer vervolgens een laag en vink optie Info/metadata tonen aan. 
 
Indien de gebruiker in NedBrowser op de  knop achter de laag drukt, wordt er een 
venster geopend. De eigenschappen van dit venster (positie, grootte, etc.) kunt u opgeven 
bij Info venster eigenschappen. Dit zijn alle eigenschappen die aan het te openen venster 
meegegeven kunnen worden. Het is de features parameter van Javascript functie 
'window.open'.  
 
Voor de specificaties van de ‘window.open’ methode, zie www.msdn.com → zoek op 
‘window.open’’. 
  
Voorbeeld:  
width=800, height=500, left=250, top=50, toolbar=yes, resizable=yes 

 

Het veld Info venster eigenschappen mag ook leeggelaten worden. In dat geval wordt de 
syteeminstelling Info venster eigenschappen onder de groep Webapplicatie gebruikt. 
 
Na deze instellingen gedaan te hebben in het stuurmodel, zult u nu moeten bepalen welke 
metadata getoond wordt in het venster. 
 
Dit kan op 2 manieren gerealiseerd worden: 
3. Info tonen uit XML bestand. 

http://www.msdn.com/


14. Bijlage C: Info/Metadata knop tonen in legenda en zoekresultaat 

NedBrowser Configuratiehandleiding 121 Versie 1.0 

4. Info tonen uit een tabel in de database. 
 

 Info tonen uit XML bestand  

In map <pad>\NBG_Share\NBG_CUSTOM staan 3 voorbeeld bestanden: 
 
1. NBG_CUSTOM_layer_info.xml 
Dit bestand bevat XML met de metadata. De XML-structuur ziet er als volgt uit: 
 
<objects> 

   <object name="Object naam" display_name="Object naam om te tonen" 

   html_url=""> 

       

<attribute display_name="Attribuut1 naam om te tonen" 

display_type='Text'>hier komt de waarde van het attribuut</attribute> 

       

<attribute display_name="Attribuut2 naam om te tonen" 

display_type='Image'>http://nedbrowser.nedgraphics.nl/NBG_CUSTOM/NBG_C

USTOM_logo.gif</attribute> 

       

<attribute display_name="Attribuut3 naam om te tonen" 

display_type='Hyperlink' hyperlink_text='Hyperlink 

tekst'>http://nedbrowser.nedgraphics.nl/NBG_CUSTOM/NBG_CUSTOM_logo.gif

</attribute> 

 

   </object> 

</objects> 

 
U dient dit bestand handmatig aan te passen. Vul waarden in voor tag <object>: 

• name  

• display name 

• html_url (optioneel). Indien ingevuld, dan wordt deze URL direct geopend in het info 

venster (de waarden voor de <attribute> tags worden genegeerd) 
 
Vul waarden in voor tag <attribute>: 

• display_name 

• display_type 

- Text  → (niet verplicht) voor het tonen van tekst 

- Image → voor het tonen van een afbeelding 

- Hyperlink → voor het tonen van een URL 

- hyperlink_text → (niet verplicht) tekst die als ‘link’ getoond wordt. Indien niet 

ingevuld, dan wordt standaard het volgende getoond: 

Klik hier voor <inhoud van display_name> 
• waarde van het attribuut 

 
Om meerdere objecten te definiëren kopieert u de regels <object name….. tot en met 
</object> 

 

 LET OP:  
Voor sommige tekens moeten de volgende speciale karakters in de tekst gebruikt 
worden: 

 

Karakter Vervangen 
door 

< &lt;        

> &gt;        
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& &amp;     

 
2. NBG_CUSTOM_layer_info.xsl 
Zorgt voor de XML naar HTML conversie van de XML structuur in 
NBG_CUSTOM_layer_info.xml.  
 
3. NBG_CUSTOM_layer_info.asp 
Dit is een voorbeeld ASP voor het tonen van metadata van een laag. U kunt deze ASP naar 
eigen wensen aanpassen (ASP kennis is een vereiste) of raadpleeg hiervoor een consultant 
van NedGraphics. 
 
NBG_CUSTOM_layer_info.asp heeft de volgende Request parameters (de waarden van 
deze parameters kunnen gebruikt worden in de ASP): 
1. NAAM_PRESENTATIE: Laagnaam in kaartmotor. 
2. OBJECT_NAAM: Naam object (= naam van het geo object waarop de laag is gebaseerd). 
 
In NBG_CUSTOM_layer_info.asp worden de volgende stappen uitgevoerd (zie methode 1): 
1. Laden van bestand NBG_CUSTOM/NBG_CUSTOM_layer_info.xml; 
2. Toevoegen van XML-attribuut “search_name” aan XML-tag “objects”.  

“search_name” wordt gevuld met de inhoud van Request parameter “OBJECT_NAAM” 
om het object te identificeren waarvan info getoond moet worden.  
Indien request parameter “OBJECT_NAAM” niet is ingevuld (d.w.z. er is geen object 
gedefinieerd voor de betreffende laag, bijvoorbeeld bij rasterlagen) dan wordt request 
parameter “NAAM_PRESENTATIE” (kaartmotor laagnaam) gebruikt. 

3. XML naar HTML conversie middels NBG_CUSTOM/NBG_CUSTOM_layer_info.xsl. 
 
Voorbeeld XML-bestand: 
 

 
 
Voorbeeld info venster: 
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 Info tonen uit een tabel in de database 

In NBG_CUSTOM_layer_info.asp is ook een voorbeeld opgenomen hoe de gegevens uit een 
database gehaald kunnen worden (zie methode 2). De volgende stappen worden 

uitgevoerd: 
1. Uitvoeren van een query; Pas de tabelnaam en kolomnamen in deze query aan. 

2. Resultaat van de query in een XML variabele zetten. (Op deze manier wordt de data van 

de presentatie gescheiden gehouden). Pas de tabelnaam en kolomnamen in deze XML 
variabele aan. 

3. XML naar HTML conversie middels NBG_CUSTOM/NBG_CUSTOM_layer_info.xsl. 
 

 Info/metadata knop tonen bij zoekresultaat 

Deze mogelijkheid kunt u in het stuurmodel als volgt instellen: 
 

Via menu Producten → Producten → Zoekresultaten → selecteer een zoekresultaat → Edit 
 

 
 

Selecteer vervolgens een zoekresultaat en vink optie Info/metadata opvragen aan. 

Indien de gebruiker op de  knop boven de zoekresultaten drukt, wordt er een venster 
geopend. De eigenschappen van dit venster (positie, grootte, etc.) kunt u opgeven bij Info 
venster eigenschappen. Dit zijn alle eigenschappen die aan het te openen venster 
meegegeven kunnen worden. Het is de features parameter van Javascript functie 
'window.open'. 
 
Voor de specificaties van de ‘window.open’ methode, zie www.msdn.com → zoek op 
‘window.open’’. 
 
Voorbeeld:  
width=800, height=500, left=250, top=50, toolbar=yes, resizable=yes 
 

Het veld Info venster eigenschappen mag ook leeg gelaten worden. In dat geval wordt de 
syteeminstelling Info venster eigenschappen onder de groep Webapplicatie gebruikt. 
 
Na deze instellingen gedaan te hebben in het stuurmodel, zult u nu moeten bepalen welke 
metadata getoond wordt in het venster. 
Dit kan op 2 manieren gerealiseerd worden: 
1. Info tonen uit XML bestand. 
2. Info tonen uit een tabel in de database. 
 

http://www.msdn.com/
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 Info tonen uit XML bestand  

In map <pad>\NBG_Share\NBG_CUSTOM staan 3 voorbeeld bestanden: 
 

1. NBG_CUSTOM_result_info.xml 
Dit bestand bevat XML met de metadata. De XML-structuur ziet er als volgt uit: 
<objects> 

   <object name="Object naam" display_name="Object naam om te tonen" 

   html_url=""> 

       

<attribute display_name="Attribuut1 naam om te tonen" 

display_type='Text'>hier komt de waarde van het attribuut</attribute> 

       

<attribute display_name="Attribuut2 naam om te tonen" 

display_type='Image'>http://nedbrowser.nedgraphics.nl/NBG_CUSTOM/NBG_C

USTOM_logo.gif</attribute> 

       

<attribute display_name="Attribuut3 naam om te tonen" 

display_type='Hyperlink' hyperlink_text='Hyperlink 

tekst'>http://nedbrowser.nedgraphics.nl/NBG_CUSTOM/NBG_CUSTOM_logo.gif

</attribute> 

 

   </object> 

</objects> 

 
U dient dit bestand handmatig aan te passen. Vul waarden in voor tag <object>: 

• name  

• display name 

• html_url (optioneel). Indien ingevuld, dan wordt deze URL direct geopend in het info 
venster (de waarden voor de <attribute> tags worden genegeerd) 

 
Vul waarden in voor tag <attribute>: 

• display_name 

• display_type 

- Text  → (niet verplicht) voor het tonen van tekst 

- Image → voor het tonen van een afbeelding 

- Hyperlink → voor het tonen van een URL 

- hyperlink_text → (niet verplicht) tekst die als ‘link’ getoond wordt. Indien niet 

ingevuld, dan wordt standaard het volgende getoond: 
Klik hier voor <inhoud van display_name> 

 

• waarde van het attribuut 

 
Om meerder objecten te definiëren kopieert u de regels <object name….. tot en met 
</object> 

 

 LET OP:  
Voor sommige tekens moeten de volgende speciale karakters in de tekst gebruikt 
worden: 

 

Karakter Vervangen 
door 

< &lt;        

> &gt;        

& &amp;     

 
2. NBG_CUSTOM_result_info.xsl 
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Zorgt voor de XML naar HTML conversie van de XML structuur in 
NBG_CUSTOM_result_info.xml. 
 
3. NBG_CUSTOM_result_info.asp 
Dit is een voorbeeld ASP voor het tonen van metadata van een zoekresultaat. U kunt deze 
ASP naar eigen wensen aanpassen (ASP kennis is een vereiste) of raadpleeg hiervoor een 
consultant van NedGraphics. 
 
NBG_CUSTOM_result_info.asp heeft de volgende Request parameters (de waarden van 
deze parameters kunnen gebruikt worden in de ASP): 
1. OBJECT_NAAM: (=naam van het object waarop het zoekresultaat is gebaseerd). 
 
In NBG_CUSTOM_result_info.asp worden de volgende stappen uitgevoerd (zie methode 1): 
1. Laden van bestand NBG_CUSTOM/NBG_CUSTOM_result_info.xml; 
2. Toevoegen van XML-attribuut “search_name” aan XML-tag “objects”. “search_name” 

wordt gevuld met de inhoud van Request parameter “OBJECT_NAAM” om het object 
te identificeren waarvan info getoond moet worden. 

3. XML naar HTML conversie middels NBG_CUSTOM/NBG_CUSTOM_result_info.xsl. 
 
Voorbeeld XML-bestand: 
 

 
 
Voorbeeld info venster: 

 

 
 

 Info tonen uit een tabel in de database 

In NBG_CUSTOM_result_info.asp is ook een voorbeeld opgenomen hoe de gegevens uit 
een database gehaald kunnen worden (zie methode 2). De volgende stappen worden 
uitgevoerd: 
1. Uitvoeren van een query; Pas de tabelnaam en kolomnamen in deze query aan. 
2. Resultaat van de query in een XML variabele zetten. (Op deze manier wordt de data 

van de presentatie gescheiden gehouden). Pas de tabelnaam en kolomnamen in deze 
XML variabele aan. 

3. XML naar HTML conversie middels NBG_CUSTOM/NBG_CUSTOM_result_info.xsl. 
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 BIJLAGE D: RAPPORT VOOR ZOEKRESULTATEN 

 Inleiding 

Het is mogelijk om in het resultaatscherm een knop boven de zoekresultaten te tonen 
waarmee de gebruiker een door u gedefinieerd rapport kan opvragen over de 
desbetreffende zoekresultaten (zie onderstaande afbeelding). 
 
 

 
 
Deze mogelijkheid kunt u in het stuurmodel instellen via menu Producten → Producten → 
Zoekresultaten. 
 

 
 

 Rapport iconen 

Het icoon dat getoond wordt in het zoekresultaat gedeelte kunt u zelf definiëren bij Icoon 
URL: 
 
Icoon URL (normaal) → URL van het te tonen rapport-icoon in normale toestand. #ROOT# 
en #NBG_ROOT# mag hierin worden gebruikt.   

 
Voorbeeld:  
#NBG_ROOT#NBG_CUSTOM/ NBG_CUSTOM_normal_rapport_url.gif 
 

Icoon URL (over) → URL van het te tonen rapport-icoon als de muis over het icoon 
beweegt. #ROOT# en #NBG_ROOT# mag hierin worden gebruikt.  

  
Voorbeeld:  
#NBG_ROOT#NBG_CUSTOM/ NBG_CUSTOM_over_rapport_url.gif 
 

 LET OP:  
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NBG_CUSTOM_normal_rapport_url.gif en NBG_CUSTOM_over_rapport_url.gif dienen 
slechts als voorbeelden en kunt u naar uw eigen wensen aanpassen. 

 

 Hint tekst  

Hint tekst is de tooltip die zichtbaar wordt wanneer de gebruiker met de muis over het 
rapport-icoon beweegt. 
 

 Venstereigenschappen 

Indien de gebruiker een aantal zoekresultaten aanvinkt en op deze knop drukt, wordt er een 

venster geopend met een aanroep naar een gedefinieerd rapport (zoals gedefinieerd bij 
Rapport URL).  

 
De eigenschappen van dit venster (positie, grootte, etc.) kunt u opgeven bij Info venster 
eigenschappen. Dit zijn alle eigenschappen die aan het te openen venster meegegeven 
kunnen worden. Het is de features parameter van Javascript functie 'window.open'. 
 
Voor de specificaties van de ‘window.open’ methode, zie www.msdn.com → zoek op 

‘window.open’’. 
 

Voorbeeld:  
width=800, height=500, left=250, top=50, toolbar=yes, resizable=yes 

 

Het veld Info venster eigenschappen  mag ook leeg gelaten worden. In dat geval wordt de 
syteeminstelling Info venster eigenschappen onder de groep Webapplicatie gebruikt. 

 Rapport URL 

NBG_CUSTOM/NBG_CUSTOM_rapport.asp is een voorbeeld ASP en kunt u naar uw wensen 

aanpassen (ASP kennis is een vereiste) of raadpleeg hiervoor een consultant van 
NedGraphics.  

 

In deze ASP worden de volgende stappen uitgevoerd: 
1. Er worden 10 URL Form parameters (DATA0 t/m DATA9) meegegeven aan de URL met 

daarin de waarden van de aangevinkte zoekresultaten. In het ASP-bestand worden de 
waarden van de 10 URL Form Parameters aan elkaar geplakt. 

2. De rapport parameter waarden van 1 zoekresultaat worden gescheiden door een 

komma (,).  
3. Zoekresultaten worden gescheiden door een ampersand (&).  

4. In de waarde van het attribuut dienen de speciale tekens vervangen te zijn: 
& door &amp; 

, door &comma. 
 

Voorbeeld voor het doorgeven van perceelgegevens: 
RSD01,A,101&RSD,A,102&RSD01,C,100 

 

 LET OP:  
Omdat een Form Parameter maar 100k karakters kan bevatten, is er een maximum 
van 1000k karakters wat doorgegeven kan worden aan de Rapport URL. 

http://www.msdn.com/
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 Attributen 

Tot slot, geef per attribuut in het zoekresultaat aan of het attribuut in het rapport moet 
worden getoond: 
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 BIJLAGE E: LIJNPATRONEN 

 Inleiding 

Lijnpatronen worden gebruikt bij het aanmaken van thema's voor normale lagen en bij het 
aanmaken van lijnfuncties voor redlinelagen. 
 
In het stuurmodel worden een aantal standaard lijnpatronen meegeleverd, maar u kunt 
ook zelf lijnpatronen samenstellen via menu Referenties → Lijnpatronen. 
 

 
 

 Lijnpatroon 

Een lijnpatroon wordt middels XML gedefinieerd: 
 
<linestyle theme="base" base_width="1" base_color="black"  

           base_pattern="8.0,6.0,0.5,6.0,0.5,6.0"  

           fill_width="2" fill_color="green"   

           parallel_width="3" parallel_color="#ff0000"  

           parallel_pattern=="2.0,10.0" 

           marker_symbol="PIJL_HORIZONTAAL_ZWART.GIF" 

           marker_interval="10"  

           marker_position="0.5" 

           marker_width="5" marker_height="10" /> 
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Lijnpatronen bestaan uit 4 delen die op elkaar worden getekend in de volgende volgorde:  
 

1. Parallel: Het patroon dat het eerst wordt getekend. Dit is het deel wat meestal aan de 
buitenkant zichtbaar is, maar dat is afhankelijk van dash-patroon van de overige delen. 

2. Fill : Het patroon wat als tweede wordt getekend bovenop het eerste patroon. 

3. Base : Het patroon wat als laatste wordt getekend bovenop de vorige patronen. 
4. Marker: Éen of meer symbolen op de lijn 

 
Het is mogelijk om lijnen als punten te presenteren door het “width”-attribuut van de eerste 

3 delen op 0 te zetten en het “theme”-attribuut op “marker_font” of “none”. 
 

Voorbeeld: 

 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 LET OP: 
Gestippelde lijnen komen het best tot zijn recht wanneer antialiasing op true is 
ingesteld. Dit kan via menu Systeeminstellingen → groep GeoTools → Antialiasing. Dit 
heeft wel consequenties voor de performance aangezien er een groter plaatje 
gegeneerd wordt. 

 

 
 

 Uitleg XML attributen 

• Attribute eindigend op _color  

De _color attributen zijn HTML kleuren zoals "red", "blue", "black", "white", "green", "yellow", 
maar kan ook een # zijn gevolgd door 6 hexadecimale cijfers voor de RGB waarde, B.V. 
#FF0000 voor de kleur rood. Waarde "transparent" kan gebruikt worden voor een 

transparante kleur.  

  

• Attribute eindigend op _width (uitgezonderd marker_width) 

parallel_width 

base_widt
h 

fill_width 

base_color fill_color parallel_color 

base_pattern 

Parallel 

Fill 

Base 

Parallel 

Fill 

Marker 

parallel_pattern 
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Hiermee wordt de dikte van het onderdeel aangegeven. De _width attributen mogen 0 
zijn. Hiermee geef je aan dat dat deel van de lijn niet getekend moet worden. Let op: 

het heeft geen zin om een _width attribuut de waarde 0 te geven als het theme-
attribuut aangeeft dat dat deel vanuit het thema (legenda-item) gezet wordt.  

 

- theme 
Mogelijke waarden : base, fill, parallel, marker_font of none 

Dit bepaalt welk deel van de lijn de lijndikte (niet van toepassing bij marker_font) en 
lijnkleur overneemt van het legenda-item uit het thema. 

Indien none dan wordt niets uit legenda-item overgenomen en het lijnpatroon 
toegepast as-is. 

 

- base_width (niet van belang indien theme="base")  
Dikte van de Base-lijn.  

  
- base_color (niet van belang indien theme="base")  

Kleur van de Base-lijn. Dit is een HTML kleur.   

  
- base_pattern 

Patroon van de Base-lijn. Bestaat uit een even aantal getallen gescheiden door een 
komma.  

Het eerste getal is de lengte van een streepje, het tweede getal is de lengte van de 
tussenruimte tot het volgende streepje. Het derde getal is de lengte van het tweede 

streepje en het vierde getal de tussenruimte naar het volgende streepje, enz. Dit 

patroon wordt zo herhaald. De tussenruimte wordt gevuld met de fill_color. Indien 
markers op de lijn worden geplaatst met een marker_interval houd er dan rekening mee 

dat de totale lengte van base_pattern gelijk is aan marker_width + marker_interval 
waarbij marker_width minimaal 6 is indien marker_height <= 6. Base_pattern start in 

dat geval in het midden van de marker. 

  
- fill_width (niet van belang indien theme="fill")  

Dikte van de Fill-lijn.  
  

- fill_color (niet van belang indien theme="fill")  

Kleur van de Fill-lijn. Dit is een HTML kleur. Indien base_width > 0 en base_pattern een 
niet Solid patroon is, dan is dit ook de kleur van de ruimtes tussen de streepjes in de 

Base-lijn.  
  

- fill_pattern 
Patroon van de Fill-lijn. Bestaat uit een even aantal getallen gescheiden door een 

komma.  

Het eerste getal is de lengte van een streepje, het tweede getal is de lengte van de 
tussenruimte tot het volgende streepje. Het derde getal is de lengte van het tweede 

streepje en het vierde getal de tussenruimte naar het volgende streepje, enz. Dit 
patroon wordt zo herhaald. De tussenruimte wordt gevuld met de fill_color. Indien 

markers op de lijn worden geplaatst met een marker_interval houd er dan rekening mee 

dat de totale lengte van base_pattern gelijk is aan marker_width + marker_interval 
waarbij marker_width minimaal 6 is indien marker_height <= 6. Base_pattern start in 

dat geval in het midden van de marker. 
 

- parallel_width (niet van belang indien theme="parallel")  
Dikte van Parallel-lijn.  

  

- parallel_color (niet van belang indien theme="parallel")  
Kleur van de Parallal-lijn.  

  
- parallel_pattern 
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Patroon van de Parallel-lijn. Bestaat uit een even aantal getallen gescheiden door een 
komma.  

Het eerste getal is de lengte van een streepje, het tweede getal is de lengte van de 
tussenruimte tot het volgende streepje. Het derde getal is de lengte van het tweede 

streepje en het vierde getal de tussenruimte naar het volgende streepje, enz. Dit 

patroon wordt zo herhaald. De tussenruimte wordt gevuld met de fill_color. Indien 
markers op de lijn worden geplaatst met een marker_interval houd er dan rekening mee 

dat de totale lengte van parallel_pattern gelijk is aan marker_width + marker_interval 
waarbij marker_width minimaal 6 is indien marker_height <= 6. Parallel_pattern start in 

dat geval in het midden van de marker. 
 

- marker_symbol  

Dit is de bestandsnaam van een symbool. Het bestand moet middels een bitmap upload 
opgenomen zijn in het stuurmodel. Geldige formaten zijn JPEG, PNG en GIF. BMP is niet 

mogelijk. Het symbool wordt midden op de base-lijn geplaatst. Indien een offset nodig 
is t.o.v. de lijn voeg dan lege ruimte aan onder- of bovenzijde van het symbool toe. Een 

nadeel van het gebruik van marker_symbol t.o.v. marker_font is dat het minder mooi 

schaalt en dat de kleur van het legenda-item niet gesubstitueerd kan worden. 

 
- marker_font / marker_font_symbol / marker_font_color 

In plaats van een marker_symbol kan ook een font-symbool worden gebruikt. Daarvoor 
moet marker_font, marker_font_symbol en optioneel marker_font_color worden 

ingevuld. Vul marker_font met de naam van een TrueType Font , bijv. Wingdings ((Let 
op: hoofdlettergevoelig!) dat in het stuurmodel is geladen via menu Referenties, optie 

Font symbolen.  

Vul marker_font_symbol met het numerieke font teken van het font-symbool. Vul 
marker_font_color met de HTML kleur. Indien niet ingevuld, dan wordt de kleur van het 

legenda item genomen. Een voordeel van het gebruik van marker_font t.o.v. 
marker_symbol is dat het mooier schaalt en dat de kleur van het legenda-item 

gesubstitueerd kan worden met theme=”marker_font”. Een nadeel van marker_font is 

dat er geen offset t.o.v. de lijn gedaan kan worden. 
 

- marker_interval 
Interval afstand in pixels tussen de symbolen op de lijn. Gebruik dit attribuut alleen als 

het symbool meerdere keren voor moet komen op de lijn. Gebruik marker_position 
indien er geen interval gebruikt moet worden. Marker_interval en marker_position zijn 

complementair. 

 
- marker_position 

Attribuut marker_interval moet in dit geval weggelaten worden.  
Dit attribuut heeft drie gebruiksmogelijkheden: 

1. Positie tussen start- en eindpunt van de lijn.  

De waarde moet gelijk zijn aan: middle_points of een numerieke waarde tussen 0 en 1 
waarbij 0.5 hetzelfde voorstelt als middle_points. Voor lijnen met meerdere 

lijnsegmenten wordt één symbool per lijnsegment getekend. 
2. Op elk punt van de lijn een symbool 

De waarde moet gelijk zijn aan: all_points 

3. Op start- en eindpunt van de lijn een symbool 
De waarde moet gelijk zijn aan: end_points 

Het verschil tussen 2 en 3 is alleen merkbaar als de lijn uit meerdere segmenten 
bestaat. 

 
- marker_anchor_x / marker_anchor_y 

X/Y-positie van het ankerpunt van de marker (marker_symbol of marker_font_symbol). 

Vul een waarde tussen 0.0 en 1.0 in. Waarde 0.5 is standaard en betekent het 
middelpunt. Gebruik bijv. marker_anchor_y="1.0" om het symbool bovenop de lijn te 
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plaatsen en marker_anchor_y="0.0" om het symbool onder de lijn te plaatsen, waarbij 
de lijn van links naar rechts loopt. 

 
- marker_width, marker_height 

Dit is de breedte resp. hoogte van het symbool in pixels. 1 van de 2 moet groter zijn 

dan 6. Beiden moeten groter zijn dan 2. 
  

Voorbeelden 
 

Voorbeeld 1: Base → Dash Dot Dot 

 
<linestyle base_width="1" base_color="blue"  

           base_pattern="8.0,6.0,0.5,6.0,0.5,6.0"  

           fill_width="0" fill_color="transparent"   

           parallel_width="0" parallel_color="transparent" 

           theme="base"/> 

 

 

 
 

 
 

Lijn in webapplicatie 

Aangezien fill_width en parallel_width op 0 
zijn ingesteld, zal alleen de base van de lijn 

getoond worden. De fill_color is 
transparant.  

 
Theme heeft in dit voorbeeld waarde base, 

daarom zal in de webapplicatie de lijn niet 

de kleur blauw krijgen, maar wordt de kleur 
overgenomen van het legenda-item uit het 

thema. In dit geval is de kleur van het 
legenda-item rood (zie afbeelding 

hiernaast). 
 

 
 

   8.0          6.0     0.5     6.0     0.5    6.0                               herhaling pattern 

1 
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Voorbeeld 2: Base → Dash 

 
<linestyle base_width="1" base_color="blue" 

           base_pattern="8.0,6.0"  

           fill_width="0" fill_color="transparent"  

           parallel_width="0" parallel_color="transparent" 

           theme="base"/> 

 

 
 

 
 

 

Lijn in webapplicatie 
Aangezien fill_width en parallel_width op 0 

zijn ingesteld, zal alleen de base van de lijn 
getoond worden. De fill_color is 

transparant.  

 
Theme heeft in dit voorbeeld waarde base, 

daarom zal in de webapplicatie de lijn niet 
de kleur blauw krijgen, maar wordt de kleur 

overgenomen van het legenda-item uit het 

thema. In dit geval is de kleur van het 
legenda-item rood (zie afbeelding 

hiernaast). 
 

 
Voorbeeld 3: Base + Parallel → Solid 

 
<linestyle base_width="3" base_color="green" 

           base_pattern="10.0,0.0"  

           fill_width="0" fill_color="blue"  

           parallel_width="5" parallel_color="blue"  

           theme="base"/> 

 

 

 
 

 
 

 
 

 

 
 

 
 

  

   8.0          6.0                                             herhaling pattern 

1 

10.0 

3 

1 

1 
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Lijn in webapplicatie 
Aangezien fill_width op 0 is ingesteld, 

zullen alleen de base lijn en de 2 
evenwijdige lijnen (parallel) getoond 

worden. 

De kleur van de evenwijdige lijnen 
(parallel_color) is ingesteld op blauw. 

 
Theme heeft in dit voorbeeld waarde 

base, daarom zal in de webapplicatie 
het hart van de lijn niet de kleur groen 

krijgen, maar wordt de kleur 

overgenomen van het legenda-item uit 
het thema. In dit geval is de kleur van 

het legenda-item rood (zie afbeelding 
hiernaast). 

 
 

 

 

 
Voorbeeld 4: Base + Fill + Parallel → Dash 

 
<linestyle base_width="1" base_color="blue" 

           base_pattern="8.0,6.0"  

           fill_width="3" fill_color="green"  

           parallel_width="5" parallel_color="black"  

           theme="fill"/> 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Lijn in webapplicatie 

De 2 buitenste evenwijdige lijnen (parallel) 
zijn zwart met dikte 1 = (parallel_width – 

fill_width) /2 
 

Aangezien theme in dit voorbeeld waarde 

fill heeft, zal de ruimte tussen de dashes in 
het hart van de lijn (base) en de binnenste 

evenwijdige lijnen (fill) niet de kleur groen 
krijgen, maar wordt de kleur overgenomen 

van het legenda-item uit het thema. In dit 
geval is de kleur van het legenda-item rood. 

De fill_width wordt ook overgenomen van 

het legenda-item en is in dit geval 3 (zie 
afbeelding hiernaast). 

 

 

 

1 

1 

1 

1 

1 

   8.0          6.0                                             herhaling pattern 
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Voorbeeld 5: Base + multiple Markers 
 
<linestyle base_width="2" base_color="green" 

           base_pattern="10.0,0.0"  

           fill_width="0" fill_color="transparent"  

           parallel_width="0" parallel_color="transparent"  

           marker_symbol="HAAIENTAND_ORANJE.gif" 

           marker_interval="10" 

           marker_width="2" marker_height="12" 

           theme="base"/> 

 
 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Lijn in webapplicatie 
In dit voorbeeld is er alleen een base-lijn met daarop meerdere symbolen 

gescheiden door een tussenruimte. Houd bij de tussenruimte (marker_interval) 
rekening met de breedte van het doek van het symbool-plaatje. In dit voorbeeld 

wordt een asymmetrisch symbool gebruikt. Zorg in dat geval in het symbool-

plaatje ervoor dat de hoogte van het doek 2x zo groot is als de hoogte van het 
symbool. De marker_width en marker_height hoeven niet per se gelijk te zijn 

aan de maten van het doek van het symbool-plaatje. De verhoudingen moeten 
wel gelijk zijn anders wordt het symbool uit elkaar getrokken. 

 
 

 

2 

12 

10 

Grootte van het 
doek van het 
symbool 
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Voorbeeld 6: Base + single Marker 
 

<linestyle base_width="2" base_color="green" 

           base_pattern="10.0,0.0"  

           fill_width="0" fill_color="transparent"  

           parallel_width="0" parallel_color="transparent"  

           marker_symbol="PIJL_HORIZONTAAL_ZWART.gif" 

           marker_position="0.5" 

           marker_width="6" marker_height="6" 

           theme="base"/> 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Lijn in webapplicatie 

In dit voorbeeld is er alleen een base-lijn met daarop één symbool halverwege het 

start- en eindpunt van de lijn. 

 

 

 

Voorbeeld 7: Base + start/eind Marker 
 
<linestyle base_width="2" base_color="green" 

           base_pattern="10.0,0.0"  

           fill_width="0" fill_color="transparent"  

           parallel_width="0" parallel_color="transparent"  

           marker_symbol="STIP_ZWART.gif" 

           marker_position="end_points" 

           marker_width="6" marker_height="6" 

           theme="base"/> 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Lijn in webapplicatie 

2 

6 

2 

6 
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In dit voorbeeld is er alleen een base-lijn met daarop twee symbolen op het start- en 
eindpunt van de lijn. Gebruik marker_position=”all_points” indien de lijn uit 

meerdere segmenten (punten) bestaat en op elk knikpunt een symbool geplaatst 
moet worden. 
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 BIJLAGE F: OBJECTEN IN KAART TOEVOEGEN MET KLANTAFH. 
ATTRIBUTEN 

 Inleiding 

Het is mogelijk om met behulp van een nieuwe kaartknop punten, lijnen en vlakken aan de 
kaart toe te voegen met klantafhankelijke attributen. Daarna wordt een venster geopend 
met een zelf gedefinieerde URL. 
 
De applicatiebeheerder voegt een nieuwe functie knop toe aan het kaartmenu waarmee 
de eindgebruiker de tekenfunctionaliteit kan starten. 
 
De eindgebruiker kan de nieuwe kaartknop activeren. Daarna kan het tekenen van een 
punt, lijn of vlak starten, net zoals bij redlining. Als deze actie klaar is wordt een op maat 
gemaakt formulier getoond waarin een aantal administratieve attributen ingevuld kunnen 
worden. Met een druk op OK wordt het formulier gesloten en de kaart ververst. 
 

 Stuurmodel 

In het stuurmodel kunt u deze nieuwe knop instellen via menu Kaartmenu → Knoppen. 
Vervolgens kunt u via menu Kaartmenu → Kaartmenu’s → Edit → Voeg functie toe deze 
knop aan een kaartmenu toekennen. 
 
Ga naar menu Kaartmenu → Knoppen → Voeg knop toe. Vul de volgende velden in: 
 
Kaartvenster functienaam 
Geef de knop een willekeurige naam. Als voorbeeld is kaartknop ADD_ADDRESS aan de 
installatie toegevoegd. 
 
Procedure aanroep 
De kaartknop start de Javascript procedure NBG_MAP_add_custom_entity die 4 
parameters heeft: 
 
NBG_MAP_add_custom_entity(‘<entity-type>’, ‘<entity>’, ‘<URL>’, ‘<window-features>’) 
 
entity-type  
P=Punt 
V=Vlak 
L=Lijn 
 
Bij entiteit-type=P wordt na 1x klikken het formulier getoond (ingesteld bij de URL). 
Bij entiteit-type=V wordt na een dubbelklik het formulier getoond (ingesteld bij de URL). 
Bij entiteit-type=L wordt na het loslaten van de muisknop het formulier getoond (ingesteld 
bij de URL). 
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entity 
De waarde kan zelf worden gekozen. Deze wordt doorgegeven als parameter 'entity' aan 
de URL en kan daar eventueel gebruikt worden. ‘Entity’ is bedoeld om het generiek te 
kunnen gebruiken voor andere doeleinden. 
 
Bijvoorbeeld: 
1. panden kunnen tekenen (entity-type=V(vlak), entity=PAND) 
2. adressen kunnen toevoegen (entity-type=P(punt), entity=ADDRESS) 
 
Afhankelijk van <entity> kunnen dan andere attributen getoond worden in de maat 
gemaakte ASP. 
 
url 
De URL die aangeroepen moet worden. Hierin mag #NBG_ROOT# worden gebruikt. 
Deze info knop opent een nieuw venster met daarin  
NBG_CUSTOM/ NBG_CUSTOM_add_address.asp.  
 
Dit is een voorbeeld ASP die standaard wordt meegeleverd en kunt u naar uw wensen 
aanpassen of raadpleeg hiervoor een consultant van NedGraphics. 
 
Na het tekenen wordt een nieuw venster geopend met daarin de URL.  
Aan de URL worden 2 parameters doorgegeven: 
- entity : Dit is gelijk aan de 2e parameter entity van NBG_MAP_add_custom_entity. 
- xycoords: De X en Y coordinaten gescheiden door een komma. 
 
window_features 
De venstereigenschappen van window.open. 

 
Voorbeeld 
NBG_MAP_add_custom_entity('P','ADDRESS','#NBG_ROOT#NBG_CUSTOM/NBG_CUSTOM
_add_address.asp','width=400,height=500,left=250,top=50,toolbar=no,resizable=yes'); 
 
Opmerking 
De entiteit wordt als vensternaam gebruikt. Dit houdt in dat dezelfde entiteiten altijd in 
hetzelfde geopende venster worden getoond. Indien met een andere knop een andere 
entiteit wordt getekend zal er een nieuw venster worden geopend. 

 
Filenaam symbool Normaal 
Bijvoorbeeld: normal_add_address.png 
 
Filenaam symbool Normaal 
Bijvoorbeeld: over_add_address.png 
 
Filenaam symbool Actief 
Bijvoorbeeld: active_add_address.png 
 
Hint tekst 
Bijvoorbeeld: ‘Adres toevoegen’ 
 
Actief maken  
Ja 
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 BIJLAGE G: NEDBROWSER OPSTARTEN MET PARAMETERS 

 Inleiding 

Het is mogelijk om NedBrowser op te starten met parameters om bijvoorbeeld in 
te zoomen op een bepaald adres of te starten met een bepaald kaartcentrum en 
schaal/breedte. 
Dit gaat door middel van een URL. Deze URL bestaat uit een basis URL en 
daarachter een aantal configureerbare parameters.  
 

 Basis URL 

Een voorbeeld van een basis URL is: 
http://nedbrowser.nedgraphics.nl/nbg 

 
Vervolgens dient achter de basis URL een slash en een vraagteken (/?) geplakt te 

worden, de URL wordt dan als volgt: 
 
http://nedbrowser.nedgraphics.nl/nbg/?  

 

Daarna kunnen de parameters achter deze URL worden toegevoegd. Deze 
parameters worden uitgelegd in de volgende paragraaf. 
 

 Parameter overzicht 

De URL parameters zijn: 
 

• action 
Mogelijke waarden:  

- NBG_INIT  
Start NedBrowser en toon een initiële kaart met een bepaald kaartcentrum 
en schaal/breedte. 

- NBG_SEARCH_GEO 
Start NedBrowser en zoom in op 1 of meer kaartobjecten. 

 

• nbg_statistiek_functie 
Optioneel. Naam van de statistiek functie die wordt gebruikt bij het vastleggen 
van het opstarten. Standaard wordt statistiek functie NBG gebruikt. Statistiek 
functies worden beheerd via menu Referenties, optie Statistiek functies. 

 

• default_centre_x 
X-coördinaat kaartcentrum. 

 

• default_centre_y 
Y-coördinaat kaartcentrum. 

  

• default_scale 

http://nedbrowser.nedgraphics.nl/nbg
http://nedbrowser.nedgraphics.nl/nbg/
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Kaartschaal. 
 

• default_width  
Kaartbreedte (wordt alleen gebruikt indien kaartschaal niet is ingevuld). 
 

• start_webapp 
Deze parameter overruled de systeeminstelling ‘Pagina waarmee NedBrowser 
wordt gestart’ onder groep ‘Webapplicatie’. 
 
Deze parameter kan de volgende waarden hebben: 
C  Nieuw venster openen, bestaande pagina afsluiten 
A  Nieuw venster openen, vragen om bestaande pagina af te sluiten 
O  Nieuw venster openen, bestaande pagina niet afsluiten 
G  Geen nieuw venster openen 

 
Hier gelden een aantal beperkingen: 

• In Firefox en Chrome wordt de bestaande pagina niet afgesloten, ook al 
staat deze instelling op C of A.  

• De vraag om de bestaande pagina af te sluiten bij instelling A wordt alleen 
getoond in Internet Explorer. 

• In Opera wordt bij de instellingen C, A en O een nieuw tabblad geopend en 
niet een nieuw venster. 

• Windows Edge ondersteunt alleen optie G. 

 

• product 
Geldt alleen voor action=NBG_SEARCH_GEO. 
 
De waarde van deze parameter moet de naam van een product zijn in de 
NedBrowser beheeromgeving. Zie menu Producten → optie Producten. De 
naam van een product is rood omkaderd in onderstaande afbeelding: 
 

 LET OP:  
Dit is hoofdlettergevoelig. 

 

 
 

• search_criterium 
Geldt alleen voor action=NBG_SEARCH_GEO. 
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De waarde van deze parameter moet de “naam op scherm” van een 
zoekingang zijn in de NedBrowser beheeromgeving. Zoekingangen worden per 
product vastgelegd. Druk op de link Zoekingangen uit de vorige afbeelding 
nadat het juiste product is aangeklikt. De “naam op scherm” van een 
zoekingang is rood omkaderd in onderstaande afbeelding. 
 

 LET OP:  
Dit is hoofdlettergevoelig. 

 

 
 
Onthoud de naam van het zoekresultaat dat links van “naam op scherm” staat 
en sluit het scherm, deze wordt later gebruikt om parameter geo_relation te 
kunnen bepalen. 
 

• search_type 
Geldt alleen voor action=NBG_SEARCH_GEO. 
 
Deze parameter geeft aan of de kaartobjecten geselecteerd/opgelicht of 
gefilterd worden. 
 
Deze parameter kan de volgende waarden hebben: 
S  Kaartobjecten selecteren 
O  Kaartobjecten oplichten 
F  Kaartobjecten filteren 
 
Indien parameter search_type niet wordt gespecificeerd, dan worden 
standaard de kaartobjecten geselecteerd (search_type = S). 
 

• geo_relation 
Geldt alleen voor action=NBG_SEARCH_GEO. 
 
De waarde van deze parameter moet de relatienaam van een kaartrelatie zijn 
in de NedBrowser beheeromgeving. Kaartrelaties worden per product en 
daarin per zoekresultaat vastgelegd. Druk op de knop Relaties uit de eerste 
afbeelding nadat het juiste product is aangeklikt. Klik daarna op het 
zoekresultaat uit de vorige afbeelding. Rechts onderin verschijnen de 
kaartrelaties van het zoekresultaat. De “relatienaam” van een kaartrelatie is 
rood omkaderd in onderstaande afbeelding. 
 

 LET OP:  
Dit is hoofdlettergevoelig. 
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Sluit het scherm. 
 
Indien parameter geo_relation niet wordt gespecificeerd, dan worden alle 
kaartrelaties gebruikt. 
 

• parameters 
Geldt alleen voor action=NBG_SEARCH_GEO. 
 
De attribuutnamen die hierin gebruikt mogen worden zijn de attribuutnamen 
van het object waarop het zoekresultaat van de zoekingang is gebaseerd. De 
naam van dit object is te vinden door op de knop Zoekresultaten te klikken in 
de eerste afbeelding, nadat het juiste product is aangeklikt. De naam van het 
object wordt rood omkaderd in de volgende afbeelding. 
 

 
 
Sluit dit scherm en sluit het productenscherm. Zoek nu in het objectenscherm 
(menu Datamodel → optie Objecten) de attribuutnamen. Dit gaat als volgt: vul 
Object (rood omkaderd) in de volgende afbeelding en druk op de knop Zoek. 
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Klik nu op Edit. 
 

 
 
Onder de tab Attributen staan onder “naam in object” de attribuutnamen die 
gebruikt kunnen worden in parameter “parameters”. 
 
Syntax 1 
Specificeer "parameters" als volgt indien vergelijkingsoperator = wordt 
gebruikt: 
 
<attr1>,<attr2>,...=<value11>,<value12>,...&<value21>,<value22>,... 
 
Het "&" teken wordt gebruikt om meerdere rijen aan te geven.  
 
Syntax 2 
Indien ook andere vergelijkingsoperatoren worden gebruikt, gebruik dan: 
 
<attr1><operator1><value1>,<attr2><operator2><value2>,... 
 
Het "&" teken kan in dat geval niet worden gebruikt.  
Dezelfde kolomnaam mag bij deze syntax meerdere keren voorkomen. 
 
Operatoren 
In bovenstaand voorbeeld kunnen <operator1> en <operator2> de volgende 
waarden bevatten: 
= 
< 
> 
<= 
>= 
<> 
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#B#   (betekent "bevat") 
#S#   (betekent "start met") 
#E#   (betekent "eindigt op") 
 

 LET OP:  
De attribuutnamen zijn hoofdlettergevoelig. 
Gebruik voor Oracle kolomnamen altijd hoofdletters. 

 Voorbeelden 

1. 
Bij deze URL wordt ingezoomd op adres Zwarteweg 10 in Enschede. 

 
http://nedbrowser.nedgraphics.nl/nbg/?action=NBG_SEARCH_

GEO&product=Kadastraal&search_criterium=Adressen&geo_rel

ation=Adressen&parameters=STRAATNAAM,HUISNUMMER=ZWARTEWE

G,10 

 

2. 
Bij deze URL wordt de initiële kaart met een bepaalde kaartcentrum en schaal in 
Enschede getoond. 

 
http://nedbrowser.nedgraphics.nl/nbg/?action=NBG_INIT&de

fault_scale=1000&default_centre_x=255000&default_centre_

y=470000&start_webapp=G 

 

http://nedbrowser.nedgraphics.nl/nbg/?action=NBG_SEARCH_GEO&product=Kadastraal&search_criterium=Adressen&geo_relation=Adressen&parameters=STRAATNAAM,HUISNUMMER=ZWARTEWEG,10
http://nedbrowser.nedgraphics.nl/nbg/?action=NBG_SEARCH_GEO&product=Kadastraal&search_criterium=Adressen&geo_relation=Adressen&parameters=STRAATNAAM,HUISNUMMER=ZWARTEWEG,10
http://nedbrowser.nedgraphics.nl/nbg/?action=NBG_SEARCH_GEO&product=Kadastraal&search_criterium=Adressen&geo_relation=Adressen&parameters=STRAATNAAM,HUISNUMMER=ZWARTEWEG,10
http://nedbrowser.nedgraphics.nl/nbg/?action=NBG_SEARCH_GEO&product=Kadastraal&search_criterium=Adressen&geo_relation=Adressen&parameters=STRAATNAAM,HUISNUMMER=ZWARTEWEG,10
http://nedbrowser.nedgraphics.nl/nbg/?action=NBG_INIT&default_scale=1000&default_centre_x=255000&default_centre_y=470000&start_webapp=G
http://nedbrowser.nedgraphics.nl/nbg/?action=NBG_INIT&default_scale=1000&default_centre_x=255000&default_centre_y=470000&start_webapp=G
http://nedbrowser.nedgraphics.nl/nbg/?action=NBG_INIT&default_scale=1000&default_centre_x=255000&default_centre_y=470000&start_webapp=G
http://nedbrowser.nedgraphics.nl/nbg/?action=NBG_INIT&default_scale=1000&default_centre_x=255000&default_centre_y=470000&start_webapp=G
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 BIJLAGE H: BROWSERONDERSTEUNING 

NedBrowser is browseronafhankelijk en kan in de volgende browsers worden bekeken: 
 

• Internet Explorer 9, 10, 11 

• Windows Edge 

• Firefox 

• Chrome 

• Opera 

• Safari 
 

 Authenticatie methoden 

In de onderstaande tabel wordt per browser getoond welke authenticatie methoden in 
NedBrowser ondersteund worden: 
 

 Windows Registry Environment Single Sign On 
(LDAP) 

  Internet Explorer ja ja ja Ja 

 Windows Edge Ja, zie 19.1.1 nee, zie opm1 nee, zie opm1 Ja 

  Firefox ja, zie 19.1.1 nee, zie opm1 nee, zie opm1 Ja 

  Chrome Ja, zie 19.1.1 nee, zie opm1 nee, zie opm1 Ja 

  Safari Nee, zie 
19.1.1 

nee, zie opm1 nee, zie opm1 Ja 

  Opera Ja, zie 19.1.1 nee, zie opm1 nee, zie opm1 Ja 

 
Opmerking 1 
Indien Registry- of Environment authenticatie wordt gebruikt in browsers anders dan 
Internet Explorer, dan wordt in de titel van NedBrowser de volgende melding getoond: 
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 Windows Authentication inlogscherm 

Windows Edge 
In Windows Edge verschijnt bij het opstarten van NedBrowser een inlogscherm indien 
Windows Authentication wordt gebruikt. Dit is tot op heden niet over te slaan.  
 
Firefox 
In Firefox verschijnt bij het opstarten van NedBrowser een inlogscherm indien Windows 
Authentication wordt gebruikt. 
 
Om automatisch in te loggen en het inlogscherm over te slaan dienen 2 parameters 
worden aangepast. Dit gaat als volgt: 
 
Door about:config in de adresbalk van een Mozilla-browser in te tikken en vervolgens op 
<enter> te drukken wordt een overzicht getoond van de verborgen instellingen van de 
Mozilla-browser. Deze kunnen eenvoudig gewijzigd worden door erop te dubbelklikken. 
 
network.automatic-nltm-auth.trusted-uris=<NedBrowser-

webserver-naam> 

network.proxy.no_proxies_on=<NedBrowser-webserver-naam> 

 
Vervang <NedBrowser-webserver-naam> door de naam van de server waarop de 
NedBrowser webapplicatie geïnstalleerd is. 
 
Chrome 
In Chrome verschijnt bij het opstarten van NedBrowser een inlogscherm indien Windows 
Authentication wordt gebruikt. 
 
Om automatisch in te loggen en het inlogscherm over te slaan dienen instellingen in 
Internet Explorer (!) aangepast te worden. Deze worden in de Registry opgeslagen en 
worden vervolgens door Chrome gebruikt. 
 



19. Bijlage H: Browserondersteuning 

Versie 1.0 150 NedBrowser Configuratiehandleiding 

Allereerst dient NedBrowser toegevoegd te worden aan de zone “Vertrouwde websites” in 
Internet Explorer via “Websites”. In veel gevallen zal dat al gebeurd zijn omdat dit in de 
installatiehandleiding wordt geadviseerd. 

 
Vervolgens moet “Aangepast niveau” worden gekozen. Helemaal onderaan staat de 
instelling “Verificatie van de gebruiker”. Door deze op “Automatisch aanmelden met 
gebruikersnaam en wachtwoord” te kiezen slaat Chrome het inlogscherm over bij het 
opstarten van NedBrowser. 
 
Opera 
In Opera verschijnt bij het opstarten van NedBrowser een inlogscherm indien Windows 
Authentication wordt gebruikt. Dit is tot op heden niet over te slaan. 
 
Safari 
Bij Safari verschijnt bij het opstarten van NedBrowser een inlogscherm indien Windows 
Authentication wordt gebruikt. Na het invullen verschijnt vervolgens de kaart maar verdere 
kaartacties gaan niet goed. Derhalve wordt Safari met Windows Authentication niet 
ondersteund, alleen Anonymous. 
 

 ActiveX 

Internet Explorer is de enige browser die ActiveX ondersteunt, andere browsers 
ondersteunen officieel geen ActiveX.  
 
Als gevolg hiervan werken de volgende NedBrowser functies alleen in Internet Explorer: 
 

•    Foto’s bekijken van Cyclorama (oude viewer, geldt niet voor Globespotter, Street 
Smart), Maxiviewer, F.I.S.  

•    Kopieer kaart naar klembord. 

•    Resultaten exporteren naar GML. 

•    Resultaten exporteren naar tekstbestand. 

• Printen: automatisch leegmaken van kop- en een voettekst. 

• Printen: automatisch aanpassen van marges voor Links/Rechts en Boven/Onder. 

• Printen: automatisch aanzetten van optie ‘Afdrukken achtergrondkleuren en plaatjes’. 

 

 NBG opstarten 

Via systeeminstelling Pagina waarmee NedBrowser wordt gestart onder groep 
Webapplicatie zijn verschillende opties mogelijk die aangeven hoe NedBrowser opgestart 
kan worden: 

 
1. Nieuw venster openen, bestaande pagina afsluiten 
2. Nieuw venster openen, vragen om bestaande pagina af te sluiten 
3. Nieuw venster openen, bestaande pagina niet afsluiten 
4. Geen nieuw venster openen 



19. Bijlage H: Browserondersteuning 

NedBrowser Configuratiehandleiding 151 Versie 1.0 

 
Hier gelden een aantal beperkingen: 

• In Firefox en Chrome wordt de bestaande pagina niet afgesloten, ook al staat deze 
instelling op 1 of 2.  

• De vraag om de bestaande pagina af te sluiten bij instelling 2 wordt alleen getoond 
in Internet Explorer. 

• In Opera wordt bij de instellingen 1, 2 en 3 een nieuw tabblad geopend en niet een 
nieuw venster. 

• Windows Edge ondersteunt alleen optie 4. 

 

 Afdrukken 

    Wegens een technisch probleem in de laatste versie van Safari/Opera werkt het 
afdrukken op de printer niet naar behoren: de kleuren van de schaalbalk en de 
transparante achtergrond van bijvoorbeeld de noordpijl worden niet correct afgedrukt. 
 

  In Windows Edge is het niet mogelijk om achtergrondkleuren en afbeeldingen te 
printen. Daardoor worden de legenda, teksten en schaalbalk niet correct afgedrukt. 
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 BIJLAGE I: BEGRIPPENLIJST 

Deze begrippenlijst is opgesteld door de NedBrowser gebruikersgroep. De 
verantwoordelijkheid voor het onderhoud van deze lijst ligt tevens bij de gebruikersgroep. 
 

Term Betekenis 

Categorie Groep van bij elkaar horende redlining elementen 

Connectie Databaseverbinding 

Datamodel Hoe hangen de verschillende tabellen met elkaar samen en wat 
betekenen deze tabellen 

DBLink (als 
connectie) 

Databaseconnectie, bij voorkeur te gebruiken voor tabellen 
buiten de "eigen" database 

Default gebruiker De fictieve gebruikersgroep waar een gebruiker bij wordt 
ingedeeld op het moment dat de gebruiker niet expliciet tot een 
gebruikersgroep behoort 

Detailoverzicht De administratieve resultaten die per individueel resultaat links 
onderin NedBrowser worden weergegeven als op de 
betreffende regel wordt geklikt 

Domein Bereik uit een look-up lijst (alle voorkomende waarden die 
vervangen moeten worden middels de look-up lijst) 

Export De te exporteren onderdelen van het resultaatscherm (als .txt-
bestand) 

Gebruikersgroep Groep van gebruikers met dezelfde rechten op weergave van 
objecten 

Geometrie (Onderdelen van) een kaart 

Kaartmenu Welke knoppen heeft een gebruiker tot zijn beschikking boven 
en onder het kaartvenster 

Laagprioriteit Volgorde van de laag t.o.v. andere lagen (wat boven en onder 
ligt kan zo worden bepaald) 

Laagresultaten Door middel van een laagresultaat kan bepaald worden welke 
gekoppelde resultaatschermen extra worden weergegeven 

Label Eén van de attributen van een kaartelement als tekst bij het 
betreffende element geplaatst 

Laag De verzameling elementen uit een object die een kaartlaag 
vormen 

Lijstoverzicht De administratieve resultaten rechts onderin NedBrowser 

Menu Groep bij elkaar horende kaartlagen in de legenda 

Object Tabel of view in een database. Deze maken onderdeel uit van 
het datamodel 

Objectrelatie Relatie tussen objecten 

Order by clause Hiermee wordt de sorteervolgorde van het resultaatscherm 
bepaald 

Print parameters Een voorgedefinieerde keuze ten aanzien van de lay-out van een 
printtemplate 

Procedure 
aanroep 

Het javascript dat moet worden gestart als er op het betreffende 
attribuut in het lijstoverzicht wordt geklikt 
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Producten Voorgedefinieerde weergave van verschillende objecten, 
toegespitst op een te verwachten informatievraag 

Relatie attributen De sleutel tussen het start- en eindobject. Deze bestaat uit 
minimaal 1 attribuut 

Redlining Beperkt tekenen in de kaart, waarbij enkele administratieve 
zaken geregistreerd kunnen worden. Te gebruiken om vanuit de 
gebruiker informatie naar een geautoriseerde gebruikersgroep 
door te geven 

Referenties Door de applicatiebeheerder aangemaakt weergave van 
kaartelementen 

Relatieketen (Combinatie van) objectrelatie(s) die gebruikt kunnen worden 
binnen zoekschermen, als koppeling tussen de kaart en 
administratieve resultaten en als koppeling tussen 
administratieve tabellen 

Resultaatscherm Administratieve weergave van (een selectie uit) een object 

Schema (als 
connectie) 

Databaseconnectie, alleen te gebruiken voor tabellen binnen de 
"eigen" database 

Templates Template = Een verzameling print parameters die tezamen een 
als standaard gedefinieerde printweergave bepalen 

Thema Presentatie van een kaartlaag, waarbij vorm en of kleur 
afhangen van de gekoppelde administratieve eigenschappen 

Thema palet Voorgedefinieerde kleurcombinatie die te gebruiken is voor een 
thematische presentatie 

Where clause Hiermee kunnen voorwaarden worden gesteld waaraan een 
weer te geven resultaatscherm moet voldoen 

Zoekcriteria Attributen waarop gezocht kan worden binnen een tabel. De 
resultaten van een zoekvraag kunnen administratief en 
geometrisch gepresenteerd worden. 
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Creëer, beheer en deel digitale gebiedsinformatie 
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